This page intentionally left blank.
Contents

Preface

Using the FileMaker Server documentation

Using FileMaker Server Help (Windows and Mac OS) vii
Starting FileMaker Server Help viii
About the Help topic window viii
Finding a topic using the Help Contents viii
Finding a topic using the Help Index (Windows and Mac OS 8.6 to 9.1) ix
Finding a topic using specific words (Windows and Mac OS 8.6 to 9.1) x
Finding a topic using specific words (Mac OS X) xi
Finding information about specific items in FileMaker Server xi
Getting help for FileMaker Server in Red Hat Linux xii
Getting help while administering FileMaker Server remotely xii

Chapter 1

Welcome to FileMaker Server 5.5

Registration and customer support 1-1
Introducing FileMaker Server 1-1
How does FileMaker Server work? 1-2
What’s in the FileMaker Server package 1-3
What’s new or improved in FileMaker Server 5.5 1-3
Before you begin 1-3

Chapter 2

Installing FileMaker Server in Windows

What you need 2-1
Windows system requirements 2-1
Networking requirements 2-1
Installing FileMaker Server 2-2

Chapter 3

Installing FileMaker Server in Mac OS 8.6 to 9.1

What you need 3-1
Mac OS 8.6 to 9.1 system requirements 3-1
Networking requirements 3-1
Installing FileMaker Server 3-1
Where files are stored on your hard disk 3-2

Chapter 4

Installing FileMaker Server in Mac OS X

What you need 4-1
Mac OS X system requirements 4-1
Networking requirements 4-1
Installing FileMaker Server 4-1
Where files are stored on your hard disk 4-2

Chapter 5

Installing FileMaker Server in Red Hat Linux

What you need 5-1
Red Hat Linux system requirements 5-1
Networking requirements 5-1
Installing and registering FileMaker Server 5-1
Where files are stored on your hard disk 5-2
Uninstalling FileMaker Server 5-3

Chapter 6

Configuring FileMaker Server (Windows and Mac OS)

Using the configuration assistants (Windows) 6-1
Opening the Properties dialog box (Windows) 6-2
Opening the Preferences dialog box (Mac OS 8.6 to 9.1) 6-2
Opening the Preferences dialog (Mac OS X) 6-3
Setting the number of guests 6-3
Allowing disconnection of idle guests 6-4
Setting a time to disconnect idle guests 6-4
Setting the pre-disconnect message 6-4
Authenticating guest log on (Windows) 6-4
Setting the maximum number of files 6-5
Changing the amount of memory used by FileMaker Server 6-5
Adjusting memory (Mac OS 8.6 to 9.1) 6-6
Changing the amount of memory used 6-6
FileMaker Server, virtual memory, and physical memory requirements 6-7
Setting how often the cache is flushed 6-7
Allowing single user files to be hosted 6-7
Allowing software updates to be downloaded automatically 6-7
Opening runtime solutions automatically (Windows and Mac OS X) 6-8
About FileMaker Developer 6-8
Opening runtime solutions automatically (Mac OS 8.6 to 9.1) 6-9
About FileMaker Developer 6-9
Enabling remote administration 6-9
Specifying a custom host name 6-10
Maximizing performance (Mac OS 8.6 to 9.1) 6-11
Choosing network protocols 6-11
Setting the preferred IP address 6-12
Recording usage statistics and setting size limits 6-12
Setting a size limit for the Application Log (Windows NT) 6-14
Setting a size limit for the Application Log (Windows 2000) 6-14
Setting a size limit for the event log (Mac OS) 6-15
Using FileMaker Server with a directory service 6-15
Registering FileMaker Server with a directory service 6-15
Specifying the authentication method (Windows) 6-16
Specifying the authentication method (Mac OS) 6-16
Publishing your contact information to your directory service 6-16
Changing the port number 6-17
Restoring FileMaker Server default settings 6-17
Protecting files with a password 6-17
How FileMaker Server behaves during system sleep (Windows 2000 and Mac OS) 6-17

Chapter 7
Administering FileMaker Server (Windows and Mac OS)

Starting FileMaker Server (Windows NT) 7-1
Starting FileMaker Server (Windows 2000) 7-1
Stopping FileMaker Server (Windows NT) 7-2
Stopping FileMaker Server (Windows 2000) 7-2
Starting FileMaker Server (Mac OS 8.6 to 9.1) 7-3
Making an alias 7-3
Quitting FileMaker Server (Mac OS 8.6 to 9.1) 7-3
Starting FileMaker Server (Mac OS X) 7-3
Making an alias for FileMaker Server Config 7-4
Starting the FileMaker Server application (Mac OS X) 7-4
Quitting FileMaker Server (Mac OS X) 7-4
Quitting the FileMaker Server Config application 7-4
Stopping the FileMaker Server application (Mac OS X) 7-4
Using remote administration 7-4
Automatically downloading the Server Administration plug-in to a remote computer 7-6
Opening the Remote Administration window 7-6
Listing hosted files and current guests 7-7
Viewing usage statistics for FileMaker Server 7-7
Hosting FileMaker Pro 5.x files 7-8
Closing hosted files 7-9
Disconnecting guests 7-10
Viewing detailed information about hosted files and guests 7-11
Sending messages to guests 7-11
Sending messages to all guests 7-12
Determining if you have exclusive access to hosted databases 7-12

Using local administration (Mac OS 8.6 to 9.1) 7-12
Opening the local administration window (Mac OS 8.6 to 9.1) 7-12
Listing hosted files and guests (Mac OS 8.6 to 9.1) 7-13
Viewing usage statistics (Mac OS 8.6 to 9.1) 7-14
Hosting FileMaker Pro 5.x files (Mac OS 8.6 to 9.1) 7-14
Closing hosted files (Mac OS 8.6 to 9.1) 7-15
Disconnecting guests (Mac OS 8.6 to 9.1) 7-16
Sending messages to guests (Mac OS 8.6 to 9.1) 7-16

Monitoring server performance (Windows) 7-17
Monitoring performance (Windows NT) 7-17
Monitoring performance (Windows 2000) 7-18
Using reported events to track activities 7-18
Viewing activities in the Event Viewer (Windows NT) 7-19
Viewing activities in the Event Viewer (Windows 2000) 7-19
Keeping event data current (Windows) 7-20
Viewing activities in the event log (Mac OS) 7-20
Recalculating the Today function in hosted databases 7-20

Chapter 8
Scheduling administrative tasks (Windows and Mac OS) 8-1
Scheduling tasks to run automatically (Windows) 8-1
Scheduling tasks to run automatically (Mac OS 8.6 to 9.1) 8-1
Scheduling database backups (Mac OS 8.6 to 9.1) 8-2
Running a script (Mac OS 8.6 to 9.1) 8-2
Sending messages to guests of hosted databases (Mac OS 8.6 to 9.1) 8-3
Scheduling tasks to run automatically (Mac OS X) 8-3
Scheduling database backups (Mac OS X) 8-3
Running a script (Mac OS X) 8-4
Sending messages to guests of hosted databases (Mac OS X) 8-4

Chapter 9
Using FileMaker Server in Red Hat Linux 9-1
Getting onscreen help with command and preference syntax 9-1
Administering FileMaker Server 9-1
Starting and stopping FileMaker Server automatically 9-2
Configuring FileMaker Server 9-3
Editing the configuration file 9-3
Applying configuration changes 9-4
Reloading the configuration file to apply runtime preference changes 9-5
 Restarting FileMaker Server to apply configuration changes 9-5
Restoring preference defaults 9-5
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting the number of guests</td>
<td>9-6</td>
</tr>
<tr>
<td>Disconnecting idle guests</td>
<td>9-6</td>
</tr>
<tr>
<td>Setting the maximum number of files</td>
<td>9-7</td>
</tr>
<tr>
<td>Changing the amount of memory used by FileMaker Server</td>
<td>9-7</td>
</tr>
<tr>
<td>Setting how often the cache is flushed</td>
<td>9-7</td>
</tr>
<tr>
<td>Allowing single user files to be hosted</td>
<td>9-8</td>
</tr>
<tr>
<td>Allowing software updates to be downloaded automatically</td>
<td>9-8</td>
</tr>
<tr>
<td>Enabling Auto Update in FileMaker Server</td>
<td>9-8</td>
</tr>
<tr>
<td>Storing plug-in files on the server computer</td>
<td>9-9</td>
</tr>
<tr>
<td>Specifying the location of hosted files</td>
<td>9-9</td>
</tr>
<tr>
<td>Specifying a user account name and group name for FileMaker Server</td>
<td>9-9</td>
</tr>
<tr>
<td>Enabling remote administration in FileMaker Server</td>
<td>9-10</td>
</tr>
<tr>
<td>Using the fmspasswd utility to encrypt passwords</td>
<td>9-11</td>
</tr>
<tr>
<td>Specifying a custom host name</td>
<td>9-11</td>
</tr>
<tr>
<td>Specifying the preferred IP address</td>
<td>9-12</td>
</tr>
<tr>
<td>Opening runtime solutions automatically</td>
<td>9-12</td>
</tr>
<tr>
<td>Using reported events and statistics to track activities</td>
<td>9-13</td>
</tr>
<tr>
<td>Setting a size limit and the location of the event log</td>
<td>9-13</td>
</tr>
<tr>
<td>Creating a statistics log</td>
<td>9-14</td>
</tr>
<tr>
<td>Using FileMaker Server with a directory service</td>
<td>9-14</td>
</tr>
<tr>
<td>Enabling directory service registration</td>
<td>9-15</td>
</tr>
<tr>
<td>Publishing your contact information to your directory service</td>
<td>9-16</td>
</tr>
<tr>
<td>Manually installing the Server Administration plug-in on a remote computer (Mac OS)</td>
<td>10-2</td>
</tr>
<tr>
<td>Enabling the Server Administration plug-in using FileMaker Pro (Mac OS)</td>
<td>10-3</td>
</tr>
</tbody>
</table>

**Appendix A**

**Technical specifications and optimization**

- Limits for files and usage: A-1
- Hardware and network considerations: A-1
- Software considerations: A-2

**Appendix B**

**Performance and usage tips**

- Performance tips: B-1
- Usage tips: B-2

**Appendix C**

**Event log messages and troubleshooting**

- FileMaker Server event log messages: C-1
- Troubleshooting: C-5
  - Problems installing or starting FileMaker Server: C-5
  - Network problems: C-5
  - Problems on guest computers: C-6
  - Problems administering remotely: C-7
  - Problems using command line options (Windows and Red Hat Linux): C-7

**Appendix D**

**About the TechInfo database**

- Searching the TechInfo database: D-1
- Sample TechInfo article: D-1
- Information on the Web: D-1

**Index**

I-1
Preface
Using the FileMaker Server documentation

The documentation for the FileMaker® Server software provides information, illustrations, and step-by-step instructions to help you learn the most about FileMaker Server—a powerful application that enhances database sharing across a network.

The FileMaker Server documentation includes:

- this book, the *FileMaker Server Administrator’s Guide*
- FileMaker Server Help, a comprehensive online help system for the Windows and Mac OS versions
- Context-sensitive Help for dialog box options (Windows), Balloon Help for menu items (Mac OS 8.6 to 9.1), and Help Tags for dialog options (Mac OS X)
- Auto Update Guide.pdf, a document on the FileMaker Server CD
- for database developers who want to set up Auto Update in their databases
- Comments in the Red Hat Linux configuration file (fmserver.conf) and a Red Hat Linux quick reference pdf file

About this guide

The *FileMaker Server Administrator’s Guide* is written for administrators of the Windows NT, Windows 2000, Mac OS, and Red Hat Linux operating systems.


In many instances, information and instructions are the same for Windows and the Mac OS. In these sections and topics, any platform-specific information, such as the name of a command, is followed by the name of the platform in parentheses. For example:

In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Administration tab, and choose one of the following options.

A note about the platform indicators

Information marked (Windows) applies to both Windows NT and Windows 2000. Information marked for one of these operating system versions alone indicates the information is version-specific.

Information marked (Mac OS) applies to both Mac OS 8.6 to 9.1 and Mac OS X. Information marked for one of these operating system versions alone indicates the information is version-specific.

Where instructions are significantly different, you see separate sections or topics for each operating system. Windows NT information appears first, followed by information for Windows 2000, then information for Mac OS 8.6 to 9.1, then Mac OS X.

A note about the illustrations

Illustrations throughout the book are mixed, depicting situations for all platforms except Red Hat Linux. Windows NT 4.0, Windows 2000, Mac OS 8.6 to 9.1, and Mac OS X systems were used for these illustrations. What you see on your screen may vary from the instructions in this book depending on the platform and operating system of your computer.
Using FileMaker Server Help (Windows and Mac OS)

FileMaker Server onscreen Help is available when you are working in the FileMaker Server Console (Windows) or when you are working with the FileMaker Server application (Mac OS 8.6 to 9.1) or FMServer Config application (Mac OS X).

If you are administering FileMaker Server remotely (from another computer on your network), you can use the Help accessed through the Remote Administration window. For more information, see “Getting help while administering FileMaker Server remotely” on page xii.

Starting FileMaker Server Help

Whenever you open FileMaker Server Help, you start the Windows Help application (Windows), the FileMaker Help Viewer application (Mac OS 8.6 to 9.1), or Help Viewer (Mac OS X). These help applications run independently of FileMaker Server.

To start FileMaker Server Help when you’re working in the FileMaker Server Console (Windows) or FileMaker Server application (Mac OS), do one of the following:

- **Windows:** Press F1, click \(\text{Help}\) on the toolbar, or choose \(\text{Action}\) menu > \(\text{Help}\).
- **Mac OS 8.6 to 9.1:** Choose \(\text{FileMaker Server Help}\) from the \(\text{Help}\) menu, press the Help key, or press \(\text{Help}\).
- **Mac OS X:** Choose \(\text{FileMaker Server Config Help}\) from the \(\text{Help}\) menu, press the Help key, or press \(\text{Help}\).

About the Help topic window

To navigate to other topics in FileMaker Server Help, you click buttons and underlined text in the Help topic window.

Finding a topic using the Help Contents

Windows: In the FileMaker Server Console, choose \(\text{Action}\) menu > \(\text{Help}\), then click \(\text{Help Topics}\).

Mac OS 8.6 to 9.1: In FileMaker Server, choose \(\text{Help}\) menu > \(\text{Contents and Index}\).

If a FileMaker Server Help topic is displayed, click \(\text{Help Topics}\) in the Help topic window, then click \(\text{Contents}\) (if necessary) to display the Help Contents.
Mac OS X: In FileMaker Server, choose Help menu > FileMaker Server Config Help.

When you open the FileMaker Server Help Contents, you see a list of Help subjects, like the table of contents in a book.

Windows and Mac OS 8.6 to 9.1: Double-click a book icon to display a list of topics for each subject. Then double-click a topic to display the Help topic window.

Mac OS X: Click a book icon to display a list of topics for each subject. Then click a topic to display the Help topic window.

Finding a topic using the Help Index (Windows and Mac OS 8.6 to 9.1)

FileMaker Server Help includes an alphabetical list of index entries—significant words and phrases—to help you find the topics containing the information you want. Each index entry is associated with one or more topics.

To use the Help Index:

1. Windows: In the FileMaker Server Console, choose Action menu > Help > Help Topics, then click Index (if necessary).

Mac OS 8.6 to 9.1: In FileMaker Server, choose Help menu > Contents and Index, then click Index (if necessary).

2. In the Index window, type all or part of an index entry you want to find.

The Help Index displays a list of entries beginning with the characters you typed. Under some index entries is a list of more than one Help topic.

3. Double-click an entry to display a list of topic choices (Windows) or the topic itself.
Finding a topic using specific words (Windows and Mac OS 8.6 to 9.1)

You can specify your own significant word or combination of words to search for within all of the Help topics. FileMaker Server Help will display a list of all topics containing the word(s) you specify and the total number of topics found. To narrow the search, you can specify a combination of words. For example, you can search for all topics containing both the word “performance” and the word “statistics.”

To find a topic based on a specific word or group of words:

1. Windows: In the FileMaker Server Console, choose Action menu > Help, click Help Topics, then click the Find tab.

   The first time you click Find in FileMaker Server Help, the Find Setup Wizard dialog box appears. Follow the instructions it provides to set up FileMaker Server Help for finding words. This setup procedure needs to be done only once.

   Mac OS 8.6 to 9.1: In FileMaker Server, choose Help menu > Contents and Index, then click the Find tab.

2. In the Find window, type the words that you want to search for.

3. To narrow the search, do one of the following:

   Windows: Type more than one word in the text box. Then click Options, select All the words you typed in any order, select Immediately after each keystroke to begin the search, then click OK. You can also select multiple words to search for by Ctrl-clicking them in the matching word list.

   Mac OS 8.6 to 9.1: Click More Choices and type a second word in the new row below the first word. Then click Search. You can add multiple rows and choose different parameters from the pop-up menus for each word.

4. Select a topic in the topic list, then click Display.
FileMaker Server Help shows each occurrence of the word or words you searched for in the Help topic window.

**Finding a topic using specific words (Mac OS X)**

To find a topic based on a question or phrase:

1. In FileMaker Server, choose Help menu > FileMaker Server Config Help.
2. In the Ask box, type a question or phrase that you want to search for and click Ask.
3. Click a topic title.

Apple Help Viewer displays a list of topics containing the word or phrase you searched for.

**Finding information about specific items in FileMaker Server**

As you’re working in FileMaker Server, you can find information about a dialog box that’s open or certain items your mouse is pointing to, depending on the platform you’re using.

**Windows:** For context-sensitive Help, do one of the following:
- Select FileMaker Server or Schedules in the Console Tree (left side of the FileMaker Server Console) and choose Action menu > Help. You can also press F1, or click on the toolbar.
- Right-click FileMaker Server or Schedules in the Console Tree and choose Help.
- In the upper-right corner of a dialog box, click, then click an item in the dialog box to find out about it.
- Rest the pointer over a menu name or toolbar item and read its description in a pop-up window.
- Rest the pointer over a menu command and read its description in the lower left corner of the console.

**Mac OS 8.6 to 9.1:** For context-sensitive Help, do one of the following:
- Some windows and dialog boxes have context-sensitive Help. To access it, open a dialog box and press the Help key, choose Help menu > FileMaker Server Help, or press 2. The Help topic for that dialog box opens. If a Help topic does not appear or the FileMaker Server Help command is dimmed in the Help menu, context-sensitive Help is not available for the open window or dialog box.
- Choose Help menu > Show Balloons and then point to a menu, or select a menu and drag to display a description of each menu item.
- Choose Help menu > Show Balloons, select a pop-up menu in a dialog box, and drag to display a description of each item in the list.
Mac OS X: For context-sensitive Help, do the following:
- Point to an option in a dialog box. After a few seconds a description of the item appears.

**Getting help for FileMaker Server in Red Hat Linux**

If you’re using FileMaker Server in Red Hat Linux, for online help see the comments in the configuration file, fmserver.conf. The QuickRef.pdf file also contains information about configuring and administering FileMaker Server in Red Hat Linux.

**Getting help while administering FileMaker Server remotely**

The onscreen Help for FileMaker Server is installed on the server computer, so you can’t access it when you are administering or monitoring FileMaker Server activity from another computer.

To get help for remote administration tasks while working in the Remote Administration window, click ☰ in the Remote Administration window.

To close the Help window and return to the Remote Administration window, click Done.
Chapter 1
Welcome to FileMaker Server 5.5

Welcome to the FileMaker Server 5.5 application from FileMaker, Inc. for Windows NT, Windows 2000, Mac OS 8.6 to 9.1, Mac OS X, and Red Hat Linux.

FileMaker Server gives you enhanced database hosting capabilities on your network when used with the FileMaker Pro 5.x database management application.

Registration and customer support
Please take the time to complete and mail the registration card for your product or register online:

- Windows: In the FileMaker Server Console, choose View menu > FileMaker on the Web
- Mac OS 8.6 to 9.1: Start FileMaker Server and choose Help menu > FileMaker on the Web
- Mac OS X: Start FileMaker Server Config and choose Help menu > FileMaker on the Web
- Red Hat Linux: Point your browser to www.filemaker.com/register

For information about technical support and customer service, see:

- www.filemaker.com (North American customers)
- www.filemaker.com/intl (customers outside North America)

or choose:

- Windows: View menu > FileMaker on the Web
- Mac OS: Help menu > FileMaker on the Web

At the web site, you will find the FileMaker, Inc. Service Directory, which details the service options available to North American customers, as well as links to FileMaker, Inc. international sites, answers to frequently asked questions, and access to extensive software libraries used by the technical support staff. If you do not have access to the Web, please refer to the Technical Support and Customer Service sheet included in the software box. North American customers can also call 1-800-965-9090 to learn about the service options available.

Introducing FileMaker Server
You've always been able to share database files in FileMaker Pro using a peer-to-peer sharing scheme with the Multi-User command. You can also use the FileMaker Server application as a dedicated host to open FileMaker Pro 5.x files and make them available to FileMaker Pro guests on your network, allowing better performance among more guests. FileMaker Server acts only as a host, and uses advanced client/server technology to take care of much of the background work associated with managing files, thereby enhancing performance for FileMaker Pro guests accessing those files.

FileMaker Server can host up to 125 database files and support up to 250 simultaneously connected FileMaker Pro guests. (AppleTalk support is limited to 124 simultaneous guests.)

FileMaker Server includes a remote administration capability. Remote administration lets you easily monitor and administer hosted databases and guests and track statistical information from a computer running FileMaker Pro 5.x.
Important: Avoid installing FileMaker Server on a computer that is a user’s primary workstation or network file server. FileMaker Server should be run on a dedicated computer reserved for use as a database server.

When FileMaker Server is hosting many guests or a large number of database files, it uses a high level of processor, hard disk, and network capacity. Other processor-intensive applications (for example, Web-server or disk-backup software) or heavy network traffic on the same computer will cause FileMaker Server to run more slowly and degrade the performance of FileMaker Pro on guest computers.

In addition, file sharing should be turned off on the computer running FileMaker Server.

Note: This guide assumes you’re familiar with general database concepts as well as the basics of FileMaker Pro. If you’re not, refer to the tutorial in the FileMaker Pro 5.5 Getting Started Guide or to the FileMaker Pro 5 User’s Guide (especially the first two chapters) for more information.

How does FileMaker Server work?

The FileMaker Server application is a tool to use with FileMaker Pro 5.x in a network environment to:

- enhance database guest performance
- increase the number of FileMaker Pro guests who can connect to a file hosted by FileMaker Server
- increase the number of files that can be hosted by FileMaker Server
- host files using more than one network protocol simultaneously

You can use the remote administration capability of FileMaker Server to administer the server software from a different computer on your network. When administering remotely, you can:

- open—or host—a FileMaker Pro database file, making it available to FileMaker Pro guests on the network
- view information about the files being hosted, like the number of guests accessing each database
- send messages to connected guests
- close a hosted FileMaker Pro file, making it unavailable to FileMaker Pro guests
- disconnect a selected FileMaker Pro guest from a particular hosted file or all hosted files

Some of these administrative tasks require that you install the Server Administration plug-in for FileMaker Server on your remote computer. For more information about installing the plug-in, see chapter 10, “Installing the Server Administration plug-in on a remote computer.”

For more information about administering remotely, see chapter 7, “Administering FileMaker Server (Windows and Mac OS).”

When you start FileMaker Server, it automatically opens and hosts all multi-user FileMaker Pro 5.x files located in the same folder (or the first level of subfolders) as the FileMaker Server application. This common folder architecture lets you easily set up the database files that you always want FileMaker Server to host on the network.

Keep in mind the following points about the different uses of FileMaker Server and FileMaker Pro:

- Use FileMaker Server to open and host FileMaker Pro files that you want to make available to FileMaker Pro guests on your network.
- As a dedicated host, FileMaker Server only hosts the files. FileMaker Server can’t access or modify the information in the files.
Welcome to FileMaker Server 5.5

Use FileMaker Pro to create database files or modify the structure of existing files (for example, to password-protect each hosted FileMaker Pro file or to access field definitions).

The Web Companion feature of FileMaker Pro can be used to publish files hosted by FileMaker Server on the Internet or on a company’s intranet. For more information about web publishing, see the documentation for FileMaker Developer, FileMaker Pro, or FileMaker Pro Unlimited.

What's in the FileMaker Server package

The FileMaker Server package includes:

<table>
<thead>
<tr>
<th>Package component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileMaker Server CD</td>
<td>The Setup application (Windows), the Start Here Mac OS Classic application, the Start Here Mac OS X application, the FileMaker Server rpm file (Red Hat Linux), as well as all the files you need to use FileMaker Server</td>
</tr>
<tr>
<td>FileMaker Server Administrator’s Guide</td>
<td>Installation instructions and information about how to use FileMaker Server (this guide)</td>
</tr>
<tr>
<td>FileMaker registration card</td>
<td>Information to register your copy of FileMaker Server</td>
</tr>
</tbody>
</table>

What's new or improved in FileMaker Server 5.5

The new and improved features of FileMaker Server include:

- Support for Windows 2000, Mac OS X, and Red Hat Linux, making FileMaker Server available on a broader range of computers and operating systems
- Ability to automatically download software updates (for example, plug-ins) from the server computer to guest computers

Windows

- Windows 2000: Ability to access Windows Services, Event Viewer, and System Monitor from within the FileMaker Server Console
- Ability to require guests to be members of the same domain as FileMaker Server before being granted access to hosted databases

Mac OS X

- A native Mac OS X application that takes advantage of Mac OS X features such as preemptive multitasking, protected memory, and dynamic memory allocation

Before you begin

For instructions on installing FileMaker Server, see the following chapters.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Mac OS 8.6 to 9.1</td>
<td>Chapter 3</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Chapter 4</td>
</tr>
<tr>
<td>Red Hat Linux</td>
<td>Chapter 5</td>
</tr>
</tbody>
</table>

Platform Chapter
This page intentionally left blank.
This chapter provides step-by-step instructions for installing FileMaker Server and associated files on a computer running Windows NT 4.0 or Windows 2000.

To use FileMaker Server, you need the following equipment and software.

**Windows system requirements**

To use FileMaker Server on Intel-Pentium and compatible systems, you need:

- an Intel compatible PC with a Pentium processor
- at least 64 MB of installed RAM (Windows NT 4.0) or 128 MB of installed RAM (Windows 2000)
- one of the following operating system software configurations:
  - Windows NT Server 4.0 or Windows NT Workstation 4.0 (10 or fewer users only) and Windows NT Service Pack 3, 4, 5, or 6. See the End User License Agreement that came with the Windows NT operating system for more information concerning the allowed number of connections.
  - Windows 2000 Server or Windows 2000 Professional (10 or fewer users only)
- Microsoft Management Console (MMC) 1.1 (installed by the FileMaker Server Installer if it’s not already installed on your computer). Windows NT: MMC requires Internet Explorer 4.01.
- a web browser for accessing FileMaker Pro 5.x for running the remote administration capability and for creating and converting databases to be hosted by FileMaker Server 5.5. FileMaker Server 5.5 supports only FileMaker Pro 5.x databases.
- a login account with administrative privileges for installing FileMaker Server
- a CD or DVD drive
- a hard disk with at least 4 MB of free disk space for the FileMaker Server files. Be sure to allow additional space for the database files you intend to host, which should be located on the same disk as the FileMaker Server application.

**Important**

Up to 20 MB of free disk space may be required during the installation process.

**Networking requirements**

To share files among users on a network, you need to have the following additional software and hardware installed on the host computer running FileMaker Server:

- a Windows NT or Windows 2000 compatible network card. If you want to specify a preferred IP address for FileMaker Server, a second network card is required. For more information, see “Setting the preferred IP address” on page 6-12.
- the software driver for your network card
- NWLink IPX/SPX Compatible Transport and/or TCP/IP network protocol for Windows NT or Windows 2000
Guests can use the following network protocols to access database files hosted by FileMaker Server:

<table>
<thead>
<tr>
<th>Network protocol</th>
<th>Windows guest</th>
<th>Mac OS 8.6 to 9.1 guest</th>
<th>Mac OS X guest</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPX/SPX</td>
<td>NWLink IPX/SPX Compatible Transport (Windows NT client)</td>
<td>IPX is not supported</td>
<td>IPX is not supported</td>
</tr>
<tr>
<td></td>
<td>Microsoft IPX/SPX Compatible Transport (Windows 95 or Windows 98 client)</td>
<td>TCP/IP is integrated</td>
<td></td>
</tr>
<tr>
<td>TCP/IP</td>
<td>TCP/IP</td>
<td>Apple Open Transport 1.1.1 with Mac OS X</td>
<td></td>
</tr>
</tbody>
</table>

**Important:** FileMaker Server uses a proprietary networking scheme and operates independently of your network operating system (NOS) access privileges. Multi-user FileMaker Pro databases will be available to FileMaker Pro guests regardless of NOS privileges. To restrict access to FileMaker databases, use the access privileges available in FileMaker Pro 5.x. For more information, see “Protecting files with a password” on page 6-17. Database files should be shared using networking available in FileMaker Pro. Do not share FileMaker Pro files using Windows file sharing.

**Installing FileMaker Server**

Use the Setup program to install FileMaker Server on your hard disk. This installation procedure describes how to install the:
- FileMaker Server application and supporting files
- FileMaker Server example files

By default, the Setup program creates a folder named Program Files\FileMaker\FileMaker Server 5.5 folder on your hard disk, then installs FileMaker Server and example files in it. However, you can choose a different location during installation.

To install FileMaker Server on your hard disk:
1. Exit all other applications and turn off virus protection utilities.
2. Insert the FileMaker Server CD into your CD or DVD drive.
3. Double-click the Read Me icon to read important information about this release of FileMaker Server. Then close the Read Me file.
   You see the Welcome screen of the FileMaker Server Setup Wizard.
5. Click Next.
6. Read the license agreement. If you agree to these terms, select I accept the terms in the License Agreement, then click Next.
7. Personalize this copy of FileMaker Server by typing your name, organization name, and indicate who can access FileMaker Server from this computer (only you or anyone who uses the computer). Then click Next.
8. Choose Complete in the Setup Type screen to install FileMaker Server and the example files, then click Next.
   *Note:* If you don’t have enough disk space on the server computer, you see the Out of Disk Space dialog box. Quit the installation, remove files from the installation volume to free some space, and try again.
9. Select an option for FileMaker Server start-up, then click Next.

**Select If you want FileMaker Server to start**

- **Automatic:** Whenever Windows starts.
  *Note:* After installation, you must start the FileMaker Server service manually the first time. For more information, see “Starting FileMaker Server (Windows NT)” on page 7-1 or “Starting FileMaker Server (Windows 2000)” on page 7-1. Thereafter, FileMaker Server will start when you restart the computer.
- **Manual:** After you turn on the FileMaker Server service in the Services control panel (Windows NT) or Services console (Windows 2000). For more information, see “Starting FileMaker Server (Windows NT)” on page 7-1 or “Starting FileMaker Server (Windows 2000)” on page 7-1.
10. Type your installation code, then click Next.

*Tip* Your installation code is a seventeen digit number located on a multi-part sticker on the installation code sheet with the FileMaker Server CD.

11. If the Microsoft Management Console (MMC) software is not installed on your server computer, the Setup Wizard will prompt you to install it now. The installation of MMC can take several minutes and you can’t cancel this installation once it has begun. If you want to install MMC and continue the installation of FileMaker Server, click Next.

12. Click Install to begin FileMaker Server file installation.

The Setup Wizard installs FileMaker Server 5.5 and the example files.

13. Click Finish to close the Setup Wizard. Remember to turn virus protection utilities back on.

It’s important to register your copy of FileMaker Server with FileMaker, Inc., so you have full access to customer and technical support. For more information, see “Registration and customer support” on page 1-1.

For information about starting the application, see “Starting FileMaker Server (Windows NT)” on page 7-1 or “Starting FileMaker Server (Windows 2000)” on page 7-1.

**Note** To enable administration functions on a remote computer (open files, close files, and so on), you must install the Server Administration plug-in on each remote computer you plan to use for remote administration. For more information, see “Automatically downloading the Server Administration plug-in to a remote computer” on page 7-6.

---

**Where files are stored on your hard disk**

The following table describes the FileMaker Server files that are installed on your hard disk.

<table>
<thead>
<tr>
<th>Default Location</th>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hard_drive\Program Files\FileMaker\FileMaker Server 5.5</td>
<td>fmserver.exe</td>
<td>The FileMaker Server service</td>
</tr>
<tr>
<td></td>
<td>fmsesg.dll</td>
<td>FileMaker Server message resource (required by Event Viewer)</td>
</tr>
<tr>
<td></td>
<td>fmscons.msc</td>
<td>FileMaker Server Console (MMC saved console)</td>
</tr>
<tr>
<td></td>
<td>fmserver.dbg</td>
<td>FileMaker Server debug symbol file (required by the Dr. Watson debugger)</td>
</tr>
<tr>
<td></td>
<td>fmsprop.dll</td>
<td>FileMaker Server properties component (MMC snap-in)</td>
</tr>
<tr>
<td></td>
<td>fmssched.dll</td>
<td>FileMaker Server Task Scheduler component (MMC snap-in)</td>
</tr>
<tr>
<td></td>
<td>fmsnema.dll</td>
<td>Performance Monitor support</td>
</tr>
<tr>
<td></td>
<td>fmsperf.dll</td>
<td>FileMaker Server component required by the Performance Monitor</td>
</tr>
<tr>
<td></td>
<td>fmshelp.hlp</td>
<td>FileMaker Server onscreen Help</td>
</tr>
<tr>
<td>Default Location</td>
<td>File</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>fmshelp.cnt</td>
<td>FileMaker Server onscreen Help Contents</td>
</tr>
<tr>
<td></td>
<td>fmshelp.gid</td>
<td>Support files for FileMaker Server onscreen Help</td>
</tr>
<tr>
<td></td>
<td>fmshelp.fts</td>
<td>Support files for FileMaker Server onscreen Help</td>
</tr>
<tr>
<td></td>
<td>readme.doc</td>
<td>Text file containing important information about this release of FileMaker Server</td>
</tr>
<tr>
<td></td>
<td>Go_FileMaker.html</td>
<td>HTML document for FileMaker on the Web</td>
</tr>
<tr>
<td></td>
<td>fms_logo.gif</td>
<td>Graphic file of FileMaker Server logo for the FileMaker Server document</td>
</tr>
<tr>
<td>hard_drive\</td>
<td>Sample batch files</td>
<td>Sample template scripts to use for running backups on the command line</td>
</tr>
<tr>
<td>Program Files\</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FileMaker \</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FileMaker Server 5.5\</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Examples</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>fmpsadm.fmx</td>
<td>Remote administration plug-in files for Windows</td>
</tr>
<tr>
<td></td>
<td>fmpsadm.fmx.txt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Server Administration X.bin</td>
<td>Remote administration plug-in files for Mac OS X</td>
</tr>
<tr>
<td></td>
<td>Server Administration X.txt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Server Administration.bin</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Server Administration.txt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AutoUpdatePlugin.fp5</td>
<td>A FileMaker Pro database that illustrates how to set up AutoUpdate</td>
</tr>
<tr>
<td>hard_drive\</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program Files\</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FileMaker \</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FileMaker Server 5.5\</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AutoUpdate Examples\</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>fmptnm.h</td>
<td>Used for manual setup of FileMaker Server Performance Monitor support</td>
</tr>
<tr>
<td></td>
<td>fmpsperf.ini</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Registration files</td>
<td>Used for registering FileMaker Server</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>system_root\</td>
<td>mmc.exe</td>
<td>Microsoft Management Console application (installed for Windows NT systems only)</td>
</tr>
<tr>
<td>System32</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Note: The FileMaker Server Installer installs MMC files on the server computer, if MMC is not already installed. In this situation, a few MMC-related files are installed in the System32 and Help folders on your server computer in addition to the files listed in the table.

Uninstalling FileMaker Server (Windows)

Before removing FileMaker Server from your computer, be sure to first stop the FileMaker Server service.

To remove FileMaker Server from your computer:

1. Start Windows.
2. Stop FileMaker Server.
   For more information, see “Stopping FileMaker Server (Windows NT)” or “Stopping FileMaker Server (Windows 2000)” on page 7-2.
3. Click the Start button > Settings > Control Panel.
4. Double-click the Add/Remove Programs icon.
   You see the Add/Remove Programs Properties dialog box.
5. Select FileMaker Server 5.5, then click the Add/Remove button.
   You see the FileMaker Server 5.5 Setup Wizard.
6. Click Next.
7. Select Remove, click Next, then click Remove again.
   The Uninstaller removes the FileMaker Server files from the hard disk. After all the files are removed, a final dialog box tells you FileMaker Server was removed successfully.
8. Click Finish and then OK to close the Add/Remove Programs Properties dialog box.
This page intentionally left blank.
Chapter 3
Installing FileMaker Server in Mac OS 8.6 to 9.1

This chapter provides step-by-step instructions for installing the FileMaker Server application and associated files on a computer running Mac OS 8.6 to 9.1.

What you need

To use FileMaker Server, you need the following equipment and software.

**Mac OS 8.6 to 9.1 system requirements**

To use FileMaker Server, you need:

- any Apple Power Macintosh or compatible computer, running Mac OS 8.6 to 9.1. FileMaker Server runs in native mode on a Power Macintosh.

- FileMaker Pro 5.x for running the remote administration capability and for creating and converting databases to be hosted by FileMaker Server 5.5. FileMaker Server 5.5 supports only FileMaker Pro 5.x databases.

- a web browser for accessing FileMaker on the Web information from the Help menu

- a CD or DVD drive

- 32 MB of available system memory (RAM). For information about running FileMaker Server with virtual memory turned on, see “FileMaker Server, virtual memory, and physical memory requirements” on page 6-7.

- an internal or external hard disk drive with at least 4 MB of free disk space to install the FileMaker Server application and related files. Be sure to allow additional space for the database files you intend to host, which should be located on the same disk as the FileMaker Server application.

**Networking requirements**

To share files among users on a network, you can use AppleTalk or TCP/IP networking. TCP/IP is recommended for best performance. Apple Open Transport 2.0.1 is required on the computer running FileMaker Server.

Guests can use the following network protocols to access database files hosted by FileMaker Server:

<table>
<thead>
<tr>
<th>Network protocol</th>
<th>Mac OS 8.6 to 9.1 guest</th>
<th>Mac OS X guest</th>
<th>Windows guest</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppleTalk</td>
<td>Apple LocalTalk (provided by your system) or Apple EtherTalk (Phase I or II)</td>
<td>AppleTalk isn’t supported in Mac OS X</td>
<td>AppleTalk isn’t supported in Windows</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Apple Open Transport 1.1.1</td>
<td>TCP/IP is integrated with Mac OS X</td>
<td>Microsoft TCP/IP-32</td>
</tr>
</tbody>
</table>

**Installing FileMaker Server**

Use the Installer to install the complete FileMaker Server package on your hard disk. The Installer creates a folder called FileMaker Server 5.5.

To install FileMaker Server on your hard disk:

1. Quit all other applications, especially virus protection software, and disable file sharing.

2. Insert the FileMaker Server CD into your CD or DVD drive.

You see the CD window on your screen. If you see only the disc icon, double-click the icon to open its window.
3. Double-click the Installer icon named Start Here Mac OS Classic.

4. Read the license agreement. If you agree to these terms, click Accept.

You see the FileMaker Server Installer dialog box.

5. To install the application onto a different disk or into a specific folder, click the Install Location pop-up menu and choose Select Folder. In the dialog box that appears, choose a destination disk and folder, then click Select.

6. Click Install.

7. Type your name, company name (optional), and your installation code.

Tip Your installation code is a seventeen digit number located on a multi-part sticker on the installation code sheet with the FileMaker Server CD.

8. Click OK.

If the hard disk you chose has enough space, the Installer begins installing files.

9. Click Quit to leave the Installer when the installation is finished.

10. If you turned off virus protection and file sharing before installing, turn them back on now.

It’s important to register your copy of FileMaker Server with FileMaker, Inc., so you have full access to customer and technical support. For more information, see “Registration and customer support” on page 1-1.

For information about starting the application, see “Starting FileMaker Server (Mac OS 8.6 to 9.1)” on page 7-3.

Note To administer FileMaker Server from a remote computer (open files, close files, and so on), you must install the Server Administration plug-in on each remote computer you plan to use for remote administration. For more information, see “Automatically downloading the Server Administration plug-in to a remote computer” on page 7-6.

Where files are stored on your hard disk

The following table shows the location and contents of the installed items.

<table>
<thead>
<tr>
<th>FileMaker Server 5.5 folder</th>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FileMaker Server</td>
<td>The FileMaker Server application</td>
</tr>
<tr>
<td></td>
<td>Read Me</td>
<td>A text file containing important information about this release of FileMaker Server</td>
</tr>
<tr>
<td></td>
<td>FileMaker on the Web</td>
<td>An alias for Go_FileMaker.html</td>
</tr>
</tbody>
</table>
### AppleScript Events Information

A FileMaker Pro database that gives an introduction to the Apple events supported by FileMaker Server, so you can control it using AppleScript or similar applications. See the documentation that came with AppleScript or other applications for details on how to send events to FileMaker Server.

### Remote administration plug-in files

- **Windows**
  - `fmpsadm.fmx`
  - `fmpsadm.fmx.txt`

- **Mac OS X**
  - `Server Administration X.bin`
  - `Server Administration X.txt`

- **Mac OS 8.6 to 9.1**
  - `AutoUpdate fmpsadm.fmx`
  - `fmpsadm.fmx.txt`

### AutoUpdate Examples

- `AutoUpdatePlugin.fp5`

A FileMaker Pro database that illustrates how to set up AutoUpdate.

### FileMaker Help

- **FileMaker Help Viewer**
  - An application that displays FileMaker Server Help

- **FileMaker Server Help**
  - Onscreen Help for FileMaker Server

### AppleScript Examples

- **Apple Script files**
  - Sample template scripts to use with FileMaker Server

<table>
<thead>
<tr>
<th>FileMaker Server 5.5 folder</th>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppleScript Examples:Apple Events Information</td>
<td>FM</td>
<td>AutoUpdate fmpsadm.fmx fmpsadm.fmx.txt</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>Remote administration plug-in files for Windows</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>Server Administration X.bin Server Administration X.txt</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>Remote administration plug-in files for Mac OS X</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>Server Administration.bin Server Administration.txt</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>Remote administration plug-in files for Mac OS 8.6 to 9.1</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>AutoUpdatePlugin.fp5 AutoUpdatePlugin</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>A FileMaker Pro database that illustrates how to set up AutoUpdate</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>FileMaker Help Viewer</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>An application that displays FileMaker Server Help</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>FileMaker Server Help Onscreen Help for FileMaker Server</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>Apple Script files</td>
</tr>
<tr>
<td></td>
<td>FM</td>
<td>Sample template scripts to use with FileMaker Server</td>
</tr>
</tbody>
</table>
This page intentionally left blank.
Chapter 4
Installing FileMaker Server in Mac OS X

This chapter provides step-by-step instructions for installing the FileMaker Server application and associated files on your computer running Mac OS X.

What you need
To use FileMaker Server, you need the following equipment and software.

Mac OS X system requirements
To use FileMaker Server, you need:
- any Apple G3 or G4 or compatible computer (CPU upgrade cards are not supported)
- Mac OS X (the Mac OS X “Public Beta” release is not supported)
- FileMaker Pro 5.x for creating and converting databases to be hosted by FileMaker Server 5.5. FileMaker Server 5.5 supports only FileMaker Pro 5.x databases.
- a login account with administrative privileges for installing FileMaker Server
- a web browser for accessing FileMaker on the Web information from the Help menu
- a CD or DVD drive
- 128 MB of available system memory (RAM)
- an internal or external hard disk drive with at least 7.8 MB of free disk space to install the FileMaker Server application and related files. Be sure to allow additional space for the database files you intend to host, which should be located on the same disk as the FileMaker Server application.

Networking requirements
To share files among users on a network, you must use TCP/IP networking. Guests can use the following versions of TCP/IP to access database files hosted by FileMaker Server:

<table>
<thead>
<tr>
<th>Network protocol</th>
<th>Mac OS 8.6 to 9.1 guest</th>
<th>Mac OS X guest</th>
<th>Windows guest</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP 1.1.1</td>
<td>Apple Open Transport</td>
<td>TCP/IP is integrated with Mac OS X</td>
<td>Microsoft TCP/IP-32</td>
</tr>
</tbody>
</table>

Installing FileMaker Server
Use the Installer to install FileMaker Server on your hard disk. The Installer creates a folder called FileMaker Server 5.5.

To install FileMaker Server on your hard disk:
1. Quit all other applications, especially virus protection software, and disable file sharing.
   Note FileMaker, Inc. recommends that you be logged in as the root user during installation.
2. Insert the FileMaker Server CD into your CD or DVD drive. You see the CD window on your screen. If you see only the disc icon, double-click the icon to open its window.
3. Double-click the Installer icon named Start Here Mac OS X
4. Read the license agreement. If you agree to these terms, click Accept
You see the FileMaker Server Installer dialog box.

5. To install the application onto a different disk or into a specific folder, click the Install Location pop-up menu and choose Select Folder. In the dialog box that appears, choose a destination disk and folder, then click Select.

6. Click Install.

7. Type your name, company name (optional), and your installation code.

Tip Your installation code is a seventeen digit number located on a multi-part sticker on the installation code sheet with the FileMaker Server CD.

8. Click OK.

If the hard disk you chose has enough space, the Installer begins installing files.

9. Click Quit to leave the Installer when the installation is finished.

10. If you turned off virus protection and file sharing before installing, turn them back on now.

It’s important to register your copy of FileMaker Server with FileMaker, Inc., so you have full access to customer and technical support. For more information, see “Registration and customer support” on page 1-1.

For information about starting the application, see “Starting FileMaker Server (Mac OS X)” on page 7-3.

Note To enable administration functions on remote computers (open files, close files, and so on), you must install the Server Administration plug-in on each remote computer you plan to use for remote administration. For more information, see “Automatically downloading the Server Administration plug-in to a remote computer” on page 7-6.

Where files are stored on your hard disk

The following table shows the location and contents of the installed items.

<table>
<thead>
<tr>
<th>FileMaker Server 5.5 folder</th>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileMaker Server 5.5 folder</td>
<td>FileMaker Server Config</td>
<td>The FileMaker Server configuration application and the server application</td>
</tr>
<tr>
<td></td>
<td>Read Me.txt</td>
<td>A text file containing important information about this release of FileMaker Server</td>
</tr>
<tr>
<td></td>
<td>FileMaker on the Web</td>
<td>An alias for Go_FileMaker.html</td>
</tr>
<tr>
<td></td>
<td>AppleScript Examples</td>
<td>An alias for the AppleScript Examples folder for more information</td>
</tr>
<tr>
<td></td>
<td>AutoUpdate</td>
<td>Remote administration plug-in files for Windows</td>
</tr>
<tr>
<td></td>
<td>Server Administration X.bin</td>
<td>Remote administration plug-in files for Mac OS X</td>
</tr>
</tbody>
</table>
### FileMaker Server 5.5 folder

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Administration.bin</td>
<td>Remote administration plug-in files for Mac OS 8.6 to 9.1</td>
</tr>
<tr>
<td>Server Administration.txt</td>
<td></td>
</tr>
</tbody>
</table>

**AutoUpdate**

- **Examples:**
  - AutoUpdatePlugin
  - AutoUpdatePlugin.fp5

  A FileMaker Pro database that illustrates how to set up AutoUpdate

**FMI**

- **Go_FileMaker.html**

  HTML document source file for FileMaker on the Web

- **FMS_Logo.gif**

  Graphic file of FileMaker Server logo for the FileMaker on the Web document

**Important**: Do not alter the contents of the FileMaker Server Package. Doing so could permanently damage FileMaker Server.
This page intentionally left blank.
Chapter 5
Installing FileMaker Server in Red Hat Linux

This chapter provides step-by-step instructions for installing FileMaker Server and associated files on a computer running the Red Hat Linux operating system.

What you need
To use FileMaker Server, you need the following equipment and software.

Red Hat Linux system requirements
- an Intel compatible PC with a Pentium or later processor
- at least 64 MB of installed RAM
- Red Hat Linux 6.2 or 7.0 operating system
- a hard disk drive
- a CD or DVD drive
- FileMaker Pro 5.x for a Windows or Mac OS computer for running the remote administration capability and for creating and converting files to be hosted by FileMaker Server 5.5
- a hard disk with at least 4 MB free disk space for the FileMaker Server files. Be sure to allow additional space for the database files you intend to host, which should be located on the same disk as the FileMaker Server application.

Networking requirements
To share files among users on a network, you need to have the following additional software and hardware installed on the host computer running FileMaker Server:
- a Red Hat Linux compatible network card
- the kernel module for your network card
- TCP/IP network protocol for Red Hat Linux

Note: If you have a second network card, you can specify a preferred IP address for FileMaker Server. For more information, see “Specifying the preferred IP address” on page 9-12.

Installing and registering FileMaker Server
You can use the terminal window or a pseudo terminal (pts) to install FileMaker Server 5.5.

Important: You must be logged in as the root user during installation and when making changes to the FileMaker Server configuration file. Logging in as root gives you complete access to all system resources. Be extremely careful when working as the root user. You could accidentally issue a command that could detrimentally affect your operating system software.

To install FileMaker Server:
1. Insert the FileMaker Server CD into your CD or DVD drive.
2. Switch to the root user by entering the following command at the shell prompt:
   $$ su -l root
   For information about accessing the shell prompt, see your operating system documentation.
3. Enter the root password.
   The prompt changes to #, indicating that you are now logged in as the root user.
4. Mount the installation CD by entering:
   $$ mount /mnt/cdrom
5. Change to the CD directory by entering:

   `# cd /mnt/cdrom`

6. Enter the following command to install the FileMaker Server files on your hard disk:

   `# rpm -Uvh fmserver-5.5-1.i386.rpm`

7. Enter the registration command followed by your installation code and the location of the FileMaker Server binary on your server computer. For example:

   `# fms_registration 1-1111-1111-1111-1111 /usr/bin/fmserverd`

   **Tip** Your installation code is a seventeen digit number located on a multi-part sticker on the installation code sheet with the FileMaker Server CD.

   Registering FileMaker Server in Red Hat Linux activates the FileMaker Server daemon and lets you start the FileMaker Server service.

8. Log out as the root user by entering:

   `# logout`

   It’s important to register your copy of FileMaker Server with FileMaker, Inc., so you have full access to customer and technical support. For more information, see “Registration and customer support” on page 1-1.

   For information about configuring and using FileMaker Server on the server computer, see chapter 9, “Using FileMaker Server in Red Hat Linux.” For information about using remote administration, see “Enabling remote administration in FileMaker Server” on page 9-10 and chapter 10, “Manually installing the Server Administration plug-in on a remote computer.”

---

### Where files are stored on your hard disk

The following table describes the FileMaker Server files and directories that are installed on your hard disk.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/etc/fmserver.conf</code></td>
<td>The FileMaker Server configuration file</td>
</tr>
<tr>
<td><code>/etc/rc.d/init.d/fmserverd</code></td>
<td>An auto-start and stop script for FileMaker Server. For more information, see “Starting and stopping FileMaker Server automatically” on page 9-2.</td>
</tr>
<tr>
<td><code>/usr/bin/fmspasswd</code></td>
<td>A utility for setting the remote administration and directory service passwords</td>
</tr>
<tr>
<td><code>/usr/bin/fmserverd</code></td>
<td>The FileMaker Server daemon binary file</td>
</tr>
<tr>
<td><code>/usr/bin/fms_registration</code></td>
<td>A utility for activating the FileMaker Server daemon (fmserverd), enabling it to start the FileMaker Server service. You run this utility only once immediately after installation.</td>
</tr>
<tr>
<td><code>/usr/doc/fmserver-5.5</code></td>
<td>The directory containing the FileMaker Server 5.5 Readme file, <em>FileMaker Server Administrator’s Guide</em> PDF, quick reference PDF, Auto Update developer documentation and sample file, and license</td>
</tr>
<tr>
<td><code>/usr/doc/fmserver-5.5/backup.sample</code></td>
<td>A sample backup script</td>
</tr>
<tr>
<td><code>/var/fmserver</code></td>
<td>The directory where you place FileMaker Pro databases that you want to host</td>
</tr>
</tbody>
</table>
Uninstalling FileMaker Server

If you need to remove the FileMaker Server software from your computer, you do not need to stop the FileMaker Server service. The operating system’s application removal command (rpm) can detect if FileMaker Server is running and will warn guests and stop the service before removing FileMaker Server from your computer.

The rpm command removes only those files installed by the FileMaker Server installer. Therefore, hosted database files placed on the server by the FileMaker Server administrator and log files created by FileMaker Server are not removed when you uninstall FileMaker Server.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/var/fmserver/AutoUpdate/FMPSADM.FMX</td>
<td>Remote administration plug-in files for Windows</td>
</tr>
<tr>
<td>/var/fmserver/AutoUpdate/FMPSADM.FMX.txt</td>
<td></td>
</tr>
<tr>
<td>/var/fmserver/AutoUpdate/Server Administration X.bin</td>
<td>Remote administration plug-in files for Mac OS X</td>
</tr>
<tr>
<td>/var/fmserver/AutoUpdate/Server Administration X.txt</td>
<td></td>
</tr>
<tr>
<td>/var/fmserver/AutoUpdate/Server Administration.bin</td>
<td>Remote administration plug-in files for Mac OS 8.6 to 9.1</td>
</tr>
<tr>
<td>/var/fmserver/AutoUpdate/Server Administration.txt</td>
<td></td>
</tr>
<tr>
<td>/var/log/fmserver</td>
<td>The directory containing log files (events.log and stats.log) for FileMaker Server. The stats.log file appears in this directory after you enable statistics logging.</td>
</tr>
</tbody>
</table>

**Note** The FileMaker Server configuration file (fmserver.conf) is backed up and saved during uninstall. Therefore, you will have access to your customized settings if you choose to reinstall FileMaker Server.

To remove all files from your hard disk that were installed by the FileMaker Server installer:

1. Switch to the root user by entering the following command at the shell prompt:
   
   ```bash
   $ su -l root
   ```

2. Enter the root password.

3. Enter the following command to remove FileMaker Server:
   
   ```bash
   # rpm -e fmserver
   ```

4. Log out as the root user by entering:
   
   ```bash
   # logout
   ```
This page intentionally left blank.
Chapter 6
Configuring FileMaker Server (Windows and Mac OS)

Configuration settings allow you to customize FileMaker Server for optimal performance.

Windows: Use the configuration assistants in the FileMaker Server Console or the Properties dialog box to configure FileMaker Server.

Mac OS: Use the Preferences dialog box to configure FileMaker Server.

Red Hat Linux: For information about configuring FileMaker Server settings in Red Hat Linux, see chapter 9, “Using FileMaker Server in Red Hat Linux.”

The following table lists all FileMaker Server configuration settings.

<table>
<thead>
<tr>
<th>Configuration setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Set the maximum number of simultaneously connected guests</td>
</tr>
<tr>
<td>- Set idle disconnect time and customize the pre-disconnect message</td>
</tr>
<tr>
<td>- Require users to be logged on to the same Windows domain in which FileMaker Server resides</td>
</tr>
<tr>
<td>- Set the maximum number of hosted files</td>
</tr>
<tr>
<td>- Allocate the amount of memory (RAM) FileMaker Server can use as database cache</td>
</tr>
<tr>
<td>- Set how often database cache is flushed</td>
</tr>
<tr>
<td>- Allow single user files to be hosted and shared</td>
</tr>
<tr>
<td>- Allow plug-in updates to be downloaded automatically</td>
</tr>
<tr>
<td>- Enable runtime files created by FileMaker Developer to be opened automatically by FileMaker Server</td>
</tr>
<tr>
<td>- Enable remote administration and specify a password</td>
</tr>
<tr>
<td>- Specify a custom server name that appears in the Hosts dialog box</td>
</tr>
<tr>
<td>- Maximize performance (Mac OS 8.6 to 9.1)</td>
</tr>
<tr>
<td>- Specify the network protocol(s) FileMaker Server will use and choose a preferred IP address</td>
</tr>
<tr>
<td>- Enable usage statistics to be recorded in a log and set a maximum size for the log</td>
</tr>
<tr>
<td>- Register FileMaker Server with a directory service</td>
</tr>
<tr>
<td>- Allow the FileMaker Server administrator’s contact information to be published to the directory service</td>
</tr>
<tr>
<td>- Specify how to authenticate FileMaker Server to a directory server</td>
</tr>
<tr>
<td>- Change the LDAP port number</td>
</tr>
</tbody>
</table>

Note: The memory requirements of FileMaker Server are directly related to the number of guests and open files. If you select large values for these, you should also increase the amount of RAM reserved for the database cache. See “Changing the amount of memory used by FileMaker Server” on page 6-5 or “Adjusting memory (Mac OS 8.6 to 9.1)” on page 6-6 for more details.

Using the configuration assistants (Windows)

In Windows, FileMaker Server comes with configuration assistants to help you set up server options. These assistants step you through the configuration process, giving you helpful instructions along the way. You can use these assistants to set up your initial configuration, and then use the Properties dialog box as described in this chapter to change settings, if needed.
To access the assistants:

1. Click the Start button > Programs > FileMaker Server Console.
You see the FileMaker Server Console.

2. Click one of the icons in the right panel to start an assistant.

Opening the Properties dialog box (Windows)

1. Click the Start button > Programs > FileMaker Server Console.
You see the FileMaker Server console.
2. Select FileMaker Server in the Console Tree, if it’s not already selected.
You see the Properties dialog box, which has seven tabs: Guests, Files, File Types, Administration, Networking, Logging, and Directory Service.

Opening the Preferences dialog box (Mac OS 8.6 to 9.1)

1. Double-click the FileMaker Server icon to start the application. If FileMaker Server is running, choose Application menu > FileMaker Server in the upper-right corner of the desktop to bring it to the foreground.
2. Choose Edit menu > Preferences.
You see a dialog box with six tabs: Guests, Files, Administration, Networking, Logging, and Directory Service.

4. Click a tab to set options for FileMaker Server configuration. For configuration details, skip the next two sections and refer to the remaining sections in this chapter.
3. Click a tab to set options for FileMaker Server configuration. For configuration details, skip the next section and refer to the remaining sections in this chapter.

**Opening the Preferences dialog (Mac OS X)**

1. Double-click the FileMaker Server Config icon to start the application.

   **Tip** If FileMaker Server is running, click the FileMaker Server Config icon in the Mac OS X Dock to bring it to the foreground.

2. Choose FMServer Config menu > Preferences.

   You see a dialog with seven tabs: Guests, Files, File Types, Administration, Networking, Logging, and Directory Service.

**Setting the number of guests**

You can specify the number of guests who are simultaneously connected to FileMaker Server. Specifying a lower number leaves more memory available for FileMaker Server to operate.

See appendix B, “Performance and usage tips” for more information about memory optimization.

To set the number of FileMaker Pro guests:

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Guests tab.

2. Enter a number for the Maximum number of simultaneously connected guests option.

The minimum number of guests is 1 and the maximum is 250. (AppleTalk support is limited to 124 simultaneous guests.)
For example, if you monitor guest usage over time and notice you rarely have more than 22 guests active at one time, set this option to allow 25 guests for best performance on your server.

3. Set any other options, then click OK.

If you increase the number of guests allowed, you must restart FileMaker Server for the new setting to take effect.

## Allowing disconnection of idle guests

FileMaker Server can disconnect guests who have been idle for more than a specified period of time. You can:

- specify the amount of time before idle guests are disconnected
- use the default disconnect message to warn guests that they will be disconnected, or write a custom message

*Note* In FileMaker Pro 5.5, you can use a password privilege to keep a guest connected to FileMaker Server when the guest is idle. In some instances, such as when a guest is also serving as a web publishing host, the guest should maintain a connection to FileMaker Server, so that users connecting to the database through a browser will be able to access the database. For more information, see FileMaker Pro 5.5 Help.

### Setting a time to disconnect idle guests

FileMaker Server can disconnect guests after a specified amount of idle time.

*Tip* To avoid being disconnected, guests should periodically show some activity (for example, move to a different record, then click in one of the fields) when working in databases hosted by FileMaker Server.

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the *Guests* tab.
2. Select *Disconnect Idle Guests*.
3. Click the up or down arrow to select the amount of idle time after which inactive guests should be disconnected. The minimum setting is 10 minutes and the maximum setting is 24 hours.
4. Set any other options, then click OK.

### Setting the pre-disconnect message

Before an idle guest is disconnected from a hosted database, FileMaker Server sends the guest a message to warn that disconnection will occur soon. You can send a default message from FileMaker Server or you can type your own message.

To customize the pre-disconnect message:

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the *Guests* tab, and select *Disconnect Idle Guests*.
2. Select *Custom message*, then type a message in the text box.
3. Set any other options, then click OK.

### Authenticating guest log on (Windows)

If FileMaker Server is running on Windows and is a member of a Windows NT 4.0 or Windows 2000 domain, you can require that guests are members of the same domain as FileMaker Server before they are granted access to a hosted database.

*Note* Guests attempting to access hosted databases on this server must be using FileMaker Pro 5.5 to gain access to a database protected by Windows authentication.

If guests are not already logged on to the same domain as FileMaker Server when they attempt to open a protected database, they are prompted for their user name and password for a Windows domain.

Records of all logon attempts are logged in the Windows Security Log. For more information about the Security Log, see your Windows documentation.
To require users to be logged on to the same domain in which FileMaker Server resides:

1. In the Properties dialog box, click the **Guests** tab.
2. Select **Require FileMaker Pro guests to log on to a Windows domain**.
3. Set any other options, then click **OK**.

### Setting the maximum number of files

You can specify the maximum number of database files FileMaker Server can open at one time. If you consistently monitor database usage, you can set the maximum number of files for best performance on your server. Specifying a lower number leaves more memory available for FileMaker Server. See appendix B, “Performance and usage tips,” for more information about memory optimization.

To set the maximum number of files FileMaker Server can host:

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the **Files** tab.
2. Enter a number close to the number of files you expect to host on FileMaker Server.
3. Set any other options, then click **OK**.

If you increase the number of files allowed, you must restart FileMaker Server for the new setting to take effect.

### Changing the amount of memory used by FileMaker Server

The operating system sets aside a certain amount of memory for each application. When you start FileMaker Server, it tells Windows or the Mac OS how much memory it needs based on its **Reserve** setting. Increasing the RAM reserved for the database cache can speed up overall performance, especially if your server hosts large files or a large number of guests or files.

Mac OS 8.6 to 9.1: The amount of application memory specified in the FileMaker Server Info dialog box also affects the operation of FileMaker Server. For more information, see “Adjusting memory (Mac OS 8.6 to 9.1)” on page 6-6.

To change the amount of memory FileMaker Server uses:

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the **Files** tab.
2. Enter the amount of RAM you want to allocate in the **Reserve** box.
3. Set any other options, then click **OK**.

You must restart FileMaker Server for the new setting to take effect.
Adjusting memory (Mac OS 8.6 to 9.1)

Your computer sets aside a certain amount of memory for each application. When you start FileMaker Server, it tells the computer how much memory it needs.

If you plan to host large database files or a large number of files, you can increase the amount of memory (RAM) set aside for FileMaker Server.

Changing the amount of memory used

To change the amount of memory reserved for FileMaker Server, keep these points in mind:

- FileMaker Server comes configured with 8 MB of memory (RAM) allocated to it. This configuration supports the default number of guests (25) and files (50). Increasing memory can speed up overall performance, especially if you are working with large files or a large number of guests or files.
- The amount of memory you give to other applications affects the performance of FileMaker Server. FileMaker Server is designed to run by itself on a dedicated computer. By not running other applications, you can assign all available memory to FileMaker Server.
- Avoid specifying less memory than the Suggested Size in the FileMaker Server Info dialog box.
- If you make changes to FileMaker Server preferences while running FileMaker Server, FileMaker Server asks you if you want to automatically adjust the application memory setting in the FileMaker Server Info dialog box to accommodate the new settings. If you click OK in the confirmation dialog box, application memory is adjusted for you. If you click Cancel in the confirmation dialog box, you should use the following procedure to adjust the application memory manually.

See appendix B. “Performance and usage tips” for suggestions for optimizing memory settings.

To change the amount of memory FileMaker Server uses:

1. If FileMaker Server is running, close the application by choosing File menu > Quit.
2. Select the FileMaker Server application icon.
3. Choose File menu > Get Info > Memory.
4. Double-click the number labeled Preferred Size.
5. Type a number to change the memory allocated for FileMaker Server.
6. Click the close box.

The next time you start FileMaker Server, the amount of memory you specified is used by the application.
FileMaker Server, virtual memory, and physical memory requirements

FileMaker Server and the virtual memory option (available with Mac OS 8.6 to 9.1) both use your hard disk to store temporary information. Virtual memory provides file mapping, which can improve the performance of FileMaker Server. If you choose to turn on virtual memory while FileMaker Server is running, ensure that you have enough physical memory to satisfy the requirements of both the Mac OS and FileMaker Server so that virtual memory won’t degrade the performance of FileMaker Server.

To determine how much physical memory you need to use FileMaker Server with virtual memory turned on:

1. Click the desktop to switch to the Finder.
2. Choose Apple > About This Computer and note how much memory the Mac OS is using.
3. Add this figure to the preferred amount of memory to determine how much physical memory you need for optimal performance of FileMaker Server with virtual memory turned on. FileMaker Server requires 8 MB for 25 guests and 50 files.

Setting how often the cache is flushed

FileMaker Server flushes (writes) information stored in the cache (temporary storage) to disk whenever FileMaker Server is idle, but you can set the cache to be flushed at specific intervals. If the cache is flushed frequently, data integrity in hosted files is improved but performance may decline.

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Files tab.
2. Select Flush cache every n hours or minutes.
3. Click the up or down arrow to select the time interval.
The minimum setting is 15 minutes and the maximum setting is 2 hours.
4. Set any other options, then click OK.

Allowing single user files to be hosted

For your convenience, you can set FileMaker Server to host single user files. This setting lets you host databases without first having to manually change them to multi-user in FileMaker Pro.

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Files tab.
2. Select Allow FileMaker Server to host Single User files.
3. Set any other options, then click OK.

Allowing software updates to be downloaded automatically

You can store software updates on the server computer and allow FileMaker Pro 5.5 guests to download these files automatically when they open database files hosted by FileMaker Server 5.5. Examples of files you can download automatically are plug-in files or plug-in license files, sometimes required by FileMaker Pro databases.

When a FileMaker Pro file is hosted using FileMaker Server, any plug-ins required by the file must exist on each guest computer used to open the database. By allowing plug-in updates to be downloaded automatically, you ensure that all guests have access to plug-ins required by a database the first time they attempt to open it. In addition, when plug-ins are changed by database developers, you can store new versions on the server computer, so you don’t have to update plug-ins on many individual guest computers.

For automatic file downloading to work correctly, you must place current plug-in files and text files containing plug-in version information in the correct location on the server computer. In addition, guests must activate the Auto Update plug-in in the Application preferences in FileMaker Pro 5.5 before attempting to open hosted files that require plug-ins.
To set up FileMaker Server to automatically download software updates to guest computers:

1. Obtain current plug-in and version control files from your FileMaker Pro database developers.

2. Create a folder named `AutoUpdate` in the folder that contains the database that uses plug-ins.

   Tip If you host multiple databases that use the same plug-ins, store updates in the `AutoUpdate` folder in the FileMaker Server 5.5 folder, rather than in individual `AutoUpdate` folders in each database folder. This allows you to store an update in one place on the server computer, and makes it available for all databases that need it.

3. Place files for automatic download in the `AutoUpdate` folder.

   Tip If some guest computers on your network run Windows and some run the Mac OS, you can include both Windows and Mac OS versions of the plug-in in the `AutoUpdate` folder.

4. In the FileMaker Server Properties (Windows) or Preferences (Mac OS) dialog box, click the Files tab.

5. Select Allow FileMaker Pro guests to download updates automatically.

6. Set any other options, then click OK.

7. Instruct users of guest computers to enable automatic download in FileMaker Pro 5.5 as follows: Start FileMaker Pro, choose Edit menu > Preferences > Application (Windows and Mac OS 8.6 to 9.1) or FileMaker Pro menu > Preferences > Application (Mac OS X).

8. Click the Plug-ins tab and select Auto Update.

Note FileMaker Pro 5.5 can check the version of plug-in files required by a hosted database and update plug-ins if the current version is not located on the guest computer. However, FileMaker Pro cannot verify the version of other downloadable files. If a non-plug-in file is located on both the server and guest computers, the file on the guest computer is backed up in the Saved System Folder (Windows) or Saved FileMaker Extensions Folder (Mac OS) and then the file from the server is placed in the System Folder (Windows) or FileMaker Extensions Folder (Mac OS).

**Opening runtime solutions automatically (Windows and Mac OS X)**

You can have FileMaker Server automatically host runtime solution files that have been bound using FileMaker Developer 5.x and have a custom filename extension.

**About FileMaker Developer**

FileMaker Developer lets database developers create and distribute complete single user database solutions with layouts that are not modifiable by users.

Runtime solution files typically have unique filename extensions. For example, rather than the standard .fp5 extension, a runtime solution file might have the extension .cm1. Registering these runtime solution filename extensions in the FileMaker Server Properties (Windows) or Preferences (Mac OS) dialog box enables FileMaker Server to open these files automatically when they are placed in the same folder as the FileMaker Server application (or subfolders one level down).

To enable FileMaker Server to open runtime solution files automatically:

1. In the Properties (Windows) or Preferences (Mac OS X) dialog box, click the File Types tab.

---

<table>
<thead>
<tr>
<th>Guest platform</th>
<th>File format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>.fmx file type for plug-in files</td>
</tr>
<tr>
<td></td>
<td>.txt format plug-in version control files</td>
</tr>
<tr>
<td>Mac OS</td>
<td>.fmxt file type in bin format (MacBinary) for plug-in files</td>
</tr>
<tr>
<td></td>
<td>.txt format plug-in version control files</td>
</tr>
</tbody>
</table>

---
2. Select Allow FileMaker Server to open registered runtime solutions.
3. To register a filename extension for a runtime solution, type the extension into the first box, then click Add.
You can register a maximum of 16 filename extensions. You can use the following wildcard characters when defining filename extensions.

<table>
<thead>
<tr>
<th>Use this character</th>
<th>To indicate</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Zero or more characters. For example, c* registers all extensions that begin with c.</td>
</tr>
<tr>
<td>?</td>
<td>One character. For example, c?p registers all extensions that begin with c and end with p, and c? registers all extensions that begin with c and are two characters in length.</td>
</tr>
</tbody>
</table>

4. To remove a filename extension, select it, then click Remove.
5. Set any other options, then click OK.

Opening runtime solutions automatically (Mac OS 8.6 to 9.1)
You can have FileMaker Server automatically host runtime solution files that have been bound using FileMaker Developer 5.x.

About FileMaker Developer
FileMaker Developer lets database developers create and distribute complete single user database solutions with layouts that are not modifiable by users. Users can purchase and use these databases without having to obtain full FileMaker Pro licenses for the computers running the databases.

If runtime solution files were bound using FileMaker Developer running in Mac OS 8.6 to 9.1, they open automatically when FileMaker Server starts if they are located in the FileMaker Server 5.5 folder (or subfolders one level down).

If runtime solution files were bound using FileMaker Developer running in Windows, you must open them using FileMaker Pro 5.x running in Mac OS 8.6 to 9.1 and then close them before placing them in the FileMaker Server 5.5 folder (or subfolders one level down). Thereafter, these solution files open automatically when FileMaker Server starts.

Enabling remote administration
Using FileMaker Pro 5.x, you can remotely control, or administer, FileMaker Server from a different computer than the one on which FileMaker Server is installed and hosting databases. After you enable remote administration, you can use a remote computer to view a list of hosted databases, and the guests using them, and monitor performance statistics.
If you have installed the Server Administration plug-in on your remote computer, you can also send messages to guests, disconnect guests, and open or close files remotely. For more information about remote administration tasks, see chapter 7, “Administering FileMaker Server (Windows and Mac OS).” For more information about installing the Server Administration plug-in, see “Automatically downloading the Server Administration plug-in to a remote computer” on page 7-6.

To enable remote administration of FileMaker Server:

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Administration tab.

![Administration tab](image)

   Administration tab (Mac OS 8.6 to 9.1)

   This option, described on page 6-11, is available for FileMaker Server running in Mac OS 8.6 to 9.1 only.

2. Choose one of the following options for remote administration.

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled</td>
<td>Disable remote administration</td>
</tr>
<tr>
<td>Requires no password</td>
<td>Let any FileMaker Pro 5.x guest remotely view statistics or control FileMaker Server</td>
</tr>
<tr>
<td>Requires password</td>
<td>Let FileMaker Pro 5.x guests remotely view statistics or control FileMaker Server only after entering the password you specify. Passwords are limited to 31 characters.</td>
</tr>
</tbody>
</table>

If you select Disabled, the FileMaker Server name is dimmed (not selectable) when FileMaker Pro guests view it in the Hosts dialog box.

3. Set any other options, then click OK.

**Important** If you choose to require a password for security reasons, also remember to restrict access to the server computer. Do not put the computer in an insecure room.

Windows: You can use Windows administrative tools to password-protect a computer. If you do, remember to always log off when leaving the computer unattended.

To prevent guests from viewing or modifying the data, scripts, and layouts in FileMaker Pro, you must create a password in each of the hosted files in FileMaker Pro. See “Protecting files with a password” on page 6-17 for more information.

**Specifying a custom host name**

You can specify a host name for the computer running FileMaker Server that’s different from the name registered by the operating system. When you define a custom name, guests see this new name when they open the Hosts dialog box in FileMaker Pro and when they administer FileMaker Server remotely.
Note: Guests connecting to databases hosted by FileMaker Server might see the host name displayed in different ways. IPX/SPX displays names using only numerals, uppercase characters, underscores (_), and periods (.), and replaces any other characters with underscores.

Names are limited to 31 characters.

3. Set any other options, then click OK

You must restart FileMaker Server for the new setting to take effect.

Maximizing performance
(Mac OS 8.6 to 9.1)

You can specify that FileMaker Server uses more CPU (central processing unit) cycles than any other application installed on your server computer.

Important: Do not enable this feature unless your server computer is dedicated to only FileMaker Server and unless FileMaker Server always runs in the foreground. If you switch to the Finder on a computer running FileMaker Server in maximum performance mode, expect Finder response time to be slow.

To maximize performance of FileMaker Server:
1. In the Preferences dialog box, click the Administration tab.
2. Select Maximize performance (less CPU time for other applications).
3. Set any other options, then click OK
4. Select FileMaker Server in the Application menu in the upper-right corner of the desktop to ensure that it is running in the foreground.

Choosing network protocols

FileMaker Server can host databases using a variety of network protocols, but TCP/IP is highly recommended.

<table>
<thead>
<tr>
<th>Network protocol</th>
<th>Windows</th>
<th>Mac OS 8.6 to 9.1</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>IPX/SPX</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>AppleTalk</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

To choose the network protocols that FileMaker Server uses:
1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Networking tab.
2. Choose the network protocol(s) you want FileMaker Server to use when communicating with FileMaker Pro guests.

3. Set any other options, then click OK.

You must restart FileMaker Server for the new setting to take effect.

**Setting the preferred IP address**

If you have multiple IP addresses, you can specify the one you want FileMaker Server to use.

Windows and Mac OS X: Each network card in your server computer has its own IP address.

Mac OS 8.6 to 9.1: Apple Open Transport determines the number of IP addresses available for each network card in your computer.

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Networking tab.

2. Select an IP address from the menu.

3. Set any other options, then click OK.

You must restart FileMaker Server for the new setting to take effect.

**Recording usage statistics and setting size limits**

When you enable statistical logging for FileMaker Server, a log file is created in your FileMaker Server 5.5 folder.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Statistics log name</th>
<th>View log in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>fmsvplog.txt</td>
<td>Performance Monitor (Windows NT)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>System Monitor (Windows 2000)</td>
</tr>
<tr>
<td>Mac OS 8.6 to 9.1</td>
<td>Server Statistics Log</td>
<td>Usage Statistics window</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Statistics.log</td>
<td>Mac OS X console application</td>
</tr>
</tbody>
</table>

The log file is a tab-delimited text file, so you can import it into, or drag and drop it onto, FileMaker Pro (or any other application that supports tab-delimited input). You can then examine historical statistical information about how FileMaker Server is performing.

Windows: You can view information from this log in the Usage Statistics window when you administer remotely, or you can display it graphically in real-time on your server computer using the Performance Monitor. For more information about viewing statistics, see “Viewing usage statistics for FileMaker Server” on page 7-7 and “Monitoring performance (Windows NT)” on page 7-17.

Mac OS: You can view information from this log in the Usage Statistics window when you administer either remotely or locally. For more information, see “Viewing usage statistics for FileMaker Server” on page 7-7 and “Viewing usage statistics (Mac OS 8.6 to 9.1)” on page 7-14.
Tips

- Renaming logs

Windows and Mac OS 8.6 to 9.1: When FileMaker Server is stopped and restarted, the existing log file is renamed fmsvplas.txt (Windows) or Server Last Statistics Log (Mac OS 8.6 to 9.1). A new log is created to record information for the current session. To save statistics for more than two sessions, rename the backup copy of the log before restarting FileMaker Server or it will be overwritten.

Mac OS X: When Statistics.log reaches its maximum size, it is renamed Statistics-old.log and a new Statistics.log is created.

- Displaying statistics graphically

Mac OS 8.6 to 9.1: To display statistical information graphically in real-time, you can use Apple events to transfer information from the Server Statistics Log to Microsoft Excel. You can then use Microsoft Excel to chart statistics. For more information about supported Apple events, see the AppleScript Examples folder inside the FileMaker Server 5.5 folder.


To record usage statistics in a log file:

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Logging tab.
2. Select Log Usage Statistics.
3. For Collect and update Usage Statistics every option, select a time interval. The minimum collection interval is 1 second and the maximum is 5 minutes.

FileMaker Server collects statistical information at the interval you selected, then writes this information to the log file at the interval displayed in Server will write to the Statistics Log every (Hhmmss).
The difference between how often data is collected and how often it is written to the log depends on the size of the FileMaker Server cache. Holding statistics in the cache rather than writing to the log at each collection optimizes performance while still providing useful and timely statistical information.

4. For **Maximum size of Statistics Log**, select a maximum size in megabytes for the log file. The minimum setting is 1 MB and the maximum is 40 MB.

5. Set any other options, then click **OK**.

For information on the types of statistics that are collected in the Statistics Log, see “Viewing usage statistics for FileMaker Server” on page 7-7.

### Setting a size limit for the Application Log (Windows NT)

You can set a maximum size for the FileMaker Server Application Log, which records with a timestamp situations that occur while FileMaker Server is running. Typical events that are logged include FileMaker Server startup and shut down, database file opening and closing, guests logging on and off, tasks that execute on schedules, and changes to FileMaker Server properties.

To set the size of the FileMaker Server Application Log:

1. Click the **Start** button > **Programs** > **Administrative Tools (Common)** > **Event Viewer**.
2. Choose **Log menu** > **Log Settings**.
3. For **Maximum Log size**, select a maximum size in kilobytes for the FileMaker Server Application Log.
4. Click **OK**.

**Tip** You might want to overwrite data when the log is full so you always have current events in the log. For more information, see “Keeping event data current (Windows)” on page 7-20.

### Setting a size limit for the Application Log (Windows 2000)

You can set a maximum size for the FileMaker Server Application Log, which records with a timestamp situations that occur while FileMaker Server is running. Typical events that are logged include FileMaker Server startup and shut down, database file opening and closing, guests logging on and off, tasks that execute on schedules, and changes to FileMaker Server properties.

To set the size of the FileMaker Server Application Log:

1. Click the **Start** button > **Programs** > **FileMaker Server Console**.
2. Select **Event Viewer (Local)** in the Console Tree.
3. Select the FileMaker Server icon in the Details Pane of the Event Viewer console.
4. Right-click and select **Properties**.
5. For **Maximum Log size**, select a maximum size in kilobytes for the FileMaker Server Application Log.
6. Click **OK**.

**Tip** You might want to overwrite data when the log is full so you always have current events in the log. For more information, see “Keeping event data current (Windows)” on page 7-20.
Setting a size limit for the event log
(Mac OS)

You can set a maximum size for the Server Event Log (Mac OS 8.6 to 9.1) or Events.log (Mac OS X), which records with a timestamp situations that occur while FileMaker Server is running. Typical events that are logged include FileMaker Server startup and shutdown, database file opening and closing, guests logging on and off, tasks that execute on schedules, and changes to FileMaker Server preferences.

To set the size of the event log:
1. In the Preferences dialog box, click the Logging tab.
2. For Maximum size of Event Log, select a maximum size in megabytes.

The minimum size setting for the log is 1 MB and the maximum is 40 MB.
3. Set any other options, then click OK.

Using FileMaker Server with a directory service

If your organization uses a Lightweight Directory Access Protocol (LDAP)-compliant directory service, such as Microsoft Active Directory, Netscape Directory, or OpenLDAP, you can centrally manage your hosted databases by registering FileMaker Server with your directory service.

When FileMaker Server is registered with an LDAP-compliant directory service, its host name and IP address are published to the directory service. The FileMaker Server administrator’s contact information can also be published.

Your system administrator should be able to give you the information you need to complete the required directory service preference settings.

For information about setting up a directory service, see the Directory Service folder on the FileMaker Server CD.

Registering FileMaker Server with a directory service

Note: This feature requires TCP/IP to be the selected network protocol.

To register FileMaker Server with a directory service:
1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Directory Service tab.
2. Select Register FileMaker Server with a directory service.
3. Type the directory service name (IP address) in the top box.
4. Type the distinguished name in the second box.
The distinguished name specifies the location of FileMaker Server in the directory service. For example:

```
ou=FileMaker,dc=mydomain,dc=Sales
```

Spaces after commas are optional.

5. Set any other options, then click OK.

**Specifying the authentication method (Windows)**

To specify how to authenticate FileMaker Server to a directory server:

1. In the Properties dialog box, click the Directory Service tab.
2. Select Register FileMaker Server with a directory service.
3. Choose from the following options for user authentication.

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Windows Authentication</td>
<td>Use the account name and password of a Windows domain to access Microsoft Active Directory</td>
</tr>
<tr>
<td>Log on as current user</td>
<td>Log on using the current Windows account, if Use Windows Authentication is selected</td>
</tr>
<tr>
<td>Log on anonymously</td>
<td>Log on without specifying an account name and password. (This option is not available if Use Windows Authentication is selected.)</td>
</tr>
<tr>
<td>Specify account name and password</td>
<td>Log on using the account name and password you specify</td>
</tr>
</tbody>
</table>

4. Set any other options, then click OK.

**Specifying the authentication method (Mac OS)**

To specify how to authenticate FileMaker Server to a directory server:

1. In the Preferences dialog box, click the Directory Service tab.
2. Select Register FileMaker Server with a directory service.
3. Click Options.
4. In the Options dialog box, enter the contact information you want to publish.

For example:

If you are using Windows 2000 Active Directory, for the Owner field:

```
CN=user1,CN=users,dc=mydomain,dc=filemaker,dc=com
```

If you are using another LDAPv3-compliant directory service, for the Owner field:

```
Marie Durand
```

5. Click OK.

**Publishing your contact information to your directory service**

As the FileMaker Server administrator, you can publish your name, location, phone number, and e-mail address to your directory service. This is useful if the directory service administrator needs to contact you if, for example, hosted databases are unavailable for guest access.

To publish contact information for the FileMaker Server administrator:

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Directory Service tab.
2. Select Register FileMaker Server with a directory service.
3. Click Options.
4. In the Options dialog box, enter the contact information you want to publish.

For example:

If you are using Windows 2000 Active Directory, for the Owner field:

```
CN=user1,CN=users,dc=mydomain,dc=filemaker,dc=com
```

If you are using another LDAPv3-compliant directory service, for the Owner field:

```
Marie Durand
```
Changing the port number

The port number setting indicates the type of the port required by your directory service. Some LDAP-compliant directory services use a port number other than the default, 389.

To change the port number for your directory service connection:

1. In the Properties (Windows) or Preferences (Mac OS) dialog box, click the Directory Service tab.
2. Select Register FileMaker Server with a directory service.
3. Click Advanced.
4. In the Advanced dialog box, type a number.
5. Click Default to restore the value to 389, the designated port number for LDAP.
6. Click OK.

Protecting files with a password

It is especially important to use the access privileges in FileMaker Pro when files are shared on a network. Using FileMaker Pro, you can restrict what users see and do in a database file by defining passwords and groups. Passwords limit what users can do and groups limit the layouts and fields they can see.

Important: Protect shared FileMaker Pro 5.x files by using FileMaker Pro access privileges. Although the shared FileMaker Pro files reside on a file server, which may have its own security scheme, any files available to FileMaker Pro guests bypass network and file server protection. For more information about protecting files with a password, see chapter 9 in the FileMaker Pro 5 User’s Guide. See also FileMaker Pro 5.5 Help for information about using record-by-record access privileges.

How FileMaker Server behaves during system sleep (Windows 2000 and Mac OS)

Windows 2000 supports Power Conservation mode, which can cause your server computer to sleep (hibernate or enter Standby mode), suspending access to hosted databases.

Computers running the Mac OS can suspend operation when they enter an energy-saving system sleep state.

FileMaker Inc. recommends that you disable sleep mode on computers running FileMaker Server.

To prevent your system from sleeping:


Restoring FileMaker Server default settings

To restore all default settings:

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac OS 8.6 to 9.1</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uninstall FileMaker Server and reinstall it. See “Uninstalling FileMaker Server (Windows)” on page 2-5.</td>
<td>Quit FileMaker Server, then delete the files FileMaker Server 5.5 Prefs. This file is stored in the Preferences folder inside the System Folder.</td>
<td>In the Preferences dialog, click the Restore Settings button, click OK, then restart FileMaker Server Config.</td>
</tr>
</tbody>
</table>
Mac OS: Disable system sleep in the Energy Saver control panel (Mac OS 8.6 to 9.1) or Energy Saver preferences (Mac OS X) by setting the slider control to Never in the Put the system to sleep whenever it is inactive area.

If sleep is enabled on the computer running FileMaker Server, it’s important to understand how FileMaker Server reacts, should the computer enter sleep mode:

- If there are no guests connected to hosted files when the operating system notifies FileMaker Server that it is going to sleep, FileMaker Server flushes the cache to disk and leaves hosted databases open. Because the cache is saved to disk before the computer sleeps, hosted databases experience no data loss and are open when the operating system wakes up.

  **Note** Database backups or scripts scheduled in FileMaker Server do not run while the operating system is sleeping.

- If there are guests connected to FileMaker Server when the operating system notifies FileMaker Server that it is going to sleep, FileMaker Server responds to the operating system, instructing that it should not sleep while FileMaker Server is running.

If the operating system shuts down unexpectedly while guests are connected and before the cache can be written to disk (for example, because the battery is critically low, the computer is overheating, or a user turns off the server computer in an emergency), FileMaker Server attempts to recover the state of hosted files when it restarts. As it opens the files located in the FileMaker Server 5.5 folder (or subfolders one level down), FileMaker Server performs a consistency check on each file. If a file is found to be corrupt, FileMaker Server logs a corruption event in the Application Log (Windows 2000) or Server Event Log (Mac OS 8.6 to 9.1) or Events.log (Mac OS X) for database corruption notifications. For more information about viewing the events, see “Viewing activities in the Event Viewer (Windows 2000)” or “Viewing activities in the event log (Mac OS)” on page 7-20.

Also, check your scheduled tasks to ensure that important backups or scripts were not scheduled to run while the operating system was asleep or off. These tasks will not run until the next scheduled time when FileMaker Server is running and the operating system is awake.

To find out the last time a scheduled task ran:
1. Click the Start button > Programs > FileMaker Server Console (Windows 2000) or bring FileMaker Server to the foreground.
2. Click Schedules in the FileMaker Server Console Tree (Windows 2000) or choose Window menu > Schedules Window (Mac OS).
3. Look at the time and date displayed in the Last Run column.
Chapter 7
Administering FileMaker Server (Windows and Mac OS)

This chapter provides information about starting and stopping FileMaker Server and administering hosted files.

Note: For information about administering FileMaker Server running in Red Hat Linux, see chapter 9, “Using FileMaker Server in Red Hat Linux.”

Starting FileMaker Server (Windows NT)

To start the FileMaker Server service:

1. Place the FileMaker Pro 5.x files that you want FileMaker Server to open—or shortcuts to those files—in the same folder as FileMaker Server (or in subfolders one level down).
   Up to 125 FileMaker Pro 5.x database files can be automatically opened when FileMaker Server starts up.

2. Click the Start button > Settings > Control Panel.

3. Double-click the Services icon.

4. Select FileMaker Server in the list, then click Start.
   FileMaker Server opens the FileMaker Pro files for access by FileMaker Pro 5.x guests on the network.

Note: The Services control panel also lets you change how FileMaker Server starts: either manually or automatically. If you want to start FileMaker Server manually when Windows restarts, click the Startup button, then click Manual. If you want FileMaker Server to start automatically when Windows restarts, click the Startup button, then click Automatic.

For information about starting the FileMaker Server service from the command prompt, see “Using the command line to automate tasks (Windows)” on page 8-8.

Starting FileMaker Server (Windows 2000)

To start the FileMaker Server service:

1. Place the FileMaker Pro 5.x files that you want FileMaker Server to open—or shortcuts to those files—in the same folder as FileMaker Server (or in subfolders one level down).
   Up to 125 FileMaker Pro 5.x database files can be automatically opened when FileMaker Server starts up.

2. Click the Start button > Programs > FileMaker Server Console.
3. Select Services (Local) in the Console Tree.
5. Choose Action menu > Start.

FileMaker Server opens the FileMaker Pro files for access by FileMaker Pro 5.x guests on the network.

For information about starting the FileMaker Server service from the command prompt, see “Using the command line to automate tasks (Windows)” on page 8-8.

**Stopping FileMaker Server (Windows NT)**

Stopping the FileMaker Server service disconnects all FileMaker Pro guests and closes all database files hosted by FileMaker Server.

**Important:** Stop the FileMaker Server service before shutting down Windows to give FileMaker Server adequate time to alert guests and prepare to shut down.

To stop FileMaker Server:
1. Click the Start button > Settings > Control Panel.
2. Double-click the Services icon.
3. Select FileMaker Server in the list, then click Stop.
4. Click Yes in the confirmation dialog box if you’re sure you want to stop the service.

FileMaker Server gives guests five minutes to close files before disconnecting them. Guests see a notification dialog box requesting that they close the files hosted by FileMaker Server.

If guests don't close the files, the dialog box reappears one minute before the files are closed.

After five minutes, FileMaker Server disconnects any remaining guests and begins closing all open files.

The process of stopping the service and closing the files may take several minutes.

**Stopping FileMaker Server (Windows 2000)**

Stopping the FileMaker Server service disconnects all FileMaker Pro guests and closes all database files hosted by FileMaker Server.

To stop FileMaker Server:
1. Click the Start button > Programs > FileMaker Server Console.
2. Select Services (Local) in the Console Tree.
3. Select FileMaker Server in the Details pane, then choose Action menu > Stop.
**Starting FileMaker Server**  
*(Mac OS 8.6 to 9.1)*

Start FileMaker Server by double-clicking its icon in the FileMaker Server 5.5 Folder, or by selecting the icon and choosing File menu > Open.

You can also make an alias to start FileMaker Server automatically each time you start your computer. See the next section for more information.

**Making an alias**

Previous versions of FileMaker Server automatically put an alias of the application in the Startup Items folder of your System Folder.

*Important:* Throw away any alias from a previous version of FileMaker Server in your Startup Items folder.

To make an alias for FileMaker Server:

1. In the Finder, select the FileMaker Server icon in the FileMaker Server 5.5 folder.
2. Choose File menu > Make Alias.

You see an alias of FileMaker Server in the application folder.

3. Copy or drag the alias into the Startup Items folder in your System Folder.

**Quitting FileMaker Server**  
*(Mac OS 8.6 to 9.1)*

Quitting FileMaker Server disconnects all FileMaker Pro guests and closes all database files hosted by FileMaker Server.

To quit FileMaker Server:

1. Choose File menu > Quit.
2. Enter text for disconnection options in the dialog box, or accept the default settings, and then click OK.

<table>
<thead>
<tr>
<th>For this option</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message to send</td>
<td>Type text you want the guests to see.</td>
</tr>
<tr>
<td>Minutes until guests forced to disconnect</td>
<td>Enter a value (the default is 5 minutes or the last-entered value).</td>
</tr>
</tbody>
</table>

After you select Quit, you see a diamond next to the command in the File menu. In the Local Administration dialog box, all databases or guest names become italicized to show that FileMaker Server is attempting to disconnect all guests, close all files, and quit.

FileMaker Server will give guests five minutes, or the amount of time you specify in the dialog box, to close files before disconnecting them. Guests see a notification dialog box requesting that they close the files hosted by FileMaker Server. If guests don’t close the files, the dialog box reappears one minute before the files are closed by FileMaker Server.

It might take FileMaker Server several minutes to complete the quitting process.

**Starting FileMaker Server (Mac OS X)**

FileMaker Server running in OS X has two components: the configuration application, called FileMaker Server Config, and the server application. They are started (and stopped) separately.
You can also make an alias to start FileMaker Server Config automatically each time you start your computer. See the next section for more information.

Making an alias for FileMaker Server Config

Note: You can make an alias for FileMaker Server Config, but not for the server itself.

To make an alias for FileMaker Server Config:

1. In the Finder, select the FileMaker Server Config icon in the FileMaker Server 5.5 folder.
2. Choose File menu > Make Alias.
   You see an alias of FileMaker Server Config in the application folder.
3. In the Login Items pane of the Login preferences, click Add.
4. Navigate to the alias you just made and click Open.
5. Close the Login preferences window.

Starting the FileMaker Server application (Mac OS X)

1. Place the FileMaker Pro 5.x files that you want FileMaker Server to open in the same folder as FileMaker Server (or in subfolders one level down). Add an extension to a filename if it does not have one. Up to 125 FileMaker Pro 5.x database files can be automatically opened when FileMaker Server starts up.
2. In the FileMaker Server window, click the Start Server button.

Quitting FileMaker Server (Mac OS X)

FileMaker Server running on OS X has two components: the configuration application, called FileMaker Server Config, and the server application. They are stopped (and started) separately.

Quitting the FileMaker Server Config application

To quit the FileMaker Server Config application, choose FMServer Config menu > Quit FMServer Config.

Stopping the FileMaker Server application (Mac OS X)

Stopping the FileMaker Server application disconnects all FileMaker Pro guests and closes all database files hosted by FileMaker Server.

To stop FileMaker Server, click the Stop Server button in the FileMaker Server window.

Guests see a notification dialog requesting that they close the files hosted by FileMaker Server. If guests don’t close the files, the dialog reappears before the files are closed by FileMaker Server.

It might take FileMaker Server several minutes to complete the quitting process.

Using remote administration

You can use FileMaker Pro 5.x to view information about guests and control database files hosted by one or more servers from a different computer than the one running FileMaker Server. This process is called remote administration.

Mac OS 8.6 to 9.1: You can also control the hosted files and guests using the same computer that’s running FileMaker Server. This process, using FileMaker Server 5.5, is called local administration.
The remote administration capability in FileMaker Server is provided through three FileMaker Pro 5.x databases. These databases are created in the server computer’s temporary directory when you enable remote administration:

- in the Administration tab of the properties (Windows) or Preferences (Mac OS) dialog box
- with the UseRemoteAdmin preference parameter (Red Hat Linux)
- when you start FileMaker Server (if remote administration is already enabled)

The databases are created in a subdirectory named Remote Administration, which appears as an active folder when you view the Folders tab of the Remote Administration window. Likewise, the remote administration databases appear when you view the Files tab in the Remote Administration window. However, the remote administration databases do not appear in the Hosts dialog box when you use FileMaker Pro 5.x to view hosted files on your server computer.

The names of the remote administration databases contain the name of the FileMaker Server computer. The computer name is truncated if it exceeds 31 characters when combined with the name of a remote administration database. This name defaults to the computer’s system name, but you can change the name displayed in the Hosts dialog box using the Administration tab of the Properties (Windows) or Preferences (Mac OS) dialog box or in the CustomServerName preference parameter (Red Hat Linux).

For example, if your FileMaker Server computer is named Database Server, you see the following filenames:

- Database Server_Admin
- Database Server_Usage
- Database Server_Data

If you disable remote administration in FileMaker Server or you stop or quit FileMaker Server, the remote administration databases are removed from the server computer. If remote administration is enabled in the Administration tab of the Properties (Windows) or Preferences (Mac OS) dialog box or in the UseRemoteAdmin preference parameter (Red Hat Linux), when you restart FileMaker Server, the remote administration files are recreated.

**Important**

Windows and Mac OS X: Do not use the remote administration capability in FileMaker Pro 5.x on the server computer to administer FileMaker Server.

Mac OS 8.6 to 9.1: You can administer FileMaker Server by using the remote administration capability in FileMaker Pro 5.x or the local administration capability in FileMaker Server.

When you administer FileMaker Server remotely, your administration capabilities are limited depending on whether or not the Server Administration plug-in for FileMaker Pro is installed on the remote computer.

If the Server Administration plug-in is not installed on the remote computer, you can:

- view a list of folders that contain database files hosted by FileMaker Server
- view a list of database files hosted by FileMaker Server and the number of guests connected to each
- view a list of all guests and the database files that they are connected to
- view usage statistics for FileMaker Server

If the Server Administration plug-in is installed on the remote computer, you can also:

- open FileMaker Pro files for access by FileMaker Pro guests through FileMaker Server
close files hosted by FileMaker Server
disconnect a selected FileMaker Pro guest from one or all hosted files
send messages to guests of hosted files
display detailed information about hosted files and guests

Automatically downloading the Server Administration plug-in to a remote computer

To automatically download the Server Administration plug-in to a remote computer:

1. In the FileMaker Server Properties (Windows) or Preferences (Mac OS) dialog box, click the Files tab and Select Allow FileMaker Pro guests to download updates automatically.
Red Hat Linux: Enable the UseAutoUpdate preference parameter.
For more information, see “Enabling Auto Update in FileMaker Server” on page 9-8.

2. In the FileMaker Server Properties (Windows) or Preferences (Mac OS) dialog box, click the Administration tab and enable remote administration.
Red Hat Linux: Enable the UseRemoteAdmin preference parameter.
For more information, see “Enabling remote administration in FileMaker Server” on page 9-10.

3. Instruct users of guest computers to enable automatic download in FileMaker Pro 5.5 as follows: Start FileMaker Pro, choose Edit menu > Preferences > Application (Mac OS 8.6 to 9.1) or FileMaker Pro menu > Preferences > Application (Mac OS X).

4. Click the Plug-ins tab and select Auto Update.

When you open the Remote Administration window, the Server Administration plug-in is downloaded to the remote computer and automatically enabled in FileMaker Pro.

Note You can install the Server Administration plug-in manually, if you want. See chapter 10, “Manually installing the Server Administration plug-in on a remote computer.”

For more information about automatically downloading plug-ins, see “Allowing software updates to be downloaded automatically” on page 6-7.

Opening the Remote Administration window

Note FileMaker Pro 5.x must be installed on the remote computer before you can administer FileMaker Server remotely.

To administer FileMaker Server remotely:

1. Log on to a Windows client computer or a computer running the Mac OS located on the same network as your FileMaker Server computer.

2. Click the Start button > Programs > FileMaker Pro 5.x (Windows) or double-click the FileMaker Pro 5.x application icon (Mac OS).

3. Choose File menu > Open, and then click Hosts.

4. Select the name of your FileMaker Server in the list of hosted databases, then click Open.

Tip For information on changing the name that appears in the list, see “Specifying a custom host name” on page 6-10.

5. Type the remote administration password, if you are prompted to enter it.

You see the FileMaker Server Remote Administration window.
For remote administration details, refer to the following sections. For information about getting onscreen Help for the Remote Administration window, see “Getting help while administering FileMaker Server remotely” on page xii.

**Listing hosted files and current guests**

Remote administration gives you several ways to list information about hosted databases and the guests accessing them.

**Tips**

- You can see a summary of all folders containing databases, the number of all databases, and the number of all guests just below the list no matter which tab is displayed.
- You can sort information in columns by clicking the column heading. The triangle in the selected column heading indicates the sort order: up for ascending (A–Z, 0–n, or shortest to longest for time durations) or down for descending (Z–A, n–0, or longest to shortest for time durations).
- Mac OS 8.6 to 9.1: To view database and guest information while working on the server computer, see “Listing hosted files and guests (Mac OS 8.6 to 9.1)” on page 7-12.

**Viewing usage statistics for FileMaker Server**

When you administer remotely, you can display usage statistics, such as how FileMaker Server is performing and how many guests are logged into FileMaker Server.

---

---
To display usage statistics for FileMaker Server, click *Usage* in the Remote Administration window.

You see the Usage Statistics window.

The following statistics are listed in the Usage Statistics window:

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactions/second</td>
<td>Number of guest requests handled per second.</td>
</tr>
<tr>
<td>Network (Kbytes/sec)</td>
<td>Amount of data being moved across the network or to and from disk. Data is measured in KB unless network activity is greater than 10 MB per second. In that case, the value displayed represents MB per second.</td>
</tr>
<tr>
<td>Guests</td>
<td>Number of connected guests. Use this information to help configure the Allow up to n simultaneously connected guests option (Windows and Mac OS) or the MaxGuests preference parameter (Red Hat Linux).</td>
</tr>
<tr>
<td>Files</td>
<td>Number of open databases. Use this information to configure the Maximum number of files to host option (Windows and Mac OS) or the MaxFiles preference parameter (Red Hat Linux).</td>
</tr>
<tr>
<td>Disk (Kbytes/sec)</td>
<td>Amount of data being written to disk. Data is measured in KB unless data written to disk is greater than 10 MB per second. In that case, the value displayed represents MB per second.</td>
</tr>
</tbody>
</table>

By default, FileMaker Server updates the statistics in the Usage Statistics window every 15 seconds or less but no more than once a second. Although this reduces the overhead required to calculate the statistics, it means the statistics are approximations of how FileMaker Server is using resources.

Windows and Mac OS: For information about where usage statistics are stored and how to display them in a chart, see “Recording usage statistics and setting size limits” on page 6-12.

Mac OS 8.6 to 9.1: To view usage statistics while working on the server computer, see “Viewing usage statistics (Mac OS 8.6 to 9.1)” on page 7-14.

Tip In Mac OS 8.6 to 9.1, you can also collect usage statistics information by using Apple events. For more information about Apple events, see the AppleScript Examples folder inside the FileMaker Server 5.5 folder.

Hosting FileMaker Pro 5.x files

Important FileMaker Server 5.5 supports only FileMaker Pro 5.x databases. Therefore, any databases you have from a previous version of FileMaker Pro must be converted to FileMaker Pro 5.x format before you can host them using FileMaker Server 5.5.
When FileMaker Server starts, it automatically opens or hosts all multi-user files in the FileMaker Server 5.5 folder including those in subfolders one level down. It also opens single user files, if you have enabled the Allow FileMaker Server to host Single User files option in the Files tab of the Properties (Windows) or Preferences (Mac OS) dialog box or the HostSingleUserFiles preference parameter (Red Hat Linux). For more information, see “Allowing single user files to be hosted” on page 6-7. Don’t use personal file sharing to share FileMaker Pro files.

**Note** To open database files while administering remotely, you must have the Server Administration plug-in for FileMaker Pro installed on the remote computer. See “Automatically downloading the Server Administration plug-in to a remote computer” on page 7-6.

To open files remotely while FileMaker Server is running:

1. In FileMaker Pro, click Open File in the Remote Administration window.
   
   You see a dialog box with a list of FileMaker Pro 5.x files available for hosting, organized by folder.

2. Choose a database in the Select a database file or folder list, then click OK.
   
   FileMaker Server opens the file, and the database name appears in the list in the Remote Administration window (if you are viewing database information in the list).

   If you selected a folder, FileMaker Server opens all of the files in that folder.

**Tips**

- Windows: You can open a file by dragging a FileMaker Pro 5.x file icon and dropping it on the FileMaker Server application icon (fmserver.exe), if the FileMaker Server service is already running.

- Mac OS 8.6 to 9.1: You can open a file by dragging a FileMaker Pro 5.x file icon onto the FileMaker Server application icon or onto the local administration window.

- Windows: You can open a file by using the command prompt. See “Using the command line to automate tasks (Windows)” on page 8-8 for more information.

- Mac OS: You can use Apple events to open files. To host files while working on the server computer, see “Hosting FileMaker Pro 5.x files (Mac OS 8.6 to 9.1)” on page 7-14. For more information about Apple events, see the AppleScript Examples folder inside the FileMaker Server 5.5 folder.

- If you are hosting large numbers of files or guests, you might improve Remote Administration performance by increasing the FileMaker Pro cache size. For more information, see the FileMaker Pro 5 User’s Guide.

- You can use the Multi-User (Hidden) command in FileMaker Pro 5.x to prevent subordinate related files from appearing in the Hosts dialog box. For more information, see the FileMaker Pro 5 User’s Guide.

- Mac OS X: Add an extension to a filename if it does not have one.

### Closing hosted files

To close a database and disconnect any guests accessing it:

1. In the Remote Administration window, choose the Folders or Files tab (if it’s not already selected) to display a list of open databases.
2. Select a file or folder in the list.
3. Click Close File.

   You see the Close File dialog box with the name of the file or folder to be closed in the title bar.
4. Enter text for the options in the dialog box, or accept the default message and settings.

<table>
<thead>
<tr>
<th>For this option</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message to send</td>
<td>Type text you want the guests to see in addition to the standard FileMaker Pro message (asking guests to close the database file).</td>
</tr>
<tr>
<td>Minutes until guest forced to disconnect</td>
<td>Enter a value (the default is 5 minutes or the last-entered value).</td>
</tr>
</tbody>
</table>

5. Click **OK**

If the **Files** tab is displayed, the **Status** of the files being closed changes to indicate that FileMaker Server has begun closing files.

Guests see a notification dialog box with your message requesting they close their connection to a file. If guests don’t close the file, the message repeats approximately one minute before the file is set to be closed by FileMaker Server.

When the set time elapses, FileMaker Server disconnects any remaining guests and closes the file or files in the folder. The file or folder name no longer appears in the Remote Administration window.

Completing the process of closing a folder, a large database file, or a file with many connected guests may take several minutes.

**Tips**
- Mac OS: To close files while working on the server computer, see “Closing hosted files (Mac OS 8.6 to 9.1)” on page 7-15.
- Mac OS: You can also close files using Apple events. For more information about Apple Events, see the AppleScript Examples folder in the FileMaker Server 5.5 folder.
- Windows: You can also close files from the command line. See “Using the command line to automate tasks (Windows)” on page 8-8 for more information.

**Disconnecting guests**

To disconnect a guest from a hosted database:

1. In the Remote Administration window, select the guest to disconnect.

<table>
<thead>
<tr>
<th>Click And select To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guests</td>
</tr>
<tr>
<td>Guests guestname</td>
</tr>
<tr>
<td>Files filename</td>
</tr>
</tbody>
</table>

2. Click **Disconnect Guest**

You see the Disconnect Guest dialog box with the name of the guest to be disconnected in the title bar.

3. Enter text for the options in the dialog box, or accept the default settings.

<table>
<thead>
<tr>
<th>For this option</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message to send</td>
<td>Type text you want the guest to see in addition to the standard FileMaker Pro message (the default).</td>
</tr>
<tr>
<td>Minutes until guest forced to disconnect</td>
<td>Enter a value (the default is 5 minutes or the last-entered value).</td>
</tr>
</tbody>
</table>
4. Click **OK**.

The selected guest sees a notification dialog box with your message requesting that the guest disconnect from the server. If the guest doesn’t disconnect, the message repeats approximately one minute before the guest is set to be disconnected.

When the set time elapses, FileMaker Server disconnects the guest and the guest’s name disappears from the Remote Administration window.

Mac OS 8.6 to 9.1: To disconnect guests while working on the server computer, see “Disconnecting guests (Mac OS 8.6 to 9.1)” on page 7-16.

---

**Viewing detailed information about hosted files and guests**

If you have the Server Administration plug-in installed on the remote computer, you can use FileMaker Pro 5.x to view detailed information about hosted files and the guests that are currently connected to them. For each hosted database, you can display:

- the name of the file
- the number of guests connected to it
- the number of records it contains
- the number of layouts it has
- its current size in bytes
- file status: **Normal** (active), **Closing**, **Pausing**, **Paused**, **Nearly full**, **Exclusive by username**. For more information about the Exclusive status, see “Determining if you have exclusive access to hosted databases” on page 7-12.

For each guest, you can display:

- the name of the guest
- the network protocol that the guest is using
- the guest’s network address
- the number of files the guest is currently connected to
- the length of time in days, hours, and minutes that the guest has been connected
- the length of time in days, hours, and minutes that the guest has been idle
- guest status: **Normal** or **Closing**

To display detailed information about hosted files and guests:

1. Select a file or guest in the Remote Administration window.
2. Click **Get Details**.

You see the Get Details dialog box showing detailed information for the file or guest.

---

**Sending messages to guests**

To send a message to one or more guests:

1. In the Remote Administration window, make a selection.
2. Click **Send Message**.

You see the Send Message dialog box with the name of the selected recipient(s) in the title bar.
3. For **Message to send**, type your message, and then click **OK**.

   FileMaker Server sends the message to the selected recipient(s).

   Windows and Mac OS X: You can also send a message to guests while working on the server computer by scheduling a Send Message task. For more information, see chapter 8, “Scheduling administrative tasks (Windows and Mac OS).”

   Mac OS 8.6 to 9.1: To send a message to guests while working on the server computer, see “Sending messages to guests (Mac OS 8.6 to 9.1)” on page 7-16.

   **Sending messages to all guests**

   To send a message to all guests currently accessing any hosted databases:

   1. In the Remote Administration window, click **Send Message to All**.
      You see the Send Message to all guests dialog box.

   2. For **Message to send**, type your message, then click **OK**.

   **Determining if you have exclusive access to hosted databases**

   Although you can use FileMaker Pro to make some changes to the structure and layout of databases that are hosted by FileMaker Server, you can’t change field definitions unless you have exclusive access to a database. When you have exclusive access, no other guests are connected to the database. Exclusive access enables you to change field definitions without first having to close the database in FileMaker Server.

   To find out if you have exclusive access to a hosted database:

   1. In the Remote Administration window, click the **Files** tab to display all hosted databases.
      For more information, see “Opening the Remote Administration window” on page 7-6.

   2. Select the database that you want exclusive access to, then click **Get Details**.

      If you have exclusive access, the Get details for *filename* dialog box lists you as the only guest connected to the selected database.

      If you don’t have exclusive access, FileMaker Pro provides a way for you to notify other guests and gain exclusive access to the database without using FileMaker Server messaging. For more information, see FileMaker Pro Help.

   **Using local administration (Mac OS 8.6 to 9.1)**

   If you’re running FileMaker Server in Mac OS 8.6 to 9.1, you can perform most of the administrative activities described in the previous sections in this chapter from the computer running the server software. However, the steps you follow are different. In addition, you can perform many administrative tasks using Apple events both from the local computer or a remote computer. For more information about Apple events, see the AppleScript Examples folder inside the FileMaker Server 5.5 folder.

   **Opening the local administration window (Mac OS 8.6 to 9.1)**

   To open the FileMaker Server local administration window:


   2. Choose **Window menu > Administration Window**.

      You see the FileMaker Server administration window.
Listing hosted files and guests (Mac OS 8.6 to 9.1)
The local administration window lists hosted databases and the guests who are using them. You can choose to display information by folder, files (databases), or guest.

Click a tab to display a different view of databases or guests
Click a column heading to sort the list by that column. Sort order is indicated by the triangle above the scrollbar
Click to reverse the sort order of the list based on the selected column
Click to reverse the sort order in the selected column

Click this tab To see
Folder A list of the database files hosted by FileMaker Server grouped by the folder in which they reside. Also included is the number of files in each folder.
Files A list of the database files hosted by FileMaker Server. Also included is the status (Open, Opening, Closing, Backing up, Pausing, Paused, Disk Full, or Exclusive) and the number of guests connected to each database.

FileMaker Server host name
Click to reverse the sort order in the selected column
Number of open databases
Shows total files, guests, and the network protocols in use
Click this tab To see
Guests A list of FileMaker Pro guests accessing the database files hosted by FileMaker Server. Also included is the network protocol used by each guest, each guest’s network address, length of time guests have been connected, and their inactive time.

Sorting and resizing columns (Mac OS 8.6 to 9.1)
You can sort information in a list by column or you can change the width of a column to display more text.

To sort items in a list, click a column heading.

The column heading darkens and the triangle control above the scrollbar indicates the current sort order of the selected column.

This symbol Indicates the selected column is sorted in
Ascending order (A–Z, 0–n, or shortest to longest for time durations)
Descending order (Z–A, n–0, or longest to shortest for time durations)

To reverse the sort order in the selected column, click the triangle control.

The sort order in each tabbed screen is retained when you click between Folders, Files, and Guests.

To unsort the list, click the heading of the sorted column to deselect it.

To resize the width of a column, place the pointer over a column heading border. When the pointer changes to †, drag it horizontally.
Selecting information in scrolling lists (Mac OS 8.6 to 9.1)
The following table describes keyboard shortcuts for selecting information in scrolling lists.

<table>
<thead>
<tr>
<th>Use this shortcut</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click an entry</td>
<td>Select a row</td>
</tr>
<tr>
<td>Double-click an entry</td>
<td>Switch to the tab for that entry and scroll to display the selected entry in the new tabbed screen. For example, if you double-click a filename in the Folders tab, the display changes to the Files tab and scrolls to show the file.</td>
</tr>
<tr>
<td>Shift-click another entry</td>
<td>Extend the current selection</td>
</tr>
<tr>
<td>⌘-click another entry</td>
<td>Deselect the entry, if it was selected, or select the entry without including entries between it and your original selection</td>
</tr>
<tr>
<td>↑ or ↓</td>
<td>Select the row above the current selection or Select the row below the current selection</td>
</tr>
<tr>
<td>Shift-↑ or Shift-↓</td>
<td>Extend the current selection</td>
</tr>
<tr>
<td>⌘-↑ or ⌘-↓</td>
<td>Select the first or last entry in a list</td>
</tr>
<tr>
<td>⌘-→</td>
<td>Expand the details displayed under the current selection</td>
</tr>
<tr>
<td>⌘←</td>
<td>Collapse the details displayed under the current selection</td>
</tr>
<tr>
<td>Page Up key</td>
<td>Scroll up</td>
</tr>
<tr>
<td>Page Down key</td>
<td>Scroll down</td>
</tr>
<tr>
<td>Home key</td>
<td>Scroll to the top of the list</td>
</tr>
<tr>
<td>End key</td>
<td>Scroll to the bottom of the list</td>
</tr>
</tbody>
</table>

Viewing usage statistics (Mac OS 8.6 to 9.1)
Use the Usage Statistics dialog box to view usage statistics, such as how FileMaker Server is performing and how many guests are connected to hosted databases.

To display usage statistics, in FileMaker Server choose Window menu > Usage Statistics.

You see the Usage Statistics window.

For information about the statistics displayed, see “Viewing usage statistics for FileMaker Server” on page 7-7. For information about where usage statistics are stored and charting them, see “Recording usage statistics and setting size limits” on page 6-12.

Hosting FileMaker Pro 5.x files (Mac OS 8.6 to 9.1)
When FileMaker Server starts, it automatically opens or hosts all multi-user files in the FileMaker Server folder (and subfolders one level down).

Important
- FileMaker Server 5.5 supports only FileMaker Pro 5.x databases. Therefore, any existing databases you have from a previous version of FileMaker Pro must be converted to FileMaker Pro 5.x format before you can host them using FileMaker Server 5.5.
- Don’t use personal file sharing to share FileMaker Pro files.

To host database files using the local administration window:
1. In FileMaker Server, choose File menu > Open File

You see the Open dialog box.
2. Select one or more database files you want to host, then click **Open**.

The database files appear in the **Folders** tab of the administration window.

---

**Tips**

- Alternatively, you can drag one or more database files onto the FileMaker Server administration window to open them for guest access.
- FileMaker Server can open files set to **Single User** in FileMaker Pro, if you have enabled the **Allow FileMaker Server to host Single User files** option. For more information, see “Allowing single user files to be hosted” on page 6-7.
- You can use the Multi-User (Hidden) command in FileMaker Pro 5.x to prevent subordinate related files from appearing in the Hosts dialog box. For more information, see the *FileMaker Pro 5 User’s Guide*.

- You can Shift-click additional files in the Open dialog box to open more than one file at a time.

**Closing hosted files (Mac OS 8.6 to 9.1)**

To close a hosted database and disconnect any guests currently accessing it:

1. In FileMaker Server, choose **Window menu > Administration Window** to display the list of currently hosted files.
2. Select a database file in the list that you want to close.

**Tip** You can Shift-click additional databases in the list to close more than one at a time. If you are viewing databases by folder, you can select one folder to close all files in it or Shift-click an assortment of files and folders to close them.

3. Choose **File menu > Close File**.

You see the Close selected files/folders dialog box.

4. Enter text for the options in the dialog box, or accept the default message and settings.

<table>
<thead>
<tr>
<th>For this option</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Message to send</strong></td>
<td>Type text you want the guests to see in addition to the standard FileMaker Pro message (asking guests to close the database file).</td>
</tr>
<tr>
<td><strong>Minutes until guests forced to disconnect</strong></td>
<td>Enter a value (the default is 5 minutes or the last-entered value).</td>
</tr>
</tbody>
</table>
5. Click OK.
The file or folder name in the list changes to italicized text to show that FileMaker Server is closing the file.

Guests see a notification dialog box with your message requesting they close their connection to the file. If guests don’t close the file, the message repeats approximately one minute before the file is closed by FileMaker Server.

When the set time elapses, FileMaker Server disconnects any remaining guests and closes the file or files in the folder. The file or folder name no longer appears in the local administration window.

Completing the process of closing a folder, a large database file, or a file with many connected guests may take several minutes.

### Disconnecting guests (Mac OS 8.6 to 9.1)

To disconnect a guest of a hosted database:

1. In FileMaker Server, choose Window menu > Administration Window.
2. Click the **Guests** tab to display a list of guests who are currently connected to hosted databases.
3. Select a guest that you want to disconnect from hosted databases.
   **Tip** You can Shift-click additional guests in the list to disconnect more than one at a time.
4. Choose File menu > Disconnect Guest.
   You see the Disconnect selected guests dialog box.

5. Enter text for the options in the dialog box, or accept the default settings. For more information about disconnection options, see “Disconnecting guests” on page 7-10.
6. Click OK.
The guest name in the list changes to italics to show that FileMaker Server is attempting to disconnect the guest.

7. The selected guest sees a notification dialog box with your message requesting that the guest disconnect from the database. If the guest doesn’t disconnect, the message repeats approximately one minute before the guest is disconnected.

8. When the set time elapses, FileMaker Server disconnects the guest and the guest’s name disappears from the Guests tab in the administration window.

### Sending messages to guests (Mac OS 8.6 to 9.1)

To send a message to one or more guests:

1. In FileMaker Server, choose Window menu > Administration Window.
2. In the Administration window, make a selection.

<table>
<thead>
<tr>
<th>Select</th>
<th>To send a message to</th>
</tr>
</thead>
<tbody>
<tr>
<td>A database file</td>
<td>All guests of the database</td>
</tr>
<tr>
<td>A folder</td>
<td>Guests of the databases in the folder</td>
</tr>
<tr>
<td>A guest</td>
<td>One guest</td>
</tr>
<tr>
<td>Nothing</td>
<td>All guests</td>
</tr>
</tbody>
</table>

**Tip** You can Shift-click additional guests to send your message to a group of specific guests.

3. Choose File menu > Send Message.
   You see the Send Message to selected guests dialog box.
4. In the Message to send box, type your message, then click OK. FileMaker Server sends the message to the selected recipient(s).

**Monitoring server performance (Windows)**

You can monitor usage statistics from the server computer using the Performance Monitor (Windows NT) or System Monitor (Windows 2000).

**Monitoring performance (Windows NT)**


To view FileMaker Server statistics in the Performance Monitor:

1. Start the FileMaker Server service, if it is not already running.
2. Click the Start button > Programs > Administrative Tools (Common) > Performance Monitor.
3. Choose Edit menu > Add To Chart.
4. For Object, choose FileMaker Server.
5. For Counter, choose the FileMaker Server statistics that you want to track, then click Add after each selection.
   - Tip: Transactions, Network KB/sec, Disk KB/sec, Cache Hit %, and Cache Unsaved % give you the most information about how your system is performing.
6. Click Done.

Real-time statistical information for FileMaker Server appears in the Performance Monitor.

For information about the statistics displayed, see “Viewing usage statistics for FileMaker Server” on page 7-7.
Tip You can use the Performance Monitor on a Windows client computer or the System Monitor on a Windows 2000 client computer to view usage statistics for FileMaker Server remotely when the server is also a Windows computer.

**Monitoring performance (Windows 2000)**

Using the Windows System Monitor, you can chart real-time statistics for various aspects of FileMaker Server performance.

To view FileMaker Server statistics in the System Monitor:
1. Start the FileMaker Server service, if it is not already running.
2. Click the Start button > Programs > FileMaker Server Console.
3. Select System Monitor in the Console Tree.
4. Click the + button on the toolbar.
5. You see the Add Counters dialog box.

6. Click Select counters from computer, then choose the computer running FileMaker Server from the list.
7. For Performance object, choose FileMaker Server.
8. Click All counters (to chart all FileMaker Server usage statistics) or click Select counters from list and choose the statistics you want to chart, clicking Add after each selection.

9. Click Close.


**Tip**

Transactions, Network KB/sec, Disk KB/sec, Cache Hit %, and Cache Unsaved % give you the most information about how your system is performing.

### Using reported events to track activities

FileMaker Server uses the Windows Event Viewer (Windows) or creates a Server Event Log (Mac OS 8.6 to 9.1) or Events.log (Mac OS X) to help you keep track of activities on the server. These log files contain time-stamped information on:

- FileMaker Server starting and stopping
- size of the database cache
- database files opened and closed by FileMaker Server
guests that connect to and disconnect from FileMaker Server, as well as the files they access

- guests that are disconnected by FileMaker Server
- new, completed, upcoming, and currently running schedules
- pre-defined errors and other unusual conditions that occur when FileMaker Server is running
- current properties (Windows) or preferences (Mac OS) settings when FileMaker Server starts up, as well as settings that are changed during a FileMaker Server session

**Viewing activities in the Event Viewer (Windows NT)**

To view information about FileMaker Server activities:

1. Click the **Start** button > **Programs** > **Administrative Tools (Common)** > **Event Viewer**.
2. Choose **Log** menu > **Application**.
   
   You see a list of FileMaker Server Events in the Event Viewer.

3. Double-click an event to display details about it.

For more information about the error conditions reported in the Event Log, see appendix C, “Event log messages and troubleshooting.”

**Tip** Choose **Log** menu > **Save As** to save information displayed in the Event Viewer as a tab-delimited text file (.TXT) and then import the information into a FileMaker Pro database for further analysis.

**Viewing activities in the Event Viewer (Windows 2000)**

To view information about FileMaker Server activities:

1. Click the **Start** button > **Programs** > **FileMaker Server Console**.
2. Select **Event Viewer (Local)** in the Console Tree.
3. Double-click the FileMaker Server icon in the Details Pane.
   
   You see a list of FileMaker Server events.
4. Double-click an event to display details about it.

**Tip** Select **Event Viewer (Local)** and choose **Action** menu > **Export List** to save information displayed in the Event Viewer as a tab-delimited text file (.TXT) and then import the information into a FileMaker Pro database for further analysis.
For more information about the error conditions reported in the event log, see appendix C, “Event log messages and troubleshooting.”

**Keeping event data current (Windows)**

You might want to configure the Event Viewer to overwrite event information, because the default setting is to stop recording events when the application log becomes full. If you have many databases open with many users accessing them, and if you flush the cache often, the log could fill up quickly and the information in the Event Viewer could quickly become out of date.

To overwrite event information when the log is full:

1. Choose one of the following:
   - Windows NT: In the Event Viewer, choose Log menu > Log Settings.
2. For Event Log Wrapping, select Overwrite Events as Needed.
3. Click OK.

**Tip**

You might want to increase the Maximum Log Size setting from the default 512 KB to 4096 KB or more, depending on how much FileMaker Server activity you anticipate on your server computer.

**Viewing activities in the event log (Mac OS)**

The Server Event Log (Mac OS 8.6 to 9.1) or Events.log (Mac OS X) file is created in the FileMaker Server 5.5 folder. You can use any application capable of opening plain text files or the Mac OS X console application to view or print it.

Mac OS 8.6 to 9.1: You can have the log file open when FileMaker Server is running, but you won’t see recent updates in the file until you close the log file and reopen it. A new log file is created each time you start FileMaker Server. The log from the previous session is backed up in the FileMaker Server 5.5 folder and renamed Server Last Event Log. Therefore, you always have the current log file and the previous one available for review. To save a specific log file, use the Finder to rename it before it is overwritten by FileMaker Server.

Mac OS X: You can have the log file open in the OS X console application when FileMaker Server is running. Events are logged continuously, with the most recent log entry at the bottom of the console application window. Events.log is created when FileMaker Server starts, only if there is no existing Events.log. Activities are added to Events.log until it reaches the maximum size, at which point it is renamed Events-old.log, and a new Events.log is created.

You can set a maximum size for the log file to prevent it from taking up too much space on your disk. For more information, see “Setting a size limit for the event log (Mac OS)” on page 6-15.

For more information about the error conditions reported in the event log, see appendix C, “Event log messages and troubleshooting.”

**Recalculating the Today function in hosted databases**

The Today function in FileMaker Pro updates whenever a database file is opened. If a database file you’re hosting with FileMaker Server contains fields that use the Today function, you must close that file and reopen it each day for this function to recalculate correctly. See the *FileMaker Pro 5 User’s Guide* for information about the Today function.
Tip You can avoid using the Today function by creating a calculation field that uses the Status(CurrentDate) function in FileMaker Pro.

If you have the Server Administration plug-in installed on a client computer, you can use the FileMaker Server remote administration capability to recalculate the Today function as described below.

Mac OS 8.6 to 9.1: You can alternatively open and close the database using the local administration capability as described on page 7-14.

To recalculate the Today function:

1. Log on to a Windows client computer or a computer running the Mac OS located on the same network as your FileMaker Server computer.

2. Click the Start button > Programs > FileMaker Pro 5.x (Windows) or double-click the FileMaker Pro 5.x application icon (Mac OS).

3. Click Open an existing file, then click OK.

4. Click Hosts and select the name of your FileMaker Server computer.

5. In the Remote Administration window, select the database containing the Today function in the Files or Folders tab, then click Close File.

6. Click Open File, select the file that you just closed, then click OK.

Closing and reopening the database in FileMaker Server causes the Today function to be recalculated by the next FileMaker Pro guest who opens the hosted file.

7. Choose File menu > Close to close the Remote Administration window.

8. In FileMaker Pro, choose File menu > Open, then click Hosts.

9. Double-click the file containing the Today function to access it as a guest.

A message appears stating that the Today function is being calculated. This process may take some time depending on the number of records and other database calculations in the file.

Tips

- You can automate the process of opening and closing files by setting up a schedule in FileMaker Server to run a .CMD script (Windows) or a system-level script (Mac OS). For more information about running scripts on a schedule, see chapter 8, “Scheduling administrative tasks (Windows and Mac OS).”

- Windows: You can use the Schedule service provided with Windows to perform these steps each day. See the sample files in the RCToday folder in the Examples folder, inside the FileMaker Server 5.5 folder, and the Windows documentation for more information about the Schedule service.

- Mac OS 8.6 to 9.1: You can automate how you recalculate the Today function in hosted databases using the sample AppleScript named Recalculate Today Function located in the AppleScript Examples folder inside the FileMaker Server 5.5 folder.
This page intentionally left blank.
Chapter 8
Scheduling administrative tasks (Windows and Mac OS)

You can create schedules to perform these tasks:

- back up hosted databases
- run command files (Windows)
- run scripts (Mac OS)
- send messages to guests

You can define up to 50 schedules in FileMaker Server. If you set up schedules that overlap, FileMaker Server starts the first task and holds the next task in queue. When the first task has completed, the next task will begin.

Windows: In addition to defining scheduled tasks in FileMaker Server, you can also automate administrative tasks by using the command line interface. You can use utilities that come with Windows, such as Windows Backup and Schedule services, for running automated tasks similar to those provided by FileMaker Server.

Scheduling tasks to run automatically (Windows)

You can use the Task Scheduling assistant to define three unique kinds of tasks and set the times that they execute. You can:

- schedule database backups
- run command files
- send messages to guests of hosted databases

To create a scheduled task:

1. Click the Start button > Programs > FileMaker Server Console.

   You see the FileMaker Server Console. FileMaker Server is selected in the Console Tree and the Details Pane displays the configuration assistants.

2. Click Task Scheduler in the Details Pane of the FileMaker Server Console.

   You see the Task Scheduling assistant.

3. Follow the directions provided by the assistant to define a task and set up a schedule to run the task automatically.

Scheduling tasks to run automatically (Mac OS 8.6 to 9.1)

1. Choose Schedules menu > New Schedule.

   You see the New Schedule dialog box.
2. In the New Schedule dialog box, type a name for the task in the Schedule Name text box.

3. Choose the type of task (Back Up Database, Run Script, or Send Message) from the pop-up menu. See the sections following step 6 for more information.

4. Click one or more days you want the task to be performed.

5. Click one or more hours and the up arrow for Start at n minutes past the hour to set the time you want the task to be performed.

To deselect a day or hour, click it again.

Note: A new scheduled task is enabled by default, which means the task will run at its scheduled time after you close the New Schedule dialog box. For more information about enabling and disabling scheduled tasks, see page 8-7.

6. Click OK.

Scheduling database backups (Mac OS 8.6 to 9.1)

- For Operate on, choose one of the following options:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Databases</td>
<td>Back up all hosted databases that are currently open</td>
</tr>
<tr>
<td>A specific folder name in the pop-up menu</td>
<td>Back up hosted databases in the selected folder</td>
</tr>
</tbody>
</table>

For Backup to, click Specify and locate a folder that you want FileMaker Server to store your backups in, or create a new folder.

Tips

- Be sure to specify a folder that is not in the same folder as the FileMaker Server application (or a subfolder one level down). Otherwise, your backups could accidentally be opened after a server restart because FileMaker Server automatically opens all databases in this location on startup.

- It’s important that you have enough disk space on the backup destination disk. For more information, see “Making sure you don’t run out of disk space during backups” on page 8-10.

Running a script (Mac OS 8.6 to 9.1)

- For Operate on, choose one of the following options:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Databases</td>
<td>Have the script affect all hosted databases that are currently open</td>
</tr>
<tr>
<td>A specific folder name in the pop-up menu</td>
<td>Run the script on all databases in the selected folder</td>
</tr>
<tr>
<td>No Databases</td>
<td>Run a non-database related script</td>
</tr>
</tbody>
</table>

Note: For an example using the No Databases option, see the example AppleScript named Run a Schedule in the AppleScript Examples folder inside the FileMaker Server 5.5 folder.
Scheduling administrative tasks (Windows and Mac OS)

For **Specify Script**, click **Specify** and locate an AppleScript on your system that you want to run.

**Sending messages to guests of hosted databases (Mac OS 8.6 to 9.1)**

For **Operate on**, choose one of the following options:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Databases</td>
<td>Send a message to all users who are currently connected to hosted databases</td>
</tr>
<tr>
<td>A specific folder name in the pop-up menu</td>
<td>Send a message to guests of all open databases in the selected folder</td>
</tr>
</tbody>
</table>

Type your message in the text box.

**Scheduling tasks to run automatically (Mac OS X)**


2. In the Schedules window, click **New**.

3. Type a name for the task in the **Schedule Name** text box.

4. Choose the type of task (Back Up Database, Run Script, or Send Messages) from the pop-up menu. See the sections following step 7 for more information.

5. Click one or more days you want the task to be performed.

6. Click one or more hours and the up arrow for **Minutes after the hour** to set the time you want the task to be performed.

   To deselect a day or hour, click it again.

   **Note**: A new scheduled task is enabled by default, which means the task will run at its scheduled time after you close the Schedules window. For more information about enabling and disabling scheduled tasks, see page 8-7.

7. Click **OK**.

**Scheduling database backups (Mac OS X)**

For **Operate on**, choose one of the following options:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Databases</td>
<td>Back up all hosted databases that are currently open</td>
</tr>
<tr>
<td>Specify</td>
<td>Back up hosted databases in the selected folder</td>
</tr>
</tbody>
</table>

For **Backup to**, click **Specify** and locate a folder that you want FileMaker Server to store your backups in, or create a new folder.

**Tips**

Be sure to specify a folder that is not in the same folder as the FileMaker Server application (or a subfolder one level down). Otherwise, your backups could accidentally be opened after a server restart because FileMaker Server automatically opens all databases in this location on startup.
It’s important that you have enough disk space on the backup destination disk. For more information, see “Making sure you don’t run out of disk space during backups” on page 8-10.

**Running a script (Mac OS X)**

For **Operate on**, choose one of the following options:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Databases</td>
<td>Have the script affect all hosted databases that are currently open</td>
</tr>
<tr>
<td>No Databases</td>
<td>Run a non-database related script</td>
</tr>
<tr>
<td>Specify</td>
<td>Run a script on all databases in the selected folder</td>
</tr>
</tbody>
</table>

For **Specify Script**, click **Specify** and locate a script on your system that you want to run. Add an extension to a script filename if it does not have one.

**Sending messages to guests of hosted databases (Mac OS X)**

For **Operate on**, choose one of the following options:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Databases</td>
<td>Send a message to all users who are currently connected to hosted databases</td>
</tr>
<tr>
<td>Specify</td>
<td>Send a message to guests of all open databases in the selected folder</td>
</tr>
</tbody>
</table>

Type your message in the text box.

**Viewing scheduled tasks in the Schedules list (Windows)**

After you create scheduled tasks, they appear in the Schedules list. The list shows you a summary of each defined schedule, including the last time the task ran and the next time it will run.

To display the Schedules list, select **Schedules** in the Console Tree.

You can use this view of your scheduled tasks to change, duplicate, enable, disable, and run tasks manually.

**Tip** To change the way items are displayed in the scheduled task list, choose **View** menu and then choose a display option.

**Administering scheduled tasks with the toolbar (Windows)**

Use the toolbar to work with scheduled tasks in the list. First, select one or more schedules in the list, then click an active tool on the toolbar.
### Scheduling administrative tasks (Windows and Mac OS)

#### Note
The tools available on the toolbar change depending on your selection in the FileMaker Server window. Therefore, not all tools described below are always visible.

<table>
<thead>
<tr>
<th>Use this tool</th>
<th>To perform this action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the information that was previously displayed in the Details Pane of the FileMaker Server Console. Information is displayed in reverse historical order.</td>
<td>Prevent all scheduled tasks from running, even if they are enabled (checked) in the Schedules list. This option lets you turn off all schedules at once and is convenient for performing administrative tasks on the server computer. When you click this button, checkmarks of enabled tasks are dimmed in the Schedules list.</td>
</tr>
<tr>
<td>Display the information that was previously displayed in the Details Pane of the FileMaker Server Console. This button activates after you have used the Back button (above) to display a previous page in the Details Pane and lets you go “forward” in historical order.</td>
<td>Allow all scheduled and enabled tasks to run. Tasks that you have individually disabled will not run.</td>
</tr>
<tr>
<td>Move the selection up one level in the folder hierarchy in the Console Tree.</td>
<td>Duplicate one or more selected scheduled tasks to use as a template for creating a new scheduled task.</td>
</tr>
<tr>
<td>Hide the Console Tree.</td>
<td>Display FileMaker on the Web information in the Details Pane of the console, which gives you easy access to the official FileMaker, Inc. web site. Click this tool again to return to the previously displayed page in the Details Pane.</td>
</tr>
<tr>
<td>Delete the current selection.</td>
<td>You can place the pointer over a tool to display a description of it.</td>
</tr>
<tr>
<td>Display properties for the current selection.</td>
<td><strong>Tip</strong></td>
</tr>
<tr>
<td>Update information displayed in the Details Pane of the FileMaker Server Console (such as the last time a schedule ran).</td>
<td></td>
</tr>
<tr>
<td>Display procedural FileMaker Server Help.</td>
<td><strong>Updating Last Run and Next Run information (Windows)</strong></td>
</tr>
</tbody>
</table>

**Last Run** and **Next Run** information gets updated in the Schedules list every 15 seconds. You can update it more often, if you want.

To update the information about when a scheduled task ran last and when it will run again, select one or more scheduled tasks and choose Action menu > Refresh.

**Viewing scheduled tasks in the Schedules window (Mac OS)**

After you create a scheduled task, it appears in the Schedules window.

To display the Schedules window, choose Window menu > Schedules Window.
The list shows you a summary of each defined schedule, including the task it performs, the last time it ran, and the next time it will run.

You can use this view of your scheduled tasks to change, duplicate, enable, disable, and run them manually as described in the following sections.

The following table describes keyboard shortcuts for selecting information in scrolling lists.

<table>
<thead>
<tr>
<th>Use this shortcut</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click an entry</td>
<td>Select a row</td>
</tr>
<tr>
<td>Shift-click another entry</td>
<td>Extend the current selection</td>
</tr>
<tr>
<td>Control-click another entry</td>
<td>Deselect the entry, if it was selected, or select the entry without including entries between it and your original selection</td>
</tr>
<tr>
<td>↑</td>
<td>Select the row above the current selection</td>
</tr>
<tr>
<td>↓</td>
<td>Select the row below the current selection</td>
</tr>
<tr>
<td>Shift ↑ or Shift ↓</td>
<td>Extend the current selection</td>
</tr>
<tr>
<td>⇧ or ⇨</td>
<td>Select the first or last entry in a list (Mac OS 8.6 to 9.1)</td>
</tr>
<tr>
<td>Page Up key</td>
<td>Scroll up</td>
</tr>
<tr>
<td>Page Down key</td>
<td>Scroll down</td>
</tr>
<tr>
<td>Home key</td>
<td>Scroll to the top of the list (Mac OS 8.6 to 9.1)</td>
</tr>
<tr>
<td>End key</td>
<td>Scroll to the bottom of the list (Mac OS 8.6 to 9.1)</td>
</tr>
</tbody>
</table>

For information on working with lists, see “Sorting and resizing columns (Mac OS 8.6 to 9.1)” on page 7-13.

Running scheduled tasks manually

1. In the Schedules list (Windows) or Schedules window (Mac OS), select a scheduled task that you want to run.

2. Choose Action menu > Run Now (Windows) or Schedules menu > Run Schedule (Mac OS).

The Last Run column is updated with the current date and time.

Changing scheduled tasks

1. In the Schedules list (Windows) or Schedules window (Mac OS), select a scheduled task.
2. Choose Action menu > Properties (Windows) or Schedules menu > Edit Schedule (Mac OS).

See page 8-2 (Mac OS 8.6 to 9.1) or page 8-3 (Mac OS X) for an illustration of the options in the Edit Schedule dialog box.

3. Make changes to the scheduled task, then click OK.

Tips
- You can double-click a schedule in the list to open the schedule Properties (Windows) or Edit Schedule dialog box (Mac OS).
- To change the format of dates or times in the Schedules list, change the date or time format settings in the Regional Settings control panel (Windows) or the Date & Time control panel (Mac OS).

Duplicating scheduled tasks

Sometimes it’s easier to use an existing scheduled task as a template, rather than defining a completely new schedule. To duplicate an existing schedule and use it as a base for a new one:

1. In the Schedules list (Windows) or Schedules window (Mac OS), select one or more scheduled tasks.

2. Choose Action menu > Duplicate (Windows) or Schedules menu > Duplicate Schedule (Mac OS).

The duplicate schedule appears with the word “copy” appended to its name. For more information about editing the duplicate schedule, see the previous section.

Deleting scheduled tasks

1. In the Schedules list (Windows) or Schedules window (Mac OS), select one or more scheduled tasks.

2. Choose Action menu > Delete (Windows) or Schedules menu > Delete Schedule (Mac OS).

You see a confirmation message asking you to confirm that you want to delete the selected schedule.

Note: You can’t undo the deletion of a schedule.

3. Click OK.

Enabling and disabling scheduled tasks

You can enable or disable specific schedules or disable all schedules at once.

<table>
<thead>
<tr>
<th>To perform this action</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable a schedule when creating it</td>
<td>In the scheduled task’s Properties dialog box (Windows) or New Schedule dialog box (Mac OS), be sure Enable this schedule is selected. Windows: If you use the Task Scheduling assistant to create a schedule, the scheduled task is enabled by default.</td>
</tr>
<tr>
<td>Enable a schedule that was disabled</td>
<td>Windows: Select one or more disabled schedules in the Schedules list and choose Action menu &gt; Enabled. A checkmark appears next to the Enabled command in the Action menu to indicate the current selection is enabled. Mac OS: In the Schedules window, click the empty checkbox to the left of the schedule name. A checkmark appears, indicating that the scheduled task is enabled.</td>
</tr>
<tr>
<td>Disable a selected schedule</td>
<td>Windows: Select one or more enabled schedules in the Schedules list and choose Action menu &gt; Enabled. The checkmark next to the Enabled command in the Action menu disappears to indicate the current selection is disabled. Mac OS: In the Schedules window, click the checkbox to the left of the schedule name. The checkmark disappears, indicating that the scheduled task is disabled.</td>
</tr>
</tbody>
</table>
Using the command line to automate tasks

You can use the command line to:

- start or stop FileMaker Server
- host FileMaker Pro files
- close files hosted by FileMaker Server
- pause or resume a file or files to periodically flush the cache

Below is a list of commands available with FileMaker Server. Text enclosed in the [ ] characters indicates that the item is optional. 

<table>
<thead>
<tr>
<th>Command</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>start</td>
<td><code>fmserver start [-s]</code></td>
<td>Start the FileMaker Server service. Include the <code>-s</code> option to skip automatically opening files in the FileMaker Server 5.5 folder (and subfolders one level down).</td>
</tr>
<tr>
<td>stop</td>
<td><code>fmserver stop [-m &quot;message text&quot;] [-t #minutes]</code></td>
<td>Stop the FileMaker Server service, send a custom message to guests, and set the number of minutes before the files close.</td>
</tr>
<tr>
<td>open</td>
<td><code>fmserver open [path]</code></td>
<td>Host specific FileMaker Pro files.</td>
</tr>
<tr>
<td>close</td>
<td><code>fmserver close [path] [-m &quot;message text&quot;] [-t #minutes]</code></td>
<td>Close specific FileMaker Pro files, send a custom message to guests, and set the number of minutes before the files close.</td>
</tr>
<tr>
<td>pause</td>
<td><code>fmserver pause [path]</code></td>
<td>Pause activity on specific or all FileMaker Pro files. Pause files before copying them to another folder, for example, when backing them up. Useful with the NT Backup and Schedule services. If you don’t specify a path, all hosted files are paused. Pause causes all changes for a particular file to be written from cache to disk and prevents guests from making any changes to the file until the file is “resumed.” After a file is successfully paused, it’s safe to copy it using a script or back-up program.</td>
</tr>
</tbody>
</table>

You can use the command line interface to automate tasks with FileMaker Server, such as backing up files using the Windows Backup and Schedule services, or administering files from the FileMaker Server computer.
To access the command line interface:

1. Open an MS-DOS window using the Command Prompt icon (Windows NT) or click the Start button > Programs > Accessories > Command Prompt (Windows 2000).

2. At the command prompt, switch to the FileMaker Server 5.5 folder. If you installed FileMaker Server in the default location, type:
   ```
   cd c:\Program Files\FileMaker\FileMaker Server 5.5
   ```

3. Type `fmserver` followed by a FileMaker Server command and any optional parameters and switches.

The following table contains examples of FileMaker Server commands you can use.

<table>
<thead>
<tr>
<th>Command syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>fmserver resume [path]</code></td>
<td>Resume activity on specific or all paused FileMaker Pro files after they have been copied or backed up. Useful with the NT Backup and Schedule services. If no path is specified, all paused files are resumed.</td>
</tr>
<tr>
<td><code>fmserver open &quot;names and addresses.fp5&quot;</code></td>
<td>Open the Names and Addresses file. Note: The filename in this example includes spaces and therefore must be enclosed in quotes.</td>
</tr>
<tr>
<td><code>fmserver close</code></td>
<td>Close all hosted FileMaker Pro files in the default close time (five minutes).</td>
</tr>
<tr>
<td><code>fmserver close expenses.fp5 -m &quot;I’ll be closing the Expenses file in 10 minutes&quot; -t 10</code></td>
<td>Send a message to guests of the Expenses file and close it in 10 minutes.</td>
</tr>
<tr>
<td><code>fmserver pause</code></td>
<td>Pause all currently hosted FileMaker Pro files, which restricts guest activity to all hosted files.</td>
</tr>
<tr>
<td><code>fmserver pause expenses.fp5</code></td>
<td>Pause the Expenses file, which restricts guest activity to that file.</td>
</tr>
<tr>
<td><code>fmserver resume</code></td>
<td>Resume all paused files.</td>
</tr>
<tr>
<td><code>fmserver resume expenses.fp5</code></td>
<td>Resume the paused Expenses file.</td>
</tr>
<tr>
<td><code>fmserver start</code></td>
<td>Start the FileMaker Server service and open all multi-user FileMaker Pro files in the FileMaker Server 5.5 folder (and subfolders one level down).</td>
</tr>
<tr>
<td><code>fmserver start -s</code></td>
<td>Start the FileMaker Server service without opening any FileMaker Pro files.</td>
</tr>
<tr>
<td><code>fmserver stop -m &quot;All servers will be shut down in 10 minutes&quot; -t 10</code></td>
<td>Send a custom message to guests and stop the FileMaker Server service in 10 minutes. This sequence closes all hosted database files.</td>
</tr>
<tr>
<td><code>fmserver open expenses.fp5 messages.fp5</code></td>
<td>Open the Expenses and Messages files.</td>
</tr>
</tbody>
</table>

For more examples, see the FileMaker Server sample files (installed in the Examples folder in the FileMaker Server 5.5 folder) or use the `fmserver /?` command at the command prompt to view a list of available commands. For general information about using the command prompt, see your Windows documentation.

**Example: Backing up hosted databases on the command line (Windows)**

You can use the `fmserver pause` and `fmserver resume` commands in the MS-DOS window, along with DOS commands, to back up FileMaker Pro database files to another folder. To automate this process, you can enter the commands described in a text file, and then execute the commands using a Windows batch process.
The process of backing up hosted databases using the command line is to create a directory in which to temporarily store the backups, pause hosted databases to limit access to them on your network, copy the files to the new directory, restore availability of the files to guests, and remove the temporary backup directory you created. These steps are described in detail below.

1. Use the DOS `mkdir` command to create a new directory, for example, Backups.
2. Use the `fmserver pause` command, which pauses a specified file or files hosted by FileMaker Server. 
Guest activity on paused database files is restricted, so it’s best to limit overall pause time as much as possible.
3. Use the DOS `xcopy` command to copy all files (including files in subdirectories) from the FileMaker Server 5.5 directory to the Backups directory.
4. Use the `fmserver resume` command to restore guest access to paused database files.
5. Move the files from the Backups directory to a permanent backup location and use the `rmdir/s/q` command to delete the Backups directory and subdirectories.

**Tips**

- A sample command file named `Backup.cmd` containing this sequence of commands is in the Examples folder inside the FileMaker Server 5.5 folder. You can use this file as a template for backing up your own hosted databases.
- To execute this set of commands on an automatic schedule, you need to use the `at` command and Schedule service provided by Windows. For more information, see your Windows documentation. If you have a tape drive, you can use the `backup` command provided by Windows to copy files directly to tape.

---

**Using a script to automate tasks (Mac OS)**

You can use a script to automate administrative tasks performed by FileMaker Server. For more information about AppleScript application programs that are provided with FileMaker Server and about supported Apple events, see the AppleScript Examples folder inside the FileMakerServer 5.5 folder.

**Making sure you don’t run out of disk space during backups**

It’s important that the destination disk where you plan to store your hosted files and backups has plenty of free space. If the hard disk runs out of space while a file is being modified or if a database file reaches the 2GB size limit, FileMaker Server will automatically begin compressing the hosted file to reduce the amount of disk space it uses. During the compression, all guest activity to the server is paused and guests see the coffee cup icon ⬆️ or the network icon. Compression may take some time to complete. To avoid automatic compression, leave plenty of free disk space on the computer running FileMaker Server.

If the hard disk runs out of space during a backup, the backup stops and FileMaker Server logs an error in the application event log (Windows) or Server Event Log (Mac OS). It’s a good idea to periodically check the Schedules list for error conditions, which are reported in the `Last Run` column. To avoid running out of disk space when backing up files, choose tape or a different hard disk as your backup destination.

For additional help troubleshooting command line problems, see appendix C, “Event log messages and troubleshooting.”
Chapter 9
Using FileMaker Server in Red Hat Linux

This chapter provides instructions for:
- administering FileMaker Server running in Red Hat Linux
- configuring FileMaker Server settings for maximum performance

Getting onscreen help with command and preference syntax

The QuickRef.pdf file installed in /usr/doc/fmserver5-5 lists syntax and options for each administration command and preference setting. In addition, preference settings are described and default values are listed in comments in the configuration file (/etc/fmserver.conf).

Administering FileMaker Server

You can use the shell prompt in Red Hat Linux to administer FileMaker Server manually.

Administrative tasks include:
- starting and stopping FileMaker Server
- hosting FileMaker Pro files
- closing files hosted by FileMaker Server
- pausing and resuming files (to periodically flush the cache or back up databases)
- listing hosted files
- reloading the configuration file to apply changes to runtime preference settings. See “Applying configuration changes” on page 9-4 for a list of all preference settings and how changes must be applied.

Tip: You can also use the administrative commands described here in scripts to automate administrative tasks. For information about scripting, see your operating system documentation or consult a third-party book on scripting.

The following table describes the administrative commands in FileMaker Server. Text enclosed in the [ ] characters indicates that the item is optional. path indicates a filename or directory.

<table>
<thead>
<tr>
<th>Command</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
</table>
| fmserverd start | [-s] [-c path] | Start the FileMaker Server service, read the FileMaker Server configuration file in /etc/fmserver.conf, and open files in the /var/fmserver directory (and subdirectories one level down).
- Use the -s option to skip automatically opening files in the /var/fmserver directory (and subdirectories one level down).
- Use the -c path option to have FileMaker Server read the configuration file (fmserver.conf) in the alternate path specified. |
| fmserverd stop | [-m "message text"] [-t #minutes] [-f] | Stop the FileMaker Server service after notifying guests that they must disconnect from hosted databases within 2 minutes.
- Use the -m "message text" option to send a custom message to guests.
- Use the -t #minutes option to set a custom duration before FileMaker Server stops.
- Use the -f option to force the FileMaker Server service to disconnect guests immediately, but close databases safely so data integrity is maintained. |
Starting and stopping FileMaker Server automatically

The FileMaker Server installer installs a file containing a script that can automatically start and stop FileMaker Server when your operating system boots and shuts down. This script is located in /etc/rc.d/init.d/fmserverd.

To have the FileMaker Server service automatically start when the operating system boots and stop when the operating system shuts down:

1. Switch to the root user by entering the following command at the shell prompt:
   
   ```
   $ su -l root
   ```

2. Enter the root password.
   The prompt changes to #, indicating that you are now logged in as root.

3. Enter the following command to enable FileMaker Server to automatically start and stop when your operating system starts and shuts down:
   
   ```
   # chkconfig fmserverd on
   ```

4. Log out as the root user by entering:
   
   ```
   # logout
   ```

To disable automatic start and stop for FileMaker Server:

1. Switch to the root user.

2. Enter the following command to disable automatic start and stop:
   
   ```
   # chkconfig fmserverd off
   ```

3. Log out as the root user.
Configuring FileMaker Server


Preference settings include:
- set the maximum number of guests
- set idle disconnect time and customize the pre-disconnect message
- set the maximum number of open files
- allocate the amount of memory (RAM) that FileMaker Server uses for the database cache
- set how often the database cache is flushed
- allow single user files to be hosted and shared
- allow connected guests to receive plug-in updates automatically
- specify a custom account name and group for FileMaker Server
- enable remote administration and specify a remote administration password
- specify a custom server name that appears in the FileMaker Pro Hosts dialog box
- specify a preferred IP address
- open runtime solution files automatically
- save event information and usage statistics in log files and set the location and size limits on these logs
- register FileMaker Server in a directory service

Editing the configuration file

You can use a text editor, such as pico, to open the configuration file in the terminal window or pseudo terminal (pts).

Important: You must be logged in as the root user when making changes to the FileMaker Server configuration file. Logging in as root gives you complete access to all system resources. Be extremely careful when working as the root user. You could accidentally issue a command that could detrimentally affect your operating system software.

1. Switch to the root user by entering the following command at the shell prompt:
   
   $ su -l root

2. Enter the root password.

   The prompt changes to #, indicating that you are now logged in as root.

3. Using your text editor, open the fmserver.conf file. For example:
   
   $ pico /etc/fmserver.conf

   The following illustration shows the beginning of the configuration file.

Important: The first 6 characters of the configuration file must be FMS550. Otherwise, FileMaker Server will not load the configuration file during start-up and will start with the default preference settings.
In the configuration file, each preference setting parameter and its value (either an ON or OFF or a specific integer or string value) must reside on a separate line. The parameter and value must be separated by a space or tab character. Parameters and values are not case sensitive.

Comments in the file, which describe each configuration setting, begin with a # character and are ignored by FileMaker Server. You can add comments to the configuration file by inserting a # character at the beginning of each line of text you add.

**Tip** To preserve a preference setting before trying another value, insert a # character at the beginning of the existing setting. You can easily revert to this setting by deleting the new line and removing the # character in the old line.

Preference settings are described in detail in the remaining sections of this chapter.

### Applying configuration changes

FileMaker Server does not automatically reread the configuration file when you close the file. Depending on the preference settings you have changed, you must either reload the configuration file or restart FileMaker Server.

The following lists group preference settings by whether they require you to reload the configuration file or restart FileMaker Server.

**Note** Restarting FileMaker Server always applies all preference settings, but restarting requires that all guests disconnect from hosted databases. Therefore, simply reloading the configuration file is recommended if you make changes to only runtime settings.

#### Runtime preference settings that are applied when you reload the configuration file or restart FileMaker Server

- MaxIdleTime
- DisconnectWarning
- UseCacheFlush
- FlushTimeInterval
- HostSingleUserFiles
- UseAutoUpdate
- UseRemoteAdmin
- RequirePassword
- Password
- CustomExtensions
- MaxEventLogSize
- UseStatsLog
- StatsTimeInterval
- MaxStatsLogSize

#### Preferences settings that require you to restart FileMaker Server

- MaxGuests, if number of guests is increased
- MaxFiles, if number of guests is increased
- CacheSize
- UseCustomServerName
- ServerRoot
- FMServerUser
- FMServerGroup
- CustomServerName
- UsePrefIPAddr
- PrefIPAddr
- UseCustomExtensions
- EventLogPath
- StatsLogPath
- UseDirectoryService
- DirectoryService.ServerName
Reloading the configuration file to apply runtime preference changes

If you make changes to the runtime preference settings, you can reload the configuration file without affecting guest access to hosted databases.

To reload the configuration file:

1. Switch to the root user by entering the following command at the shell prompt:
   
   $ su -l root

2. Enter the root password.
   
   The prompt changes to #, indicating that you are now logged in as root.

3. Reload the configuration file by entering:

   # fmserverd reload

4. Log out as the root user by entering:

   # logout

Restarting FileMaker Server to apply configuration changes

If you make changes to the non-runtime preference settings, you must restart FileMaker Server to apply preference settings.

To restart FileMaker Server and apply preference setting changes:

1. Switch to the root user by entering the following command at the shell prompt:

   $ su -l root

2. Enter the root password.
   
   The prompt changes to #, indicating that you are now logged in as root.

3. Stop the FileMaker Server service by entering:

   # fmserverd stop
   
   Any guests currently accessing hosted databases are asked to disconnect within two minutes.

4. After FileMaker Server has stopped, restart the service by entering:

   # fmserverd start

5. Log out as the root user by entering:

   # logout

Restoring preference defaults

Default settings for each parameter are documented in comment lines in the configuration file (/etc/fmserver.conf). If you have changed a preference parameter value and you want to restore it to its default state, replace the changed value with the default value located in the comment text that precedes the changed preference parameter. Then reload or restart the configuration file, depending on the requirements of the setting you restored.
To start FileMaker Server with preference settings in their default state, stop FileMaker Server, rename or delete the FileMaker Server configuration file (/etc/fmserver.conf), then restart FileMaker Server.

To reinstall FileMaker Server, overwriting all installed files and create a new default configuration file, stop FileMaker Server, and enter the following command:

```
# rpm -Uvh --replace --force -noscripts fmserver-5.5.1-i386.rpm
```

**Setting the number of guests**

You can specify the number of guests who are simultaneously connected to FileMaker Server. Specifying a lower number leaves more memory available for FileMaker Server to operate.

To set the number of FileMaker Pro guests:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the MaxGuests preference parameter and replace the current value with a whole number between 1 and 250. For example:
   
   ```
   MaxGuests 30
   ```

   The default setting is 25.
4. If you’re finished making changes to the configuration file, close the text editor. If you increased the number of guests, restart FileMaker Server. If you decreased the number of guests, you can reload the configuration file. Then log out as the root user.

**Disconnecting idle guests**

FileMaker Server can disconnect idle guests from hosted databases after a specified length of time. If you want to change this setting, first turn on guest disconnection. Then use the default idle time setting or specify your own duration. You can use the default pre-disconnection message or write a custom message.

**Note** In FileMaker Pro 5.5, you can use a password privilege to keep a guest connected to FileMaker Server when the guest is idle. In some instances, such as when a guest is also serving as a web publishing host, the guest should maintain a connection to FileMaker Server, so that users connecting to the database through a browser will be able to access the database. For more information, see FileMaker Pro 5.5 Help.

To allow FileMaker Server to disconnect idle guests:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the DisconnectIdleGuests preference parameter and replace the current value with `ON`.
4. Find the MaxIdleTime preference parameter and replace the current value with a whole number between 10 and 1440 minutes. For example:
   
   ```
   MaxIdleTime 60
   ```

   The default setting is 720 minutes.
5. Find the default DisconnectWarning message setting and type a new message between the quotes or leave the default message (shown below) in place.
   
   ```
   DisconnectWarning "It appears that you have been idle for a while. Please switch to another record to remain connected."
   ```
6. If you’re finished making changes to the configuration file, close the text editor, reload the configuration file, and log out as the root user.
Setting the maximum number of files

You can change the maximum number of files FileMaker Server can have open simultaneously. Specifying a lower number of files leaves more memory available for FileMaker Server to operate. If you know the approximate number of files you consistently host, you can set the maximum number of files close to this number to gain the best performance from FileMaker Server.

When you increase the number of files allowed, you must restart FileMaker Server for the new setting to take effect.

To set the maximum number of files FileMaker Server can host:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the MaxFiles preference parameter, type a space, and type a value for the number of files you expect to host. The minimum setting is 1 and the maximum is 125. For example:

```
MaxFiles 60
```

The default setting is 50 files.
4. If you’re finished making changes to the configuration file, close the text editor, restart FileMaker Server, and log out as the root user.

Note If you decrease the maximum number of hosted files, you can reload the configuration file instead of restarting FileMaker Server.

Changing the amount of memory used by FileMaker Server

You can change the amount of memory FileMaker Server uses for the database cache. Do not specify more RAM than is physically available on the server computer. Be sure to leave enough RAM for the operating system.

When you change the amount of memory set aside for FileMaker Server, you must restart FileMaker Server for the new setting to take effect.

To change the amount of memory FileMaker Server uses:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the CacheSize preference parameter and replace the current value with a whole number between 2 and 40 megabytes (MB). For example:

```
CacheSize 6
```

The default setting is 4 MB.
4. If you’re finished making changes to the configuration file, close the text editor, restart FileMaker Server, and log out as the root user.

Setting how often the cache is flushed

FileMaker Server flushes (writes) information stored in the cache (temporary storage) to disk wherever FileMaker Server is idle. If the cache is flushed frequently, data integrity in hosted files is improved but FileMaker Server performance may decline.

If you want to change this setting, first turn on the cache flush setting. Then you can use the default time interval or specify your own interval.

To flush the cache periodically:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the UseCacheFlush preference parameter and replace the current value with ON.

```
UseCacheFlush ON
```
4. Find the FlushTimeInterval preference parameter and replace the current value with a whole number between 15 and 120 minutes. For example:

   FlushTimeInterval 20

   The default setting is 15 minutes.

5. If you’re finished making changes to the configuration file, close the text editor, reload the configuration file, and log out as the root user.

Allowing single user files to be hosted

For your convenience, you can set FileMaker Server to open files set to Single User in FileMaker Pro. This setting lets you host single-user databases without first having to manually open them in FileMaker Pro and change them to multi-user.

To open single user files automatically:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the HostSingleUserFiles preference parameter and replace the current value with ON.

   HostSingleUserFiles ON

4. If you’re finished making changes to the configuration file, close the text editor, reload the configuration file, and log out as the root user.

Allowing software updates to be downloaded automatically

You can store software updates on the server computer and allow FileMaker Pro 5.5 guests to download these files automatically when they open database files hosted by FileMaker Server 5.5. Examples of files you might want to download automatically are plug-in files or plug-in license files, sometimes required by FileMaker Pro databases.

When a FileMaker Pro file is hosted using FileMaker Server, any plug-ins required by the file must exist on each guest computer used to open the database. By allowing plug-in updates to be downloaded automatically, you ensure that all guests have access to plug-ins required by the database the first time they attempt to open it. In addition, when plug-ins are changed by database developers, you can store new versions on the server computer so you don’t have to update plug-ins on many individual guest computers.

If you want to change this setting, first turn on the Auto Update setting. Then place plug-in and plug-in version files in the Auto Update directory on the server computer and instruct database guests to turn on the Auto Update plug-in in the Application preferences in FileMaker Pro 5.5.

Enabling Auto Update in FileMaker Server

To enable FileMaker Pro guests to automatically receive plug-in updates from the server computer:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the UseAutoUpdate preference parameter and replace the current value with ON.

   UseAutoUpdate ON

4. If you’re finished making changes to the configuration file, close the text editor, reload the configuration file, and log out as the root user.

Note: FileMaker Pro 5.5 can check the version of plug-in files required by the hosted database and update plug-ins if the current version is not located on the guest computer. However, FileMaker Pro cannot verify the version of other downloadable files. If a non-plug-in file is located on both the server and guest computers, the file on the guest computer is backed up in the Saved System Folder (Windows) or Saved FileMaker Extensions folder (Mac OS) and the file on the server is placed in the System Folder (Windows) and FileMaker Extensions folder (Mac OS).
Storing plug-in files on the server computer

For automatic file downloading to work correctly, you must place current plug-in files and text files containing version information for each plug-in in the correct location on the server computer. In addition, guests must activate the Auto Update plug-in in the Application preferences in FileMaker Pro 5.5 before attempting to open hosted files that require plug-ins.

To set up the server and guest computers for Auto Update:

1. Obtain updated plug-in and version control files from your FileMaker Pro database developers.
2. Place files for automatic download in the /var/fmserver/AutoUpdate directory or create a directory named AutoUpdate in the directory that contains the databases that require plug-ins.

Tip If you host multiple databases that use the same plug-ins, store updates in the /var/fmserver/AutoUpdate directory, rather than in individual AutoUpdate folders in each database directory. This allows you to store an update in one place on the server computer, and makes it available for all databases that need it.

3. Instruct users of guest computers to enable automatic download in FileMaker Pro 5.5 as follows: Start FileMaker Pro, choose Edit menu > Preferences > Application (Windows and Mac OS 8.6 to 9.1) or FileMaker Pro menu > Preferences > Application (Mac OS X).

4. Click the Plug-ins tab and select Auto Update.

Specifying the location of hosted files

When FileMaker Server starts, it looks for databases in the /var/fmserver directory (and one level down) by default and opens them automatically. You can have FileMaker Server open files in a different directory (and one level down) by specifying the directory path in the configuration file.

Note The ServerRoot preference parameter is the search path for the close, pause, and resume commands as well. Therefore, when you issue a close, pause, or resume command, FileMaker Server looks for files located in this path.

When you change the location of hosted files, you must restart FileMaker Server for the new setting to take effect.

To specify the location of hosted files:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the ServerRoot preference parameter and replace the current value with a new path. For example:

   ServerRoot "/var/fmserver/autoopen"

4. If you’re finished making changes to the configuration file, close the text editor, restart FileMaker Server, and log out as the root user.

Specifying a user account name and group name for FileMaker Server

For security reasons, you can specify a custom user account name for FileMaker Server to use after installation, which makes FileMaker Server run as a non-privileged user. Changing the account and group name can protect your system from extensive damage if someone were to misuse the fmserverd process.

<table>
<thead>
<tr>
<th>Guest platform</th>
<th>File format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>.fmx file type for plug-in files</td>
</tr>
<tr>
<td></td>
<td>.txt version plug-in version control files</td>
</tr>
<tr>
<td>Mac OS</td>
<td>.fmxt file type in bin format (MacBinary) for plug-in files</td>
</tr>
<tr>
<td></td>
<td>.txt format plug-in version control files</td>
</tr>
</tbody>
</table>

Tip If you host multiple databases that use the same plug-ins, store updates in the /var/fmserver/AutoUpdate directory, rather than in individual AutoUpdate folders in each database directory. This allows you to store an update in one place on the server computer, and makes it available for all databases that need it.
To specify a customized user account name and group name:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the FMServerUser preference parameter and replace the existing user name between the quotes with a custom user name. For example:
   
   FMServerUser "fmsdaemon"

   The default user account name is fmserver.

4. Find the FMServerGroup preference parameter and replace the existing group name between the quotes with a custom group name. For example:

   FMServerGroup "MKTG"

   The default group name is fmserver.

   **Note**: Both the user name and group name are case sensitive.

5. If you’re finished making changes to the configuration file, close the text editor.

6. Ensure that all databases hosted by FileMaker Server are readable and writable by the new user and group names by entering the following commands:

   ```
   # chown fmsdaemon database_1 database_2 ...
   # chgrp MKTG database_1 database_2 ...
   # chmod 664 database_1 database_2 ...
   ```

   where `database_1 database_2` ... is a list of all databases to be hosted, separated by single spaces.

   The chmod command above grants read/write permission to the new user and group names. When you list hosted files using the operating system command `ls -1`, file permissions are now displayed as follows:

   `-rw-rw-r--`

   **Important**: If permissions are not set correctly on database files, FileMaker Server can’t open them.

7. Restart FileMaker Server and log out as the root user.

**Enabling remote administration in FileMaker Server**

Using FileMaker Pro 5.x, you can remotely control FileMaker Server from a different computer than the one on which FileMaker Server is installed and hosting databases. After you turn on remote administration, you can use a remote computer to view a list of hosted databases, the guests using them, and monitor performance statistics. You can control access to remote administration by requiring a password that restricts access to the Remote administration databases. For more information about using remote administration on a guest computer, see chapter 7, “Administering FileMaker Server (Windows and Mac OS).”

If you want to administer FileMaker Server from a remote computer, first enable it on the server computer. Then install the remote administration plug-in on the client computers you plan to use for remote administration. For more information about installing and enabling the remote administration plug-in, see “Automatically downloading the Server Administration plug-in to a remote computer” on page 7-6.

To administer FileMaker Server from a remote computer, first turn on remote administration and then enable password protection, if you want. You use the fmspasswd utility installed with FileMaker Server to encrypt the remote administration password.

To turn on remote administration and create a remote administration password:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the UseRemoteAdmin preference parameter and replace the current value with `ON`.

   ```
   UseRemoteAdmin ON
   ```
4. Find the RequirePassword preference parameter and replace the current value with \texttt{ON}, if you want to restrict access to remote administration.

\texttt{RequirePassword \texttt{ON}}

5. If you’re finished making changes to the configuration file, close the text editor.

6. Use the \texttt{fmspasswd} utility to encrypt a remote administration password, as described in the next section. Then reload the configuration file, and log out as the root user.

\textbf{Using the \texttt{fmspasswd} utility to encrypt passwords}

You can use the \texttt{fmspasswd} utility installed with FileMaker Server to encrypt passwords for remote administration and directory service access. Encrypted passwords are stored in the FileMaker Server configuration file.

To encrypt a password:

\begin{enumerate}
\item If you’re not already logged in as root, switch to the root user.
\item Enter the following command to start the \texttt{fmspasswd} utility:
\begin{verbatim}
# fmspasswd
\end{verbatim}
\item Enter the path to the FileMaker Server configuration file when prompted.
\item If the configuration file is in the default location, press Return.
\item When prompted, enter \texttt{R} if you’re encrypting a password for the remote administration preference or enter \texttt{L} if you’re encrypting a password for the LDAP preference.
\item Enter your password.
\item For security reasons, your password doesn’t appear on the screen.
\item Verify your password by entering it again.
\end{enumerate}
**Specifying the preferred IP address**

If you have more than one network card in the server computer, you can specify a preferred IP address for FileMaker Server to use. Otherwise, FileMaker Server will use the first configured non-loopback device returned by the operating system.

If you want to dedicate a specific IP address for FileMaker Server, first you turn on this setting and then you specify the IP address to use. After you specify a preferred IP address, you must restart FileMaker Server for the new setting to take effect.

To set the preferred IP address:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the UsePrefIPAddr preference parameter and replace the current value with ON.
   
   ```
   UsePrefIPAddr ON
   ```

4. Find the PrefIPAddr preference parameter and replace the current value between the quotes with a valid IP address. For example:
   
   ```
   PrefIPAddr "192.168.0.10"
   ```

   **Note:** If UsePrefIPAddr is set to OFF, the PrefIPAddr setting is ignored and the first system IP address is used.

5. If you’re finished making changes to the configuration file, close the text editor, restart FileMaker Server, and log out as the root user.

**Opening runtime solutions automatically**

You can have FileMaker Server automatically open runtime solution files that have been bound using FileMaker Developer 5.x.

**About FileMaker Developer**

FileMaker Developer lets database developers create and distribute complete single user database solutions containing layouts that are not modifiable by users.

Runtime solution files typically have unique filename extensions. For example, rather than the standard .fp5 extension, a runtime solution file might have the extension .cm1. Registering these runtime solution filename extensions in the fmserver.conf file enables FileMaker Server to open these files automatically when they are placed in the /var/fmserver directory (or subdirectories one level down).

If you want FileMaker Server to open runtime solutions automatically, first turn on custom extensions, then specify the extensions to recognize.

To enable FileMaker Server to open runtime solution files automatically:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the UseCustomExtensions preference parameter and replace the current value with ON.
   
   ```
   UseCustomExtensions ON
   ```

4. Find the CustomExtensions preference parameter and replace the current value between the quotes with from 1 to 16 custom file extensions. Separate each extension with a colon. For example:
   
   ```
   CustomExtensions ".cm1:.fregv:.fvgx:.pfc"
   ```

   Extensions can contain any characters except the double quote character (") and can be any length, as long as the database file name and extension don’t exceed 256 characters.

5. If you’re finished making changes to the configuration file, close the text editor, restart FileMaker Server, and log out as the root user.
FileMaker Server creates event and statistics log files to help you keep track of activities on the server.

The event log (var/log/fmserver/events.log) contains time stamped information on:

- FileMaker Server start and stop events
- the size of the database cache
- current preference settings from the configuration file
- database files opened and closed by FileMaker Server
- guests that connect to and disconnect from FileMaker Server and the files they access
- guests that are disconnected by FileMaker Server
- pre-defined errors and other unusual conditions that occur when FileMaker Server is running

The statistics log (var/log/fmserver/stats.log) contains realtime statistical information regarding FileMaker Server usage, such as the number of guests connected and the percentage of unsaved cache.

For more information about interpreting information in the statistics log, see “Viewing usage statistics for FileMaker Server” on page 7-7.

Setting a size limit and the location of the event log

To set a size limit and change the location for the event log:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the MaxEventLogSize preference parameter and replace the current value between the quotes with a value between 1 and 40 MB. For example:

   ```
   MaxEventLogSize 10
   ```

   The default setting is 1 MB. If the log file grows to within 5 KB of the size set in the configuration file, the log is backed up in a file named events.log.old in the log directory and a new log file is created.
4. Find the EventLogPath preference parameter and replace the current value between the quotes with the path where you want to store the event log file. For example:

```
EventLogPath "/var/log/MKTG_DB_Server/events.log"
```

The default path is /var/log/fmserver/events.log.

5. If you’ve finished making changes to the configuration file, close the text editor. If you changed only the size of the event log, reload the configuration file. If you changed the location of the event log, restart FileMaker Server. Then log out as the root user.

Creating a statistics log

You can create a log file to collect statistical information about FileMaker Server and set the time interval (in seconds) when statistical information is written to the log. You can also set a maximum size for the log file.

First you turn on the statistics log so a log file is created and updated as statistical information is collected. Then set the location of the log file, the collection interval, and maximum size, if you want.

To save usage statistics for FileMaker Server in a log file:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the UseStatsLog preference parameter and replace the current value with ON.
   ```
   UseStatsLog ON
   ```
4. Find the StatsLogPath preference parameter and replace the current value between the quotes with the path where you want to store the statistics log file.
   ```
   StatsLogPath "/*user/MKTG_DB_Server/stats.log"
   ```
   The default path is /var/log/fmserver/stats.log.

5. Find the StatsTimeInterval preference parameter and replace the current value with a value between 15 and 300 seconds. For example:

   ```
   StatsTimeInterval 20
   ```
   The default setting is 15 seconds.

6. Find the MaxStatsLogSize preference parameter and replace the current value with a value between 1 and 40 MB. For example:

   ```
   MaxStatsLogSize 20
   ```
   The default setting is 1 MB. If the log file grows to within 5 KB of the size set in the configuration file, the log is backed up in a file named stats.log.old in the log directory and a new log file is created.

7. If you’ve finished making changes to the configuration file, close the text editor. If you changed the location of the event log, restart FileMaker Server. Otherwise, reload the configuration file. Then log out as the root user.

Using FileMaker Server with a directory service

If your organization uses a Lightweight Directory Access Protocol (LDAP)-compliant directory service, such as Microsoft Active Directory, Netscape Directory, or OpenLDAP, you can centrally manage your hosted databases by registering FileMaker Server with your directory service.

When FileMaker Server is registered with an LDAP-compliant directory service, the host name and IP address are published to the directory service. The FileMaker Server administrator's contact information can also be published.

For information about setting up a directory service, see the Directory Service directory on the FileMaker Server CD.
Enabling directory service registration
To register FileMaker Server with a directory service, you need to set the following preferences in the configuration file:

1. specify the fully-qualified domain name or IP address of the directory service
2. specify an account name and password for directory service access
3. verify and possibly change the port number used to access the directory service
4. register the distinguished name for FileMaker Server in the directory service

In addition, you can optionally publish your contact information with the directory service. This way, the directory service administrator can contact you if, for example, hosted databases are unavailable for guest access.

Your system administrator should be able to give you the information you need to complete the required directory service preference settings.

To enable FileMaker Server to register with a directory service:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.
3. Find the UseDirectoryService preference parameter and replace the current value with ON.
   
   UseDirectoryService ON

4. Find the DirectoryService.ServerName preference parameter and replace the current value between the quotes with the domain name of the directory service or IP address of the directory server. For example:
   
   DirectoryService.ServerName "17.184.8.9"

5. Find the DirectoryService.LogonRequired preference parameter and replace the current value with ON.
   
   DirectoryService.LogonRequired ON

6. Find the DirectoryService.AcctName preference parameter and replace the current value between the quotes with your account name. For example:
   
   DirectoryService.AcctName "My_Company"

7. Find the DirectoryService.Password preference parameter and replace the current value with ON.
   
   DirectoryService.Password ON

8. Find the DirectoryService.LdapServerPort preference parameter and replace the current value with the port number of your directory service. For example:
   
   DirectoryService.LdapServerPort 300

   The default setting is 389. The port number setting indicates the type of the port required by your directory service. For example, 389 indicates an LDAP server port, but some LDAP-compliant directory services use a different port number.

9. Find the DirectoryService.DistinguishedName preference parameter and replace the current value between the quotes with your distinguished name. For example:
   
   DirectoryService.DistinguishedName"ou=filemaker, dc=domainname, dc=com"

   The distinguished name indicates where FileMaker Server is registered or located in the directory service.

10. If you’re finished making changes to the configuration file, close the text editor.

11. If you enabled the DirectoryService.Password preference parameter, use the fmspasswd utility to encrypt a remote administration password, as described in “Using the fmspasswd utility to encrypt passwords” on page 9-11. Then restart FileMaker Server and log out as the root user.
Publishing your contact information to your directory service

As the FileMaker Server administrator, you can publish your name, location, phone number, and e-mail address to your directory service. This is useful if the directory service administrator needs to contact you.

To publish contact information for the FileMaker Server administrator:

1. Using your text editor, open the fmserver.conf file.
2. Find the DirectoryService.Owner preference parameter and replace the current value between the quotes with your administrator’s name. For example:
   
   DirectoryService.Owner "Sophie Tang"

3. Find the DirectoryService.Location preference parameter and replace the current value between the quotes with the physical location of the server computer. For example:
   
   DirectoryService.Location "Computer room in bldg 1"

4. Find the DirectoryService.Phone preference parameter and replace the current value between the quotes with your phone number. For example:
   
   DirectoryService.Phone "408-555-1234"

5. Find the DirectoryService.Email preference parameter and replace the current value between the quotes with your e-mail address. For example:
   
   DirectoryService.Email "sophietang@my_company.com"

6. If you’re finished making changes to the configuration file, close the text editor, restart FileMaker Server, and log out as the root user.
Chapter 10
Manually installing the Server Administration plug-in on a remote computer

Note The Server Administration plug-ins are installed in the AutoUpdate folder by default and can be automatically downloaded to a remote computer. For more information, see “Automatically downloading the Server Administration plug-in to a remote computer” on page 7-6.

About the Server Administration plug-in
To have full administrative capabilities when administering FileMaker Server from a remote computer (a computer that is not running the server software), you must install the Server Administration plug-in on each remote computer you plan to use for remote administration.

In addition to viewing information about databases, guests, and FileMaker Server activities, the plug-in also lets you use a remote computer to:
- open FileMaker Pro 5.x files for access by FileMaker Pro guests through FileMaker Server
- close files hosted by FileMaker Server
- disconnect a selected FileMaker Pro guest from one or all hosted files
- send messages to guests of hosted files

Before you can use FileMaker Pro 5.x to administer files hosted by FileMaker Server, you must use FileMaker Pro to enable the Server Administration plug-in (see page 10-2 for Windows procedure or page 10-3 for Mac OS procedure), and use FileMaker Server to enable remote administration (see page 6-9).

For information about using remote administration, see chapter 7, “Administering FileMaker Server (Windows and Mac OS).”

Manually installing the plug-in on a remote computer (Windows NT and Windows 2000)

1. Exit all other applications and turn off virus protection utilities.
2. Install FileMaker Pro 5.x on the remote computer, if it’s not already installed.
3. Insert the FileMaker Server CD into your CD or DVD drive.
You see the FileMaker Server Setup Wizard.
5. Click Next.
6. Read the license agreement. If you agree to these terms, select I accept the terms in the License Agreement, then click Next.
7. Type your name and organization, and indicate who can access FileMaker Server from this computer (only you or anyone who uses the computer). Then click Next.
8. Select Custom then click Next.
You see the Custom Setup screen in the Setup Wizard.
9. Click the disk icon to the left of FileMaker Server and choose This feature will not be available.
10. Click the disk icon to the left of FileMaker Server Examples and choose This feature will not be available.
Click the disk icon to the left of FileMaker Server Remote Administration and choose This feature will be installed on local hard drive, then click Next.

Click Install.

The Installer installs the plug-in (fmpsadm.fmx) on your hard disk. The Installer checks if FileMaker Pro 5.x is installed on the remote computer. If the Installer finds FileMaker Pro 5.x, it uses the FileMaker Pro 5.x path as the default location for the Server Administration plug-in. If FileMaker Pro 5.x is not found, the Installer sets the default installation path to: Program Files\FileMaker\FileMaker Pro 5.x\System

Click Finish to close the Setup Wizard.

Enabling the Server Administration plug-in using FileMaker Pro (Windows)

To enable the Server Administration plug-in:

1. Start FileMaker Pro 5.x.
2. Choose Edit menu > Preferences > Application.
3. Click the Plug-ins tab, select Server Administration, then click OK.

If you want to administer FileMaker Server now, see “Enabling remote administration” on page 6-9 and “Opening the Remote Administration window” on page 7-6. Otherwise, choose File menu > Exit to exit FileMaker Pro.

Manually installing the Server Administration plug-in on a remote computer (Mac OS)

Note: You must be running Mac OS 7.6.1 to 9.1 or Mac OS X on the remote computer to install the Server Administration plug-in.

To install the Server Administration plug-in on a computer running the Mac OS:

1. Quit all other applications, especially virus protection software, and disable file sharing.
2. Install FileMaker Pro 5.x on the remote computer, if it’s not already installed.

3. Insert the FileMaker Server CD into your CD or DVD drive. You see the CD window on your screen. If you see only the disc icon, double-click the icon to open its window.

4. Double-click the Installer icon named Start Here Mac OS Classic or Start Here Mac OS X.

5. Read the license agreement. If you agree to these terms, click Accept.

You see the FileMaker Server Installer dialog box.

6. Click Easy Install and select Custom Install.

Note The Easy Install/Custom Install menu does not appear if you are running a version of Mac OS prior to 8.6.

7. Select FileMaker Server Remote Administration.

The plug-in must be installed in the FileMaker Extensions folder in the FileMaker Pro 5.x folder. If FileMaker Pro 5.x is installed, the FileMaker Server Installer locates this folder on your hard disk and installs the Server Administration plug-in there. If FileMaker Pro 5.x is not installed on your computer, the Installer creates the following folder and installs the plug-in here:

```
hard_disk:FileMaker Pro 5.x folder:FileMaker Extensions
```

8. Click Install.

9. Click Quit to leave the Installer when the installation is finished.

10. If you turned off virus protection and file sharing before installation, turn them back on now.

Enabling the Server Administration plug-in using FileMaker Pro (Mac OS)

To enable the Server Administration plug-in:

1. Start FileMaker Pro 5.x.

2. Choose Edit menu > Preferences > Application (Mac OS 8.6 to 9.1) or FileMaker Pro menu > Preferences > Application (Mac OS X).

3. Click the Plug-ins tab, select Server Administration, then click OK.

If you want to administer FileMaker Server now, see “Enabling remote administration” on page 6-9 and “Opening the Remote Administration window” on page 7-6. Otherwise, choose File menu > Quit (Mac OS 8.6 to 9.1) or FileMaker Pro menu > Quit FileMaker Pro (Mac OS X) to quit FileMaker Pro.
Appendix A
Technical specifications and optimization

Limits for files and usage

<table>
<thead>
<tr>
<th>Item</th>
<th>Maximum setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of files hosted by FileMaker Server</td>
<td>125 files, depending on the Maximum number of files to host (Windows and Mac OS) or MaxFiles (Red Hat Linux) setting. (Other network applications may limit this number.)</td>
</tr>
<tr>
<td>Number of files open at the same time</td>
<td>50 per FileMaker Pro 5.x guests</td>
</tr>
<tr>
<td>Number of network users</td>
<td>250 guests. (AppleTalk support is limited to 124 simultaneous guests.) You can restrict the number of simultaneously connected guests with the Maximum number of simultaneously connected guests (Windows and Mac OS) or MaxGuests (Red Hat Linux) setting. Specifying a realistic number of guests fewer than 250 can optimize performance.</td>
</tr>
<tr>
<td>File size</td>
<td>2 GB (gigabytes) per file. The combined size of all open files is limited only by disk space.</td>
</tr>
<tr>
<td>Length of host name</td>
<td>31 characters</td>
</tr>
<tr>
<td>Length of FileMaker Server password</td>
<td>31 characters</td>
</tr>
<tr>
<td>Length of filename</td>
<td>Windows: 255 characters</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: To open the files in FileMaker Server, the first 31 characters of the filename must be unique.</td>
</tr>
<tr>
<td></td>
<td>Mac OS: 31 characters</td>
</tr>
<tr>
<td></td>
<td>Red Hat Linux: 256 characters</td>
</tr>
</tbody>
</table>

Hardware and network considerations

Keep the following points in mind when you’re setting up FileMaker Server on your computer and configuring the network where it will run.

**Use a dedicated computer**
Use FileMaker Server by itself on a computer on which no other applications are normally running and that isn’t a user’s primary workstation. When FileMaker Server is hosting many guests or a large number of database files, it uses a high level of processor, disk, and network capacity. Other processor-intensive applications or heavy network traffic on the same computer causes FileMaker Server to run more slowly, and the performance of FileMaker Pro on guest computers to degrade.

**Use as fast a computer as possible**
The faster the computer, the better the performance of FileMaker Server.

- Windows and Red Hat Linux: FileMaker Server requires at minimum a Pentium processor.
- Mac OS: FileMaker Server requires at minimum a PowerPC processor.
Use a fast hard disk
Because of the way FileMaker Pro stores information in files, FileMaker Server benefits a great deal from fast disk input/output. Try to use a hard disk with software (or drivers) that supports asynchronous disk I/O. This technology lets FileMaker Server perform other operations after starting a read or write operation on a file, rather than having to wait for the disk I/O to complete. If FileMaker Server can take advantage of asynchronous I/O when opening a file, it notes it in the corresponding log file entry. (See “Using reported events to track activities” on page 7-18 (Windows and Mac OS) or “Using reported events and statistics to track activities” on page 9-13 (Red Hat Linux) for more information.) To determine whether your hardware supports asynchronous I/O, refer to the documentation that came with your hardware.

Use a fast network
Mac OS: If possible, use a network faster than LocalTalk, such as Ethernet.

Software considerations
Consider the following issues when deciding which software to use with FileMaker Server.

Only FileMaker Pro 5.x databases can be hosted
FileMaker Server 5.5 supports only FileMaker Pro 5.x databases. Therefore, any existing databases you have from a previous version of FileMaker Pro must be converted to FileMaker Pro 5.x format before you can host them using FileMaker Server 5.5.

Coexistence with screen savers software
Avoid using screen saver software that creates moving images on the monitor of the computer running FileMaker Server. This type of software can use significant system resources, which hinders the processing of FileMaker Server networking traffic. Instead, use a screen saver that blacks out your monitor or dims its brightness, or manually dim the monitor.

Turn off file sharing
Make sure operating system file sharing is turned off on the server computer.

Coexistence with AppleShare software (Mac OS 8.6 to 9.1)
Running AppleShare software (including AppleShare and AppleShare Pro) and the FileMaker Server application on the same computer is not recommended. If you must use that configuration, keep the following information in mind:

- Limit connected AppleShare users.

Users connected to an AppleShare server through the AppleTalk protocol occupy a physical connection to the server known as an AppleTalk socket. AppleTalk sockets are also used by FileMaker Server when guests access a hosted file using the AppleTalk protocol. If many users are connected to the AppleShare server and are occupying these AppleTalk sockets, fewer sockets are available to FileMaker Server running on the same computer. This could cause FileMaker Pro guests using the AppleTalk protocol to receive a message indicating that they have exceeded host capacity, which prevents them from accessing hosted databases on the server even if server limit requirements on page A-1 haven’t been reached.
- Use a third-party server access monitoring utility to keep the number of AppleShare connections to a minimum and to allow only active connections.
This lets FileMaker Server use the maximum number of sockets for guests of FileMaker Pro files. For more information about configuring AppleShare software, see your AppleShare documentation.

**Don’t allow the server to sleep (Windows 2000 and Mac OS)**

Windows 2000 supports Power Conservation Mode, which can cause your computer to hibernate or enter Standby mode, affecting the operation of FileMaker Server. Similarly, computers running the Mac OS can suspend operations when they enter an energy-saving system sleep state. Therefore, FileMaker, Inc. recommends that you disable Power Conservation mode (Windows 2000) or system sleep (Mac OS) on the computer running FileMaker Server. For more information, see “How FileMaker Server behaves during system sleep (Windows 2000 and Mac OS)” on page 6-17.
This page intentionally left blank.
Appendix B
Performance and usage tips

Performance tips

If you find that FileMaker Server is sluggish when performing certain operations, try the following:

- Run FileMaker Server on a dedicated computer.
- Use as fast a computer and network as possible.
- Always use remote administration to perform administrative tasks on hosted files, such as sending messages to connected guests.
- Reduce the number of guests able to access FileMaker Server. See “Setting the number of guests” on page 6-3 (Windows and Mac OS) or “Setting the number of guests” on page 9-6 (Red Hat Linux).
- Reduce the maximum number of files that can be hosted by FileMaker Server. See “Setting the maximum number of files” on page 6-5 (Windows and Mac OS) or “Setting the maximum number of files” on page 9-7 (Red Hat Linux).
- Monitor the cache hit percentage in usage statistics. You can view real-time usage statistics using the Performance Monitor (Windows NT), System Monitor (Windows 2000), or the Usage Statistics window (Mac OS 8.6 to 9.1 or remote administration).

The value for Cache Hits is the percentage of times FileMaker Pro retrieves data from the cache (RAM) rather than the hard disk. Reading data from RAM is much more efficient than reading it from the hard disk, so this value should be a high number, like 90 or 95. If it isn’t, you might need to allocate more memory to FileMaker Server.

FileMaker Server tracks three values for Cache Hits: Current, Average, and Peak. It’s best to monitor the Current value periodically, as an average value can be skewed by running even one data-intensive report on a hosted database.

- Monitor the percentage of unsaved cache in usage statistics. This value indicates how much data could potentially be lost if your server computer shut down unexpectedly before writing data stored in cache to the hard disk.

The percentage reported is the portion unsaved in the total cache. For example, if the cache is set to 2 MB and the Cache Unsaved % value is 50, you would lose 1 MB of data should your computer fail unexpectedly.

If the Cache Unsaved % value is consistently high, increase the frequency with which the cache is flushed, or schedule backups that occur more often. For more information about changing cache flush frequency, see “Setting how often the cache is flushed” on page 6-7.

- Don’t collect statistical information too frequently. FileMaker, Inc. recommends setting the collection rate no lower than 15 seconds. For more information, see “Recording usage statistics and setting size limits” on page 6-12 (Windows and Mac OS) or “Creating a statistics log” on page 9-14 (Red Hat Linux).

- Perform calculation-intensive operations on a small found set.

Sorting, replacing data, viewing and printing summary report layouts, and other calculation-intensive operations performed on many database records affect the overall performance of FileMaker Server for connected guests. Try to perform these types of operations on a smaller found set of only the records you’re interested in. (See the FileMaker Pro 5 User’s Guide for more information about using found sets.) In addition, it’s best to schedule these types of operations to be performed during low usage periods.
Avoid automatic file compression. If the hard disk runs out of space while a file is being modified or if a database file reaches the 2 GB size limit, FileMaker Server will automatically begin compressing the hosted file to reduce the amount of disk space it uses. During the compression, all guest activity to that file is paused. To avoid automatic compression, leave plenty of free hard disk space on the computer running FileMaker Server and monitor database file sizes.

Enable FileMaker Server to open files automatically. Put database files you want FileMaker Server to host in the same folder as FileMaker Server (and subfolders one level down) to take advantage of the application’s ability to open these files automatically on startup and when remote administration is enabled.

Avoid using FileMaker Server on the same computer that is operating as a file server as performance will be significantly decreased for both services.

Increase the cache size in the Properties (Windows) or Preferences (Mac OS) dialog box or CacheSize preference parameter (Red Hat Linux). See “Changing the amount of memory used by FileMaker Server” on page 6-5 (Windows and Mac OS) or “Changing the amount of memory used by FileMaker Server” on page 9-7 (Red Hat Linux) for details.

Verify that no other processor-intensive programs or applications that create a high level of network traffic are being used on the computer running FileMaker Server. Examples of software that can cause performance problems for FileMaker Server include screen savers, Internet Information Server (Windows), or SQL Server (Windows).

Windows: Consider using either the Logon screen saver or the Blank Screen screen saver that is available with Windows.

Don’t use personal file sharing to share FileMaker Pro files. Guests should access hosted FileMaker Pro files using the Hosts button in the Open dialog box in FileMaker Pro.

**Usage tips**

FileMaker Server can host FileMaker Pro 5.x files created on either the Windows or Mac OS platform, but the files should reside in the FileMaker Server 5.5 folder (Windows and Mac OS) or /var/fmserver (Red Hat Linux) and subfolders or subdirectory one level down. With Windows, you can have the files in other folders if you place shortcuts to the FileMaker Pro files (or to folders containing FileMaker Pro files) in the FileMaker Server 5.5 folder. You can also drag database files on top of the fmserver.exe (Windows) or FileMaker Server (Mac OS 8.6 to 9.1) application icon to open them.

Windows: If you modify the .fp5 extension of a FileMaker Pro file, FileMaker Server can’t automatically open the file when started. To open files with modified filename extensions:

- Register the non-standard file extension using the File Type properties (see page 6-8) and place the file in the FileMaker Server 5.5 folder (and subfolders one level down) so it opens when the FileMaker Server service starts.
- Manually drop the file with the non-standard extension on top of the FMServer.exe file.
- Use the command line to open the file with the non-standard extension. For more information about command line options, see “Using the command line to automate tasks (Windows)” on page 8-8.

Red Hat Linux: If hosted database files have custom file extensions (something other than .fp5), FileMaker Server can’t open them automatically when it starts unless you register the file extensions in the FileMaker Server configuration file (fmserver.conf). For more information, see “Opening runtime solutions automatically” on page 9-12.

If you have duplicate filenames in the FileMaker Server 5.5 folder and subfolders one level down, FileMaker Server opens the first copy it finds.
FileMaker Server administration allows several operations to be performed simultaneously on all of the files in a single subfolder. For example, you can use Pause, Resume, Close, and Open from the command line, or you can use Back up and Send Message from a scheduled task (Windows and Mac OS). To take advantage of this feature, place related databases into the same subfolder. When FileMaker Server is started, these files are hosted as a group.

Up to a maximum of 125 files can be made accessible to FileMaker Pro 5.x guests on the network. Each FileMaker Pro guest can open a maximum of 50 files. Since FileMaker Server can host up to 125 files, it is possible to have multiple files available for access by multiple workgroups.

Remember that double-clicking a FileMaker Pro file opens that file in FileMaker Pro 5.x, not FileMaker Server. See “Hosting FileMaker Pro 5.x files” on page 7-8 (Windows and Mac OS) or “Administering FileMaker Server” on page 9-1 (Red Hat Linux) to learn about opening files with FileMaker Server.

FileMaker Server displays a message if it can’t open the selected database file and writes a description of the problem to the Application Log (Windows) or the server event log (Mac OS) or /var/log/fmserver/events.log (Red Hat Linux). For more information, see “Using reported events to track activities” on page 7-18 (Windows and Mac OS) or “Using reported events and statistics to track activities” on page 9-13 (Red Hat Linux).

If the database file you’re hosting uses the Today function to calculate dates, you must close and reopen it using FileMaker Server each day to update the dates correctly. See “Recalculating the Today function in hosted databases” on page 7-20 for more information.
This page intentionally left blank.
# Appendix C
## Event log messages and troubleshooting

### FileMaker Server event log messages

The following is a list of some of the log file messages you might see and an explanation. Variables, such as the name of the user or file, are in italics.

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppleTalk network initialization failed; an unexpected error occurred (error number)</td>
<td>FileMaker Server couldn’t initialize AppleTalk due to an unexpected operating system error. See your operating system documentation for an explanation of the specified error. Check the AppleTalk configuration and reconfigure or reinstall, if needed.</td>
</tr>
<tr>
<td>AppleTalk network initialization failed; not enough memory</td>
<td>There is insufficient memory to use AppleTalk. See “What you need” on page 3-1 for RAM requirements.</td>
</tr>
<tr>
<td>AppleTalk network initialization failed; protocol not installed</td>
<td>Check the network installation and setup procedures in the operating system documentation and reinstall the protocol, if necessary.</td>
</tr>
<tr>
<td>Closing file filename due to a serious error (error number)</td>
<td>The specified file is being closed by FileMaker Server due to an error condition. The file may need to be recovered in the FileMaker Pro 5.x application. See “Troubleshooting” in FileMaker Pro 5.5 Help for information about recovering damaged files.</td>
</tr>
<tr>
<td>Could not pause file filename because of an outstanding database lock from guest guestname</td>
<td>FileMaker Server is trying to get exclusive use of the file to pause it for an operation (for example, a backup or cache flush), but can’t because a guest is changing the file. You can try the backup later, or close the file to force the guest(s) to disconnect.</td>
</tr>
<tr>
<td>File could not be opened: database may be damaged; try opening in FileMaker Pro</td>
<td>The file may be damaged and needs to be opened in FileMaker Pro 5.x. Start the FileMaker Pro application, open the file, and follow any instructions on your screen. (See “Troubleshooting” in FileMaker Pro 5.5 Help for more information about recovering files.) Then try opening the file with FileMaker Server.</td>
</tr>
<tr>
<td>File could not be opened: must be set to Multi-User in FileMaker Pro</td>
<td>FileMaker Server can’t open files set to single user by default. However, you can select Allow FileMaker Server to host Single-User files in the files tab of the Properties dialog box (Windows) or the Preferences dialog box (Mac OS) or enable the HostSingleUserFiles preference parameter (Red Hat Linux) to open the file without changing it using FileMaker Pro. Alternatively, you can open the file in the FileMaker Pro 5.x application and choose File menu &gt; Sharing &gt; Multi-User before opening it with FileMaker Server.</td>
</tr>
<tr>
<td>File filename full, compression started</td>
<td>When a FileMaker Pro file approaches the 2 GB file size limit or there is no longer enough free space on the hard disk, FileMaker Server attempts to compress it by reclaiming unused space in the file. This process is automatic, and this message is written to the log file when the process begins.</td>
</tr>
</tbody>
</table>
### Message Explanation

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>File filename compressed, freeing x blocks</td>
<td>The specified file has been successfully compressed, leaving FileMaker Server enough room to continue working with the file safely. (One block equals 1,024 bytes.)</td>
</tr>
<tr>
<td>File filename compressed, but still nearly full. Only x block(s) free</td>
<td>The specified file was compressed, but there isn’t enough room for FileMaker Server to continue safely working with the file. The administrator should close the file, back it up, and take steps to reduce the size of the file and create more room on the hard disk.</td>
</tr>
<tr>
<td>FileMaker Server is now awake. All schedules will be resumed.</td>
<td>This message is sent to the log by FileMaker Server when the server computer wakes up from hibernation (Windows 2000) or system sleep mode (Mac OS). Files that were hosted by FileMaker Server before hibernation or sleep occurred are now available for guest access once again.</td>
</tr>
<tr>
<td>FileMaker Server is going to sleep. The entire cache will be flushed.</td>
<td>If the server computer is configured to sleep during periods of inactivity, before doing so the operating system prompts each open service or application to find out if the service or application can accommodate sleep mode. If any guests are currently connected to a hosted database, FileMaker Server denies the sleep request and the server computer does not sleep. If no guests are connected, FileMaker Server writes any unsaved changes to disk (flushes the cache) and allows the server computer to sleep. During sleep, all scheduled tasks are suspended and do not run again until the next scheduled time when the server computer is awake.</td>
</tr>
<tr>
<td>FileMaker Server quitting! (error number)</td>
<td>FileMaker Server detects a severe error during network use, due to a network failure or other causes. Check network installation, settings, and the system error log (Windows).</td>
</tr>
<tr>
<td>FileMaker Server quitting! Network initialization failed; an unexpected error occurred</td>
<td>FileMaker Server can’t use any network protocol because of an unexpected error. Check network installation, settings, and the system error log (Windows).</td>
</tr>
<tr>
<td>FileMaker Server quitting! Network initialization failed; not enough memory</td>
<td>FileMaker Server can’t use any network protocol due to insufficient memory. See “What you need” on page 2-1 (Windows), page 3-1 (Mac OS 8.6 to 9.1), page 4-1 (Mac OS X), or page 5-1 (Red Hat Linux) for RAM requirements.</td>
</tr>
<tr>
<td>FileMaker Server quitting! This disk is full</td>
<td>FileMaker Server detects that the disk volume is full. Free some space on the disk and restart FileMaker Server.</td>
</tr>
<tr>
<td>FileMaker Server quitting! Network initialization failed (error number)</td>
<td>FileMaker Server is unable to start because of missing required software or hardware. See “What you need” on page 2-1 (Windows), page 3-1 (Mac OS 8.6 to 9.1), page 4-1 (Mac OS X), or page 5-1 (Red Hat Linux) for more information.</td>
</tr>
<tr>
<td>Quit forced: User username forced to close connection (error number)</td>
<td>During a shutdown or disconnect operation, the named user didn’t close the file within the specified time. The user’s connection was forcibly closed by FileMaker Server.</td>
</tr>
<tr>
<td>Registration with directory service failed (error number)</td>
<td>Registration with the directory service failed because Microsoft Active Directory is not installed on this computer.</td>
</tr>
<tr>
<td>Remote administration has been disabled because the databases could not be opened (error number)</td>
<td>The system’s storage area for temporary files might be full or set to read-only. Check the temporary storage area on the server computer and try again.</td>
</tr>
<tr>
<td>Message</td>
<td>Explanation</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Schedule schedule name aborted; destination could not be found</td>
<td>The specified destination could not be found. If the destination is a removable medium, make sure it is inserted in its drive. If the destination volume is an external or network drive, connect the drive or network. Try again after the destination is correctly set up.</td>
</tr>
<tr>
<td>Schedule schedule name aborted; the destination is not writable</td>
<td>The specified destination is locked or read-only. If the destination is a removable medium, you might need to remove it, make it writable, and reinsert it.</td>
</tr>
<tr>
<td>Schedule schedule name aborted; no open databases to operate on</td>
<td>The schedule specifies a directory in which FileMaker Server currently has no databases open. Therefore, the scheduled task can’t proceed. Make sure that the schedule specifies the correct directory to operate on, and that all databases have been opened correctly.</td>
</tr>
<tr>
<td>Schedule schedule name was unable to back up file filename; can’t replace item with that name on destination</td>
<td>When FileMaker Server backs up a file, it first checks if a file with the same name already exists on the destination volume and attempts to rename the existing file. In this case, the existing file could not be renamed, and therefore it could not be replaced with the new backup. Move the existing file to another location or give it a name that doesn’t conflict with the file being backed up.</td>
</tr>
<tr>
<td>Schedule schedule name was unable to back up file filename; error writing to destination (error number)</td>
<td>An unexpected operating system error occurred when FileMaker Server attempted to copy files to the destination volume. Refer to the system error log or look up the specified error number in your operating system documentation to determine the cause of the problem.</td>
</tr>
<tr>
<td>Schedule schedule name was unable to back up file filename; file on destination is locked</td>
<td>The named file already exists on the destination volume and is locked or read-only. For the backup to succeed, you need to either move the locked/read-only file to a different folder or change the schedule definition to use a different destination. The file could also be open by another application, in which case it must be closed before it can be moved or renamed.</td>
</tr>
<tr>
<td>Schedule schedule name was unable to back up file filename; not enough free space on destination</td>
<td>The destination volume does not have enough free space to hold a copy of the specified file. Check the free space on the destination or choose a different destination for the backup.</td>
</tr>
<tr>
<td>TCP/IP network initialization failed; an unexpected error occurred</td>
<td>FileMaker Server couldn’t initialize TCP/IP due to an unexpected operating system error. See the system event log (Windows) or your operating system documentation for an explanation of the specified error. Check the TCP/IP configuration and reconfigure or reinstall, if needed.</td>
</tr>
<tr>
<td>TCP/IP network initialization failed; the TCP/IP address is already in use or an address could not be obtained (error number)</td>
<td>The IP address selected for use by FileMaker Server is already in use or isn’t correctly configured. Verify the IP address and TCP/IP configuration in the Networks control panel (Windows) or TCP/IP control panel (Mac OS 8.6 to 9.1) or TCP/IP preferences (Mac OS X). If FileMaker Pro 5.x is already running on the same computer and is set to use TCP/IP, FileMaker Server is prevented from using the same IP address. You should run FileMaker Server on a dedicated computer.</td>
</tr>
<tr>
<td>TCP/IP network initialization failed; not enough memory</td>
<td>There is insufficient memory to use TCP/IP. See “What you need” on page 2-1 (Windows), page 3-1 (Mac OS 8.6 to 9.1), page 4-1 (Mac OS X), or page 5-1 (Red Hat Linux) for RAM requirements.</td>
</tr>
<tr>
<td>TCP/IP network initialization failed; protocol is not installed (error number)</td>
<td>Windows: FileMaker Server can’t initialize TCP/IP, because the TCP/IP protocol is not installed or not configured correctly in the Networks control panel. Check the network installation and setup procedures in the Windows documentation and reinstall, if necessary.</td>
</tr>
</tbody>
</table>
### Message | Explanation
--- | ---
IPX/SPX network initialization failed; an unexpected error occurred (error number) | Windows: FileMaker Server can’t initialize IPX/SPX. Check network settings and system error log.
IPX/SPX network initialization failed; not enough memory | Windows: There is insufficient memory to use IPX/SPX. See “What you need” on page 2-1 for RAM requirements.
IPX/SPX network initialization failed; protocol is not installed (error number) | Windows: FileMaker Server can’t initialize IPX/SPX, because the IPX/SPX protocol is not installed or not configured correctly in the Networks control panel. Check the network installation and setup procedures in the Windows documentation and reinstall, if necessary.
User username no longer responding, connection closed | A connected guest’s computer has stopped communicating with FileMaker Server due to a network disruption or a software error.
Using a database cache size of xK | Written at FileMaker Server startup to show how much of the application’s memory is usable for the database cache (x is replaced by a number). You can adjust application memory by changing the Reserve MB of RAM for database cache in the Files tab of the Properties (Windows) or Preferences (Mac OS) dialog box or enabling the CacheSize preference parameter. The new cache size takes effect the next time you start FileMaker Server. Mac OS 8.6 to 9.1: You might have to adjust the application memory size for FileMaker Server using the Get Info dialog box in the Finder. For more information, see “Adjusting memory (Mac OS 8.6 to 9.1)” on page 6-6.
Troubleshooting

The following table lists some problems you may encounter when using FileMaker Server.

**Tip** When FileMaker Server behaves unexpectedly, check the log file to diagnose the problem. See “Using reported events to track activities” on page 7-18 (Windows and Mac OS) or “Using reported events and statistics to track activities” on page 9-13 (Red Hat Linux) and “FileMaker Server event log messages” on page C-1 for more information.

### Problems installing or starting FileMaker Server

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Suggested solution or explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>You’re unable to install FileMaker Server.</td>
<td>Check the hardware and software requirements listed in “What you need” on page 2-1 (Windows), page 3-1 (Mac OS 8.6 to 9.1), page 4-1 (Mac OS X), or page 5-1 (Red Hat Linux) to ensure your equipment and software are compatible. Windows, Mac OS X, and Red Hat Linux: Be sure to log in with administrative privileges when checking for compatibility.</td>
</tr>
<tr>
<td>You’re unable to start FileMaker Server.</td>
<td>Check the hardware and software requirements listed in “What you need” on page 2-1 (Windows), page 3-1 (Mac OS 8.6 to 9.1), page 4-1 (Mac OS X), page 5-1 (Red Hat Linux) to ensure your equipment and software are compatible. Also check the Windows Event Viewer, the Server Event Log (Mac OS 8.6 to 9.1) or events.log (Mac OS X and Red Hat Linux) for a description of why FileMaker Server couldn’t start. For more information about the Event Viewer, see “Using reported events to track activities” on page 7-18 (Windows and Mac OS) or “Using reported events and statistics to track activities” on page 9-13 (Red Hat Linux).</td>
</tr>
</tbody>
</table>

### Network problems

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Suggested solution or explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>A FileMaker Pro guest using IPX can’t find FileMaker Server databases on the network.</td>
<td>Windows: Verify that IPX networking software is properly installed. Verify that the host and guest are using the same frame type. Verify that the IPX/SPX network protocol (or both TCP/IP and IPX/SPX) is selected in the Networking tab of the Properties dialog box. Verify that the 250 simultaneous guest limit has not been reached.</td>
</tr>
</tbody>
</table>
A FileMaker Pro guest using TCP/IP can’t find FileMaker Server databases on the network.

Verify that TCP/IP networking software is properly installed on the host and guest computers. In the Hosts dialog box, click the Specify Hosts button and enter the host IP address.

Windows and Red Hat Linux: Use the ping command to contact the host address and verify the network is working properly. Verify that the 250 simultaneous guest limit has not been reached.

Windows: Verify that the TCP/IP network protocol (or both TCP/IP and IPX/SPX) is selected in the Networking tab of the Properties dialog box.

Mac OS: Verify that the TCP/IP network protocol (or both TCP/IP and AppleTalk [Mac OS 8.6 to 9.1]) is selected in the Networking tab of the Preferences dialog box.

A FileMaker Pro guest using AppleTalk can’t find FileMaker Server databases on the network.

Verify that the 124 simultaneous guest limit has not been reached. Also remember that AppleTalk is not supported by FileMaker Server running in Windows or Mac OS X.

---

### Problems on guest computers

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Suggested solution or explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>The FileMaker Server name does not appear in the FileMaker Pro Hosts dialog box.</td>
<td>Hold down the Ctrl key (Windows) or Option key (Mac OS) as you click Hosts in the Open dialog box. Sometimes with high network traffic, FileMaker Pro might not find the server on the first attempt. Holding down the Ctrl or Option key forces FileMaker Pro to check the network for a longer period of time. Windows: Verify that the FileMaker Server service is started in the Windows Services control panel. On a TCP/IP network, you may need to specify the host IP address or name. Click Specify Hosts in the TCP/IP Hosts dialog box, then type in the IP address or the name of the computer running FileMaker Server.</td>
</tr>
<tr>
<td>Guests using the IPX/SPX protocol can’t see FileMaker Server databases.</td>
<td>Windows: This is generally caused by using an incorrect frame type on the server or guest machine. To change the frame type on Windows, you must change the configuration of the IPX/SPX compatible protocol in the Network control panel. See your Windows documentation for more details.</td>
</tr>
<tr>
<td>Guests receive Communication with the host was interrupted and could not be re-established message on guest computer.</td>
<td>The guest has been disconnected from a database by FileMaker Server because the guest didn’t comply with a request from FileMaker Server to close a database. Another reason communication between the host and guest may have been disrupted is due to a hardware failure (lost network connection) or a software connection time-out (no response from guest for a given period of time). The latter could be caused by a screen saver, debugger, or processor-intensive operation.</td>
</tr>
<tr>
<td>Guests receive servername is no longer available or the host capacity has been exceeded message on guest computer.</td>
<td>FileMaker Server has shut down or you reached the maximum allowable connections or guests on FileMaker Server. Verify that FileMaker Server is running or increase the number of guests allowed in the Guests tab of the Properties dialog box (Windows) or the Preferences dialog box (Mac OS). See “Setting the number of guests” on page 6-3.</td>
</tr>
</tbody>
</table>
### Problems administering remotely

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Suggested solution or explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>You’re unable to administer FileMaker Server remotely using FileMaker Pro 5.x.</td>
<td>Check that remote administration is enabled in the Administration tab of the Properties dialog box (Windows) or Preferences dialog box (Mac OS) or UseRemoteAdmin preference parameter (Red Hat Linux). See “Enabling remote administration” on page 6-9 (Windows and Mac OS) or “Enabling remote administration in FileMaker Server” on page 9-10 (Red Hat Linux). If you want full administrative access to FileMaker Server, you must install and enable the Server Administration plug-in on your remote computer. For more information, see “Automatically downloading the Server Administration plug-in to a remote computer” on page 7-6.</td>
</tr>
<tr>
<td>The Open, Close, Disconnect, and Get Details buttons are dimmed in the Remote Administration window.</td>
<td>The Server Administration plug-in isn’t installed and enabled on the remote computer. Install and enable the plug-in and try again. For more information, see “Automatically downloading the Server Administration plug-in to a remote computer” on page 7-6.</td>
</tr>
</tbody>
</table>

### Problems using command line options (Windows and Red Hat Linux)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Suggested solution or explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>The command you typed didn’t work.</td>
<td>When typing at the command prompt, specify the filename extension (.FP5) after the filename. Make sure that you are using the correct short filenames, or enclose long filenames that contain spaces in quotation marks. To see the short filenames, type <code>dir /x</code> at the prompt.</td>
</tr>
<tr>
<td>You can’t remember command syntax or usage.</td>
<td>Type <code>fmserver /?</code> (Windows) or <code>fmserverd -h</code> (Red Hat Linux) at the prompt to view a list of available commands. Windows: Look at the messages in the Windows Event Viewer for tips.</td>
</tr>
</tbody>
</table>
This page intentionally left blank.
Appendix D
About the TechInfo database

The TechInfo database is a great resource for technical information about FileMaker, Inc. products. This FileMaker Pro database serves as a front-line resource for the company’s support technicians as they solve customer inquiries. It collects Q&As, tips, FAQs, bug reports, update notes, press releases, templates, and other material valuable for support professionals. You can access the TechInfo database in the support area of the official FileMaker, Inc. web site (www.filemaker.com).

Searching the TechInfo database

To locate all information about FileMaker Server in the TechInfo database, specify FileMaker Server as the product name and start your search. You can look for more specific articles by adding additional keywords before searching. For example, including the word network as a keyword before you search displays a list of all TechInfo articles that contain the words “FileMaker Server” and “network.”

Keep the following search tips in mind:

- Use the singular form, for example, host instead of hosts.
- Try roots of words. For example, summar instead of summaries or summary.
- Use generic terms. For example, protocol instead of TCP/IP.

Sample TechInfo article

The following TechInfo article gives you an idea of the kind of information you will find in the TechInfo database.

Information on the Web

You can also find more information, tips, and database ideas by visiting FileMaker, Inc. on the Web:

Windows: In the FileMaker Server Console, choose Help menu > FileMaker on the Web or point your browser to www.filemaker.com.

Mac OS: In FileMaker Server, choose Help menu > FileMaker on the Web or point your browser to www.filemaker.com.

This page intentionally left blank.
A

Access privileges
  FileMaker Pro (Windows and Mac OS) 6-17
  Linux  9-10
  Windows 2-2
Account name, specifying custom for FileMaker Server (Linux) 9-9
Activities, FileMaker Server
  message descriptions  C-1
  viewing
    Linux  9-13
    Mac OS 7-20
    Windows 2000 7-19
    Windows NT 7-19
Administering
  closing files
    locally (Linux) 9-2
    locally (Mac OS 8.6 to 9.1) 7-15
    remotely 7-9
    using command line (Windows) 8-9
  disconnecting guests
    locally (Mac OS 8.6 to 9.1) 7-16
    remotely 7-10
  from different platforms (Windows and Mac OS) 2-2
  local administration (Mac OS 8.6 to 9.1), described 7-4, 7-12
  opening files
    locally (Linux) 9-2
    locally (Mac OS 8.6 to 9.1) 7-14
    remotely 7-9
    using the command line (Windows) 8-9
  sending messages
    locally (Mac OS 8.6 to 9.1) 7-16
    remotely 7-11
  setting passwords for remote access
    Linux  9-10
    Windows and Mac OS 6-9
  using command line
    Linux 9-1–9-2
    Windows 8-8–8-10
  viewing usage statistics
    locally (Mac OS 8.6 to 9.1) 7-14
    remotely 7-8
  Administration tab (Windows and Mac OS) 6-10
  Administration window (Mac OS 8.6 to 9.1) 7-12
  Alias, making
    Mac OS 8.6 to 9.1 7-3
    Mac OS X 7-4
  Apple events
    support described
      Mac OS 8.6 to 9.1 3-3
    using to
      close files (Mac OS) 7-10
      collect statistics
        (Mac OS 8.6 to 9.1) 7-8
      graph statistics
        (Mac OS 8.6 to 9.1) 6-13
      open databases (Mac OS) 7-9
  AppleScript
    example file location
      Mac OS 8.6 to 9.1 3-3
    recalculating Today function
      (Mac OS 8.6 to 9.1) 7-21
  AppleShare software
    See also Networks; Performance
    coexistence with FileMaker Server
      (Mac OS 8.6 to 9.1) A-2
    connections (Mac OS 8.6 to 9.1) A-2
  AppleTalk
    See also Networks
    hosting with (Mac OS 8.6 to 9.1) 3-1
  Application log. See Log files
  Assistants (Windows)
    configuration 6-1
    starting 6-1
    task scheduling 8-1
  Asynchronous disk I/O  A-2
  Auto Update plug-in
    Linux 9-8
    Windows and Mac OS 6-7, 7-6
  AutoUpdate directory, location of
    Linux 5-3
    Mac OS 8.6 to 9.1 3-3
    Mac OS X 4-2
    Windows 2-4

B

Backimg up database files
  running out of disk space 8-10
  sample script
    Linux 5-2
    Windows 2-4
  using command line (Windows) 8-9
  using FileMaker Server (Windows and Mac OS) 8-1
Bug reports, looking up  D-1
Cache
flush setting
   Linux  9-7
   Windows and Mac OS  6-7
hit percentage  7-8
log file message  C-2, C-4
monitoring  B-1
percentage unsaved  7-8
size in log file (Windows 7-18
viewing percentages locally
   (Mac OS 8.6 to 9.1)  7-14
CacheSize preference parameter (Linux)  9-7
chgrp command (Linux)  9-10
chmod command (Linux)  9-10
chown command (Linux)  9-10
ckconfig command (Linux)  9-2
Close command
   Linux  9-2
   Windows  8-8
Closing files
   See also Administering; Disconnecting
guests; Files; Quitting FileMaker Server
locally (Mac OS 8.6 to 9.1)  7-15
remotely  7-9
using command line (Windows)  8-8
Coffee cup icon  8-10
Columns, resizing and sorting
   in local administration window
   (Mac OS 8.6 to 9.1)  7-13
   in Schedules list
   Mac OS  8-5
   Windows  8-4
Command file, running on a schedule
   (Windows)  8-1
Command line (Windows)
   examples  8-9
   sample files  8-9
troubleshooting  C-7
using  8-8 – 8-10
Compression, database file  8-10, B-2, C-1
Computer, dedicated. See Dedicated host
Configuration application, described
   (Mac OS X)  7-3
Configuration assistants (Windows)  6-1
Configuration file (Linux)
   applying changes  9-4
   editing  9-3
   location of  5-2
   opening  9-3
   reloading  9-2, 9-5
   restarting to apply changes  9-5
   restoring defaults  9-5
Configuring
   applying changes (Linux)  9-4
   choosing network protocols
   Mac OS  8.6 to 9.1  6-11
   Windows  6-11
   customizing host name
   Linux  9-11
   Windows and Mac OS  6-10
   directory service
   Linux  9-14
   Windows and Mac OS  6-15
   disconnection message
   Linux  9-6
   Windows and Mac OS  6-4
   downloading plug-ins automatically
   Linux  9-8
   Windows and Mac OS  6-7
   flushing cache
   Linux  9-7
   Windows and Mac OS  6-7
   hosting single user files
   Linux  9-8
   Windows and Mac OS  6-7
idle disconnect time
   Linux  9-6
   Windows and Mac OS  6-4
IP address
   Linux  9-12
   Windows and Mac OS  6-12
maximum number of files
   Linux  9-7
   Windows and Mac OS  6-5
memory considerations (Windows and
Mac OS)  6-1
multiple network cards
   Linux  9-12
   Windows and Mac OS  6-12
number of guests
   Linux  9-6
   Windows and Mac OS  6-3
opening configuration file (Linux)  9-3
opening preferences dialog
   (Mac OS X)  6-3
opening preferences dialog box
   (Mac OS 8.6 to 9.1)  6-2
opening properties dialog box
   (Windows)  6-2
overview
   Linux  9-3
   Windows and Mac OS  6-1
remote administration password
   Linux  9-10
   Windows and Mac OS  6-9
requiring guest authentication
   (Windows)  6-4
restoring defaults
   Linux  9-5
   Windows and Mac OS  6-17
Connections, AppleShare  A-2
Console, FileMaker Server (Windows)  6-1
Contents, using in Help (Windows and
Mac OS) viii
Control panel, Services (Windows) 7-1, 7-2
Copying schedules (Windows and Mac OS) 8-7
Corrupted database (Windows and Mac OS) 6-17
CPU, maximizing for FileMaker Server (Mac OS 8.6 to 9.1) 6-11
Crash, system (Windows and Mac OS) 6-18
Cross-platform issues
documentation notation vii
Mac OS X 4-1
Windows and Mac OS 2-2, 3-1
Custom host name. See Host name
Customer support 1-1
CustomExtensions preference parameter (Linux) 9-12
Customizing FileMaker Server. See Configuring
CustomServerName preference parameter (Linux) 9-11

D
Daemon file location (Linux) 5-2
Database files. See Files
Dates, incorrect calculation 7-20
Dedicated host
described 1-1, A-1
performance issues (Windows and Mac OS) 6-11
Default configuration settings, restoring
Linux 9-6
Windows and Mac OS 6-17
Deleting
FileMaker Server (Windows) 2-5
scheduled tasks (Windows and Mac OS) 8-7
Dialog boxes, getting Help
Mac OS 8.6 to 9.1 xi
Mac OS X xii
Windows xi
Dimmed icon, in Hosts dialog box (Windows and Mac OS) 6-10
Directories, described (Linux) 5-2
Directory service
described
Linux 9-14
Windows and Mac OS 6-15
distinguished name, specifying
Linux 9-15
Windows and Mac OS 6-16
encrypting password (Linux) 9-11
port number, specifying
Linux 9-15
Windows and Mac OS 6-17
preference parameters (Linux) 9-15 – 9-16
publishing contact information
Linux 9-16
Windows and Mac OS 6-16
registering with
Linux 9-15
Windows and Mac OS 6-15
Directory Service tab (Windows and Mac OS) 6-15
Disabling
remote administration
Linux 9-10
Windows and Mac OS 6-9
scheduled tasks (Windows and Mac OS) 8-7
DisconnectIdleGuests preference parameter (Linux) 9-6
Disconnecting guests
See also Administering; Guests
locally (Mac OS 8.6 to 9.1) 7-16
remotely 7-10
troubleshooting C-6
Disconnection message
Linux 9-6
Windows and Mac OS 6-4
DisconnectWarning preference parameter (Linux) 9-6
Disk
running out of room when backing up files 8-10
writing guest data
Linux 9-7
Windows and Mac OS 6-7
writing statistics to log file
Linux 9-14
Windows and Mac OS 6-13
Disk I/O, asynchronous A-2
Disk KB/sec statistics, described 7-8
Distinguished name, specifying for a directory service
Linux 9-15
Windows and Mac OS 6-16
Documentation, described vii
DOS command line (Windows) 8-8 – 8-10, C-7

E
Edit Schedule dialog box (Windows and Mac OS) 8-6
Enabling
remote administration
Linux 9-10
Windows and Mac OS 6-9
scheduled tasks (Windows and Mac OS) 8-7
Server Administration plug-in manually
Mac OS 10-3
Windows 10-2
Encrypting passwords (Linux) 9-11
Error messages. See Messages; Log files; Troubleshooting
Ethernet. See Networks
Event Viewer (Windows)
described 7-18
keeping data current 7-20
message descriptions C-1
EventLogPath preference parameter
(Linux) 9-14
Events
See also Log files
checking for file corruption (Windows and
Mac OS) 6-18
recording
Linux 9-13
Mac OS 6-15
Windows 2000 6-14
Windows NT 6-14
Exclusive access to hosted files 7-12
Exiting FileMaker Server
See also Quitting FileMaker Server
Windows 2000 7-2
Windows NT 7-2
Extensions, registering filename
Linux 9-12
Windows and Mac OS X 6-8

FileMaker Pro
changing field definitions in hosted
files 7-12
downloading plug-ins from
Linux 9-8
Windows and Mac OS 6-7
enabling Server Administration plug-in
manually
Mac OS 10-3
Windows 10-2
FileMaker Server, comparison
1-2
filename extensions, registering
Linux 9-12
Mac OS 8.6 to 9.1 6-9
Windows and Mac OS X 6-8
passwords on files 6-17
record-by-record access privileges 6-17
Remote Administration window 7-6
runtime solutions
Linux 9-12
Mac OS 8.6 to 9.1 6-9
Windows and Mac OS X 6-8

FileMaker Server
See also Administering; Configuring
described 1-1 – 1-3
documentation, described vii
FileMaker Pro, comparison 1-2
files, described
Linux 5-2
Mac OS 8.6 to 9.1 3-2
Mac OS X 4-2
Windows 2-3
hardware requirements
Linux 5-1
Mac OS 8.6 to 9.1 3-1
Mac OS X 4-1
Windows 2-1
installing
Linux 5-1
Mac OS 8.6 to 9.1 3-1
Mac OS X 4-1
Windows 2-2
limits A-1
network requirements
Linux 5-1
Mac OS 8.6 to 9.1 3-1
Mac OS X 4-1
Windows 2-1
new features 1-3
optimizing B-1, C-1
performance tips B-1, C-1
registering software license 1-1
sample files
Linux 5-2
Mac OS 8.6 to 9.1 3-2
Mac OS X 4-2
Windows 2-4
starting
Linux 9-1, 9-2
Mac OS 8.6 to 9.1 7-3
Mac OS X 7-4
using command line (Windows) 8-8
Windows 2000 7-1
Windows NT 7-1
stopping
Linux 9-1
Mac OS 8.6 to 9.1 7-3
Mac OS X 7-4
using command line (Windows) 8-8
Windows 2000 7-2
Windows NT 7-2
system requirements
Linux 5-1
Mac OS 8.6 to 9.1 3-1
Mac OS X 4-1
H

Hardware requirements
See also Memory; System requirements; Troubleshooting
asynchronous disk I/O A-2

described
  Linux  5-1
  Mac OS 8.6 to 9.1  3-1
  Mac OS X  4-1
  Windows  2-1

networking
  Linux  5-1
  Mac OS 8.6 to 9.1  3-1
  Mac OS X  4-1
  Windows  2-1

performance A-1

Help. See FileMaker Server Help

Hibernation (Windows 2000)   6-17

Hit percentage, cache  7-8

Host name
  maximum length A-1
  setting
    Linux  9-11
    Windows and Mac OS  6-10

unavailable C-6

Hosting files
See also Administering; Files; Guests; Remote administration
  automatically  B-2
described  7-8

errors C-1

maximum number A-1
  Linux  9-7
  Windows and Mac OS  6-5

runtime solutions
  Linux  9-12
  Mac OS 8.6 to 9.1  6-9
  Windows and Mac OS X  6-8

sending messages to guests
  locally (Mac OS 8.6 to 9.1)  7-16
  remotely  7-11
  troubleshooting C-1
  using command line (Windows)  8-8

Hosts dialog box
described  6-10
dimmed icon (Windows and Mac OS)  6-10

host name
  setting (Linux)  9-11
  setting (Windows and Mac OS)  6-10
  troubleshooting C-6
  opening  7-6

HostSingleUserFiles preference parameter
  (Linux)  9-8

I, J

Idle disconnect time
  Linux  9-6
  Windows and Mac OS  6-4

Index, using in Help (Windows and Mac OS 8.6 to 9.1) ix

Installing FileMaker Server
  in Linux   5-1 – 5-2
  in Mac OS 8.6 to 9.1  3-1 – 3-2
  in Mac OS X  4-1 – 4-2
  in Windows   2-2 – 2-3
  recommendations  1-2
  remote administration plug-in, automatically  7-6
  remote administration plug-in, manually
    Mac OS  10-2
    Windows  10-1
  troubleshooting C-5

IP address
  setting
    Linux  9-12

Windows and Mac OS  6-12
specifying for a directory service
  Linux  9-15
  Windows and Mac OS  6-15
  troubleshooting C-6

IPX/SPX (Windows)
  incorrect frame types C-6
  troubleshooting C-5

Italicized text, in local administration window
      (Mac OS 8.6 to 9.1)  7-16

K

Keyboard shortcuts (Mac OS 8.6 to 9.1)  7-14

L

LDAP
See Directory service

Limits for files and usage A-1

Listing information (Mac OS 8.6 to 9.1)  7-14

Listing open files
  locally (Linux)  9-2
  locally (Mac OS 8.6 to 9.1)  7-13
  remotely  7-7

Local administration (Mac OS 8.6 to 9.1)
described  7-4, 7-12
  hosting files  7-14
  viewing databases and guests  7-12

LocalTalk. See Networks

Log files
  application log
    Windows 2000   6-14
    Windows NT   6-14
  event log, described
    Linux  9-13
    Mac OS  7-20
  Events.log (Mac OS X)
described  7-18
maximum size 6-15
keeping data current (Windows) 7-20
location of (Linux) 5-3
message descriptions C-1
statistics log
described (Linux) 9-14
described (Windows and Mac OS) 7-8
maximum size (Linux) 9-14
maximum size (Windows and
Mac OS) 6-13
writing to disk (Linux) 9-14
writing to disk (Windows and
Mac OS) 6-13
viewing events (Windows) 7-18
Logging tab (Windows and Mac OS) 6-13

M
MaxEventLogSize preference parameter
(Linux) 9-13
MaxFiles preference parameter (Linux) 9-7
MaxGuests preference parameter (Linux) 9-6
MaxIdleTime preference parameter
(Linux) 9-6
Maximum number of files
described A-1
setting
Linux 9-7
Windows and Mac OS 6-5
Maximum number of guests
troubleshooting C-6
with AppleShare (Mac OS 8.6 to 9.1) A-2
MaxStatsLogSize preference parameter
(Linux) 9-14
Memory
See also Cache; Hardware requirements;
Optimization; Performance; System requirements
adjusting
Linux 9-7
Mac OS 8.6 to 9.1 6-6
Windows and Mac OS 6-5
minimum
Linux 5-1
Mac OS 8.6 to 9.1 3-1, 6-6
Mac OS X 4-1
Windows 2-1
virtual memory (Mac OS 8.6 to 9.1) 6-7
Messages
FileMaker Server log file C-1
sending to guests
locally (Mac OS 8.6 to 9.1) 7-16
remotely 7-11
Microsoft Active Directory
Linux 9-14
Windows and Mac OS 6-15
Monitoring FileMaker Server. See Administering

N
Netscape Directory
Linux 9-14
Windows and Mac OS 6-15
Network card requirements (Linux) 5-1
Network KB/sec statistics, described 7-8
Network operating system (Windows) 2-2
Networking tab (Windows and Mac OS) 6-11
Networks
See also Optimization; Troubleshooting
choosing protocols
Mac OS 8.6 to 9.1 6-11
Windows 6-11
error messages C-2
initialization failure C-2
mixed networks
Mac OS 8.6 to 9.1 3-1, 6-11
Mac OS X 4-1, 6-11
Windows 2-2, 6-11
performance considerations
(Mac OS) A-2
requirements
Linux 5-1
Mac OS 8.6 to 9.1 3-1
Mac OS X 4-1
Windows 2-1
setting IP address
Linux 9-12
Windows and Mac OS 6-12
sockets, AppleTalk A-2
traffic and performance B-2
troubleshooting C-5
New Schedule dialog box
Mac OS 8.6 to 9.1 8-1
Mac OS X 8-3
NOS (Windows) 2-2
Number of guests
maximum A-1
setting
Linux 9-6
Windows and Mac OS 6-3

O
Onscreen Help. See FileMaker Server Help
Open command
Linux 9-2
Windows 8-8
Opening files
automatically B-2
locally
Linux 9-2
Mac OS 8.6 to 9.1 7-14
remotely 7-6, 7-8
runtime solutions
Linux 9-12
Mac OS 8.6 to 9.1 6-9
Windows and Mac OS X 6-8
using command line (Windows) 8-8
OpenLDAP
   Linux 9-14
   Windows and Mac OS 6-15
Operating system requirements
   Linux 5-1
   Mac OS 8.6 to 9.1 3-1
   Mac OS X 4-1
   Windows 2-1
Optimization B-1, C-1
See also Log files; Hardware requirements;
Memory; Networks; Performance

P
Passwords
   encrypting for configuration file (Linux) 9-11
   in FileMaker Pro files 6-17
   remote administration
      maximum length A-1
      setting 6-10
Pause command
   Linux 9-2
   Windows 8-8
Performance
   coexistence with other software A-2
   hardware A-1
   maximize mode (Mac OS 8.6 to 9.1) 6-11
   network (Mac OS) A-2
   tips A-1, B-1
Performance Monitor (Windows NT), using 7-17
Permissions, file (Linux) 9-10
Plug-in, remote administration
   automatically downloading 7-6
   described 7-5
   installing manually
      Mac OS 10-2
      Windows 10-1
Plug-ins
   downloading automatically
      Linux 9-8
      Windows and Mac OS 6-7
Port number, specifying for a directory service
      Linux 9-15
      Windows and Mac OS 6-17
Power Conservation mode
   (Windows 2000) 6-17
Preferences. See Configuring
PrefIPAddr preference parameter (Linux) 9-12
Product features, new and improved 1-3
Product registration 1-1
Properties. See Configuring
Protocols, network
   setting
      Mac OS 8.6 to 9.1 6-11
      Windows 6-11
   supported
      Linux 5-1
      Mac OS 8.6 to 9.1 3-1
      Mac OS X 4-1
      Windows 2-1
Quick reference of commands (Linux) xii
Quit FileMaker Server
   Linux 9-1
   Mac OS 8.6 to 9.1 7-3
   Mac OS X 7-4
   Windows 2000 7-2
   Windows NT 7-2

R
RAM. See Memory
Registering
   filename extensions for runtime solutions
      Linux 9-12
      Windows and Mac OS X 6-8
   software license 1-1
Registration utility, description (Linux) 5-2
Related database files, locating B-2
Reload command (Linux) 9-2, 9-5
Remote administration
   described 1-1
   enabling in FileMaker Server
      Linux 9-10
      Windows and Mac OS 6-9
   encrypting password (Linux) 9-11
   getting Help xii
   hosting files 7-9
   installing plug-in manually
      Mac OS 10-2
      Windows 10-1
   plug-in files
      Linux 5-3
      Mac OS 8.6 to 9.1 3-3
      Mac OS X 4-2
      Windows 2-4
   troubleshooting C-7
Remote Administration window
   described 7-7
   opening 7-6
   sorting columns 7-7
Remote administration, downloading plug-in automatically 7-6
Removing
   FileMaker Server
      Linux 5-3
      Windows 2-5
scheduled tasks (Windows and Mac OS) 8-7
Replacing data, performance issues B-1
Requirements. See Hardware requirements; Memory; Networks; System requirements
RequirePassword preference parameter (Linux) 9-11
Resizing columns
  in Schedules list
  Mac OS 8-5
Windows 8-4
locally (Mac OS 8.6 to 9.1) 7-13
Restart command (Linux) 9-5
Resume command
  Linux 9-2
Windows 8-9
Runtime solutions, hosting automatically
  Linux 9-12
  Mac OS 8.6 to 9.1 6-9
Windows and Mac OS X 6-8

S
Sample files
  command line (Windows) 8-9
Linux 5-2
Mac OS 8.6 to 9.1 3-2, 3-3
Mac OS X 4-2
Windows 2-4
Schedules
  changing (Windows and Mac OS) 8-6
  creating
    Mac OS 8.6 to 9.1 8-1
    Mac OS X 8-3
Windows 8-1
delisting (Windows and Mac OS) 8-7
described (Windows and Mac OS) 8-1
duplicating (Windows and Mac OS) 8-7
  enabling and disabling (Windows and Mac OS) 8-7
  running manually (Windows and Mac OS) 8-6
  viewing (Windows) 8-4
Screen saver software, and FileMaker Server A-2, B-2
Scripts
  autostart and stop (Linux) 9-2
  for administrative tasks (Linux) 9-1
  running on a schedule
    Mac OS 8.6 to 9.1 8-2
    Mac OS X 8-4
  using to automate tasks (Mac OS) 8-10
Search path for hosting files (Linux) 9-9
Selecting information in lists (Mac OS 8.6 to 9.1) 7-14
Sending messages to guests See also Administering; Messages all, remotely 7-12
locally (Mac OS 8.6 to 9.1) 7-16
remotely 7-11
  using a schedule (Windows and Mac OS) 8-1
Server Administration plug-in
  automatically downloading 7-6
  described 7-5
  enabling manually
    Mac OS 10-3
Windows 10-2
installing manually
  Mac OS 10-2
Windows 10-1
Server application, described
  (Mac OS X) 7-3
Server Event Log (Mac OS 8.6 to 9.1) See also Log files
described 7-20
maximum size 6-15
Server Last statistics Log file (Mac OS 8.6 to 9.1) 6-13
Server name. See Host name
ServerRoot preference parameter (Linux) 9-9
Services control panel (Windows) 7-1, 7-2
Shutdown
  and FileMaker Server
    Windows NT 7-2
  checking for file corruption (Windows and Mac OS) 6-18
Single user files, hosting
  Linux 9-8
Windows and Mac OS 6-7
Sleep, by operating system (Windows and Mac OS) 6-17
Sockets, network. See Connections,
AppleShare; Networks; Optimization
Software requirements
  Linux 5-1
  Mac OS 8.6 to 9.1 3-1
  Mac OS X 4-1
Windows 2-1
Sorting
  columns
locally (Mac OS 8.6 to 9.1) 7-13
remotely 7-7
performance issues B-1
scheduled tasks
  Mac OS 8-5
Windows 8-4
usage statistics, remotely  7-8
Specify Hosts button  C-6
Standby mode (Windows 2000)  6-17
Start command
  Linux  9-1
  Windows  8-8
Starting
  FileMaker Server, automatically
    Linux  5-2, 9-2
    Mac OS 8.6 to 9.1  7-3
    Mac OS X  7-4
    troubleshooting  C-5
    Windows 2000  2-2
    Windows NT  2-2, 7-1
  FileMaker Server, manually
    Linux  9-1
    Mac OS 8.6 to 9.1  7-3
    Mac OS X  7-4
    troubleshooting  C-5
    using command line (Windows)  8-8
    Windows 2000  2-2, 7-1
    Windows NT  2-2, 7-1
Statistics
  collecting
    Linux  9-13
    Windows and Mac OS  6-12
  viewing
    locally (Linux)  9-13
    locally (Mac OS 8.6 to 9.1)  7-14
  Performance Monitor
    (Windows NT)  7-17
    remotely  7-8
  System Monitor (Windows 2000)  7-18
Statistics log file.  See Log files
StatsLogPath preference parameter  (Linux)  9-14
StatsTimeInterval preference parameter  (Linux)  9-14
Status (Current Date) function  7-21
Stop command (Windows)  8-8
Stopping FileMaker Server
  Linux  9-1
  Mac OS 8.6 to 9.1  7-3
  Mac OS X  7-4
  Windows 2000  7-2
  Windows NT  7-2
Summary reports  B-1
Support, technical  1-1
System crash, checking for file corruption
  (Windows and Mac OS)  6-18
System Monitor (Windows 2000), using  7-18
System requirements
  See also  Hardware requirements; Memory;
  Troubleshooting
  Linux  5-1
  Mac OS 8.6 to 9.1  3-1
  Mac OS X  4-1
  Windows  2-1
T
Task Scheduling assistant (Windows)  8-1
Tasks, scheduling (Windows and Mac OS).  See Schedules
TCP/IP
  See also  Networks
  host address  C-6
  troubleshooting  C-6
TechInfo database  D-1
Technical specifications  A-1
  See also  FileMaker Server; Optimization;
  Performance
Technical support
  contacting  1-1
  TechInfo database  D-1
Tips.  See Optimization; Performance;
Troubleshooting
Today function  7-20
Toolbar (Windows)
  described  8-4
  displaying descriptions for buttons  xi
Transaction statistics, described  7-8
Troubleshooting  C-5 – C-7
  See also  Log files; Hardware requirements;
  Networks; Optimization; Performance
  system crash (Windows and Mac OS)  6-18
U
Uninstalling FileMaker Server
  Linux  5-3
  Windows  2-5
Unsaved cache percentage  7-8
Unselectable icon, in Hosts dialog box
  (Windows and Mac OS)  6-10
Unused cache percentage  B-1
Usage statistics
  logging
    Linux  9-14
    Windows and Mac OS  6-12
  viewing
    locally (Linux)  9-13
    locally (Mac OS 8.6 to 9.1)  7-14
    locally (Windows 2000)  7-18
    locally (Windows NT)  7-17
    remotely  7-8
Usage Statistics window (Mac OS 8.6 to 9.1)  6-12
UseAutoUpdate preference parameter  (Linux)  9-8
UseCacheFlush preference parameter  (Linux)  9-7
UseCustomExtensions preference parameter  (Linux)  9-12
UseCustomServerName preference parameter  (Linux)  9-11
UsePrefIPAddr preference parameter
  (Linux)  9-12
UseRemoteAdmin preference parameter
  (Linux)  9-10
Users. See Guests
UseStatsLog preference parameter
  (Linux)  9-14

V
var/fmserverd, description (Linux)  5-2
var/log/fmserver, description (Linux)  5-3
Viewing
details about files and guests,
remotely  7-11
FileMaker Server events
  Linux  9-13
  Mac OS   7-20
  Windows 2000   7-19
  Windows NT   7-19
scheduled tasks
  Mac OS   8-5
  Windows   8-4
usage statistics
  locally (Linux)  9-13
  locally (Mac OS 8.6 to 9.1)   7-14
  locally (Windows 2000)   7-18
  locally (Windows NT)   7-17
  remotely   7-8
Virtual memory. See Memory; Performance

W, X, Y, Z
Web site
  for registering software   1-1
  TechInfo database   D-1
  technical support   1-1
Writing guest data to disk
  Linux   9-7
  Windows and Mac OS   6-7